
Customer Release Notes
Fiery Command WorkStation Package, v6.5

This document contains important information about this release. Be sure to provide this information to all users
before proceeding with the installation.

About this release

The following applications are included in this release:

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Fiery Hot Folders for Mac 4.1.0.21

• Fiery Hot Folders for Windows 4.1.0.21

• Fiery Software Manager v4.4.0.18

Upgrading

This installer will upgrade any existing Fiery Command WorkStation Package to the latest package containing Fiery
Command WorkStation and Fiery Hot Folders. Optionally, you can install Fiery Remote Scan by using Fiery
Software Manager.
Fiery Command WorkStation Package supports Fiery servers running FS100 and later, and Fiery proServer and Fiery
XF 7.0 and later. It will not connect to:

• Fiery servers running Fiery System 9/9e Rel2 and System 10 software and previous versions

• Fiery XF 6.x servers and earlier

• Fiery Central servers

If you need access to these products, do not upgrade. Fiery Extended Applications Package is still available at 
www.efi.com/cws. For a full list of supported cutsheet printers, see http://fiery.efi.com/CWS/supported-printers.
For more information on technical specifications, refer to www.efi.com/cws.

New features
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What's new?

For information about new features that were added in the initial release of version 6.5, visit http://
fiery.efi.com/CWS/Whats-New.
For information about new features that were added after the initial release of version 6.5, see the information
below.

Fiery Spot Pro

Fiery Command WorkStation 6.5 allows you to manage spot colors with Fiery Spot Pro, which replaces Fiery
Spot-On. For a full list of improvements, see https://www.efi.com/spotpro.
Fiery Spot Pro is available to selected servers with the following requirements:

• FS200 Pro and later software

• Fiery Graphic Arts Package, Premium Edition

Learn more at http://fiery.efi.com/spotpro/supported-printers.
If your Fiery server does not have Fiery Spot Pro enabled, Fiery Command WorkStation will continue to support
Fiery Spot-On.

Considerations for using Fiery Spot Pro

• Do not use the "@" symbol in any spot color name.

• After you start Spot Pro, wait approximately 60-120 seconds before using the search function, or switching
output profiles.

• Optimizing spot colors after several iterations may result in more pronounced differences between the
original spot color and a converted spot color.

• There is a slight numerical rounding of converted L*a*b* values and device CMYK values.

• Two instances of Spot Pro on different user systems connecting to the same Fiery server may lead to errors if
both users perform editing operations.

EFI ES-3000 support

The new EFI ES-3000 measurement instrument is supported through an EFI ES-2000 emulation in Fiery
Command WorkStation 6.5. The EFI ES-3000 is an upgrade to the EFI ES-2000 and supports single-scan
measurements in the measurement modes M1 and M2. You can use the EFI ES-3000 instrument (by selecting
the entry “EFI ES-2000” in the user interface) with Fiery Calibrator, Fiery Spot Pro, and Paper Simulation
features of Fiery Command WorkStation.

Note: The ES-2000 emulation (“EFI ES-2000” entry in the user interface) can be used in conjunction with an EFI
ES-2000 as well.
For information about using the EFI ES-3000 with different applications, see the documentation that
accompanies those applications.

Fiery Option Package license notifications

Notifications about available server updates are now listed under the new Notifications section in Fiery
Command WorkStation. Notifications are displayed when licenses of the installed Fiery options approach their
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expiry date or have expired. Notifications are displayed in Fiery Command WorkStation, Fiery Hot Folders, and
Fiery WebTools.

Note: You can view license expiration information at any time in WebTools > Home and Fiery Command
WorkStation > Device Center > General > General Info.
The expiry notifications provide the following options:

• Renew now

• Dismiss

• Learn more

Support for Fiery JobExpert Report

Fiery Command WorkStation 6.5 connected to FS400 servers allows you to preview the enhancements made to
the job using Fiery JobExpert.
Fiery JobExpert Report provides an overview of the suggested job properties settings applied to your jobs using
Fiery JobExpert.

Support for Adobe Acrobat Pro 2017 and Enfocus PitStop Edit 2019

The Adobe Acrobat Pro 2017 and Enfocus PitStop Edit 2019 option is available for download from Fiery
Software Manager.

Support for measurement instruments in Fiery XF Color Editor

These single patch and optimization measurement instruments are supported:

Measurement instrument Single patch Optimization

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

Support for variable light ink end point

Fiery XF allows you to set up a light ink end point to save light ink on calibration files.
To create an ink-saving calibration file, reduce the amount of light ink by changing the Light ink end point value
in the Ink Limit and Calibration tab of Color Tools.

Support for 1617 (CGATS IT8.7/5) patch layout

Fiery XF supports a profiling chart in Color Tools with 1617 patches.
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The 1617 target is a CMYK printer characterization target combining the unique patch values in the standard
IT8.7/4 target with all the patch values in columns 4 and 5 of the P2P51 target.

Support for creating Verifier custom presets from Server Manager

You can create custom presets in XF-Verifier from Server Manager.

Support for retaining folder location of a Hot Folder backup file

When you restore Hot Folders from a backup file, you can now retain the original folder locations of the backup
file.

EFI IQ web applications

You can register EFI IQ web applications from the Home screen of Command WorkStation. EFI IQ web
applications give more visibility to your print production with powerful print analytics.

Updates to system requirements

Supported versions

Fiery Command WorkStation supports these operating systems for your computer:

• macOS 11 (only with Intel processors)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10, 64-bit

• Windows Server 2019, 64-bit

• Windows Server 2016, 64-bit

• Windows 8.1, 64-bit

• Windows 7, 64-bit

• Windows Server 2012 R2, 64-bit

• Windows Server 2008 R2, 64-bit

Discontinued support

• macOS 10.11

• macOS 10.12

• System 10 and earlier

When you update Fiery Command WorkStation to version 6.5, all previously added System 10 servers will be
removed from the server list. If you attempt to log in to a Fiery server that runs System 10 or earlier, you are
prevented from using this server because only a Fiery server that runs FS100 and later is supported.
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64-bit application

Fiery Command WorkStation 6.5 (CWS) is a native 64-bit application for both macOS and Windows platforms.
32-bit operating systems are not supported for CWS 6.5. If Fiery Software Manager is already running on a 32-
bit operating system (OS) such as Windows 7 32-bit, it will not display the update notifications for the CWS 6.5
package. If you attempt to run this version of Fiery Software Manager on a 32-bit OS, you will see a compatibility
error, and Fiery Software Manager will not run. To view the supported operating systems, see http://
fiery.efi.com/cws-specifications.

Support for Adobe Acrobat DC subscription for use with Fiery Impose, Fiery Compose, or Fiery
JobMaster

Fiery Command WorkStation Package v6.5.0.292 supports the use of individual-owned/personal subscriptions
of Acrobat DC installed on a client computer, for use with Fiery Impose, Fiery Compose, or Fiery JobMaster.

Note: To use Acrobat from within Fiery Impose, Fiery Compose, or Fiery JobMaster, you must install only one
instance of Acrobat DC on the client computer. Additionally, ensure that other Acrobat versions are not
installed on the same client computer.

Known issues

Reader View

In Fiery Impose, Fiery Compose, Fiery JobMaster, or Fiery Preview, Reader View has been removed on macOS
11 and later.

ImageEnhance Visual Editor

When you maximize the ImageEnhance Visual Editor window on macOS 11, the monitor may flicker for a few
seconds.

PS to PDF conversion

When you use macOS 10.14.5 and later with Fiery Impose, Fiery Compose, or Fiery JobMaster, you may be
prompted to allow Fiery Command WorkStation to have access to Acrobat Distiller. This permission is
necessary for the conversion of PS files to PDF. If you do not grant permission, the conversions will not be
successful and you will need to change the Automation security feature in macOS.

1 Close all Fiery applications.

2 Close Acrobat Distiller.

3 Go to System Preferences > Security & Privacy > Privacy > Automation.

4 Click the Lock icon in the bottom-left corner and enter your password.

5 In the Apps list, locate Fiery Command WorkStation.app.

6 Select the Acrobat Distiller.app option.
This allows Fiery Command WorkStation to have access to Acrobat Distiller.
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macOS 10.15 (Catalina) information

Fiery Preview, Fiery Impose, Fiery Compose, or Fiery JobMaster on macOS 10.15

PDF Support Applications kit

The PDF Support Applications kit (provided by EFI), which consists of Adobe Acrobat and Enfocus PitStop, is
not compatible with macOS 10.15 (Catalina). If you use Acrobat and/or PitStop, do not upgrade to macOS
10.15. For new installations, the PDF Support Applications installer does not run.
Upgrading to macOS 10.15 while using the current PDF Support Applications kit may result in the following
issues:

• If you have Acrobat DC already installed before upgrading to macOS 10.15, it will run normally. However,
the Acrobat DC installer is not compatible with macOS 10.15, so new installations of Acrobat DC are not
possible. Additionally, the included Enfocus PitStop is not supported with macOS 10.15.

• If you have Acrobat XI already installed before upgrading to macOS 10.15, it will not run, and is not
supported for macOS 10.15. We recommend uninstalling Acrobat XI before upgrading to macOS 10.15. The
Acrobat XI uninstaller will not run on macOS 10.15, so if you upgrade to macOS 10.15 with Acrobat XI still
installed, your system will be in a state in which Acrobat XI does not work and cannot be uninstalled.

If a compatible version of Acrobat is not installed, the following issues apply:

• The Edit in Acrobat function is unavailable in Fiery Impose, Fiery Compose, and Fiery JobMaster.

• Opening a PostScript job with Fiery Preview, Fiery Impose, Fiery Compose, or Fiery JobMaster may result in
an error.

• Fiery Impose templates that use the workflows User defined finish size or Based on Trim Box may not work
properly with PostScript jobs.

• Fiery Hot Folders does not provide the option to convert PostScript files to PDF.

Other issues

After you upgrade to macOS 10.15 from an older macOS version, launching Fiery Preview, Fiery Impose, Fiery
Compose, or Fiery JobMaster may cause one of the following messages to be displayed:

• "ICUConverter.framework" will damage your computer. You should move it to the Trash.

• "ICUData.framework" will damage your computer. You should move it to the Trash.

macOS 10.15 erroneously identifies these files as malware. To resolve these issues, reinstall Fiery Command
WorkStation Package version 6.4.0.396 or later, which is compatible with macOS 10.15.
When you hover your mouse over buttons for any of the control icons in Fiery Preview, Fiery Impose, Fiery
Compose, or Fiery JobMaster, the tool tips are not displayed.

Full Disk Access

Because of changes in how macOS 10.15 manages security, there are now additional steps required to allow
Fiery applications to function properly.
You need to make changes to the Full Disk Access security feature in macOS in order for Fiery applications to
manage updates and access files such as Impose templates and hot folders. Enable Full Disk Access for Fiery
applications such as Fiery Command WorkStation.
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1 Close all Fiery applications.

2 Go to System Preferences > Security & Privacy > Privacy > Full Disk Access.

3 Click the Lock icon in the bottom-left corner and enter your password.

4 Click the + button.

5 In the Applications folder, select Fiery Software Manager and Fiery Software Uninstaller and click Open.
These applications require full disk access in order to maintain and update Fiery applications on your
computer.

6 In the Applications folder, select the Fiery Command WorkStation application and click Open.

7 If you use Fiery Hot Folders or Fiery Remote Scan, select each application and click Open.
When Fiery Hot Folders detects that the Documents, Desktop, and Downloads folders are being used, it
issues a message requesting full disk access. This message is still displayed even after access has been granted.
You can dismiss this message and continue working.

Safari browser errors on macOS 10.15

If you use Safari on macOS 10.15, you will encounter repetitive browser errors when trying to open the following
webpages from Fiery Command WorkStation Device Center > General > Tools:

• Fiery System Restore

• Fiery System Image

• Fiery Resources and Settings

These errors can also occur when you open Fiery WebTools in the Safari browser.
Use Chrome or Firefox to access these webpages.

Fiery XF on macOS 10.15

If you use Fiery XF on macOS 10.15, you need to upgrade Fiery Color Profiler Suite to version 5.3.1. With Fiery
Color Profiler Suite version 5.3.1, the macOS 10.15 compliant Fiery Verify is now available to Fiery XF users as
the default verification application.
Color Verifier is not compliant with macOS 10.15, but is still supported on the older macOS versions. But you
need to install Color Verifier separately. Download Color Verifier for macOS 10.14 and earlier versions from the
Download Center.

Fiery Color Profiler Suite and Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) and earlier versions are not fully compatible with Fiery Command
WorkStation Package 6.5 (CWS) for cutsheet printers. We recommend updating to Fiery Color Profiler Suite
5.1.
When using CPS 5.0 with CWS 6.5, you may experience the following issues:

• If you see a message in CWS "Connect the spectrophotometer to your computer" while CPS is currently
open, close CPS and click OK to continue.

• After you create a new calibration setting in Calibrator, the Create new profile button to launch CPS is
hidden. This issue is resolved after upgrading to CPS 5.1.
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Edit in Acrobat option from Fiery Impose, Fiery Compose, or Fiery JobMaster opens two Acrobat
windows

On Windows computers, when the Edit in Acrobat option is selected from within Fiery Impose, Fiery Compose,
or Fiery JobMaster, Acrobat may open in two windows instead of one. This is a known issue. You can close the
Adobe Acrobat window and continue to work in the window with the PDF.

Setting Preferences in Adobe Acrobat Distiller for PostScript to PDF conversion

Fiery Impose, Fiery Compose, and Fiery JobMaster require Acrobat Distiller to convert PostScript (PS) files to
PDF on a client computer.
Due to enhanced security settings in Acrobat Distiller, you must confirm that the PS file to be converted is from
a trustworthy source in: Acrobat Distiller > File > Preferences > Preferences - Acrobat Distiller, select Trust all files
opened via Acrobat Distiller under Security.

Note: If Trust all files opened via Acrobat Distiller is not selected, you are prompted to confirm that the file is
from a trustworthy source for every PS file to be converted to PDF. This also applies to Hot Folders when the
Microsoft Office filter is selected, Output file type is specified as PDF, and a joboptions file is selected as a Distiller
profile.

Cannot start Configure from macOS computer

If your Fiery server runs system FS100, you cannot start Configure from these operating system versions:

• mac10.14.6, and later versions of 10.14

• macOS 10.15 (all versions)

To connect to Fiery Command WorkStation, use a macOS computer with an earlier version of macOS, or use a
Windows computer.

Delay in starting Fiery Impose, Fiery Compose, or Fiery JobMaster

Fiery Impose, Fiery Compose, and Fiery JobMaster may take longer to start than in previous versions. To reduce
the length of time to open one of these applications, start Fiery Preview first, and then the application you want
to use.

Issues fixed in Fiery Command WorkStation Package v6.5.0.599

Fiery Command WorkStation

• The measurement results with the ES-3000 spectrophotometer were not accurate.

Issues fixed in Fiery Command WorkStation Package v6.5.0.581

Fiery Command WorkStation

• When you are using the TIFF input format in Fiery Hot Folders, the image positioning settings were not applied
correctly for a few languages.

• Fiery Command WorkStation Package 6.5 supports Windows 10, version 20H2.
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Fiery XF

• When you add a Fiery XF server with the Save Password preference turned on and you restart the Fiery XF
server, Fiery Command WorkStation Package does not start successfully.

Issues fixed in Fiery Command WorkStation Package v6.5.0.563

Fiery Command WorkStation

• On a Japanese-language system, when you log in with a newly created administrator account, Fiery Spot Pro fails
to open.

Fiery XF

• In Fiery Command WorkStation Job Center, the Job Status column reports that the verification was not
successful, even if the job passed all the tests in Fiery Verify.

• In Fiery Command WorkStation Job Center, if the status of a nested job was To Verify, Fiery Verify did not start
when you clicked Verify from the Job Summary pane of the parent job. Fiery Verify opens if you click Optimize or
Details from Job Summary pane of a child job.

Issues fixed in Fiery Command WorkStation Package v6.5.0.539

Fiery Command WorkStation

• After you imposed a PPML job with a 4-up template and processed it, some pages of the job were not displayed
in Fiery ImageViewer.

Fiery XF

• You could not specify a value more than 59.4 cm for the Custom width setting in Command WorkStation Server
Manager > Layout > Step and Repeat > Pattern.

Issues fixed in Fiery Command WorkStation Package v6.5.0.512

Fiery Command WorkStation

• On a Japanese-language system, when you print a job that was edited using Fiery ImageViewer, the Fiery server
stopped responding.

• The display of edit boxes of a job in wireframe view in Fiery Impose is now aligned with the wireframes.

Fiery XF

• If you changed the media name or associated a calibration file (*.EPL) to a media profile with a different name in
Color Tools > Connect Profiles, the compatible printer information was removed from the calibration file (*.EPL).

• You could not save the Glue Area setting in Job Editor > Overlap/Glue.

• XF 7.2 supports the X-Rite i1Pro3 and EFI ES-3000 measurement instruments on macOS computers.
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Issues fixed in Fiery Command WorkStation Package v6.5.0.475

Fiery Command WorkStation

• In Fiery Spot Pro, you can now specify the separation values for Spot Colors and Substitute Colors to one
decimal place.

• In Fiery Spot Pro, the Revert To Factory option is now disabled for spot colors in a duplicated group.

• You can reinstall and activate Adobe Acrobat Pro 2017 and Enfocus PitStop Edit 2019 from Fiery Software
Manager.

Fiery XF

• With VUTEk roll-to-roll superwide format printers, the print mode setting in Special Settings > White ink
printing always changed back to Spot color WHITE_INK.

• With the system language of the Fiery server set to Polish, the Cut Server application did not recognize nesting
jobs.

Issues fixed in Fiery Command WorkStation Package v6.5.0.433

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 supports Windows 10 version 2004.

• When you printed a booklet job using a Fiery Impose template that is saved as a preset, sometimes the cover
media setting was not applied.

• Occasionally you could not start Fiery Impose, Fiery Compose, or Fiery JobMaster because an incorrect error
message stated that the application was already open. This issue has been fixed.

• When you had multiple licenses activated, you could not restore the License Activation Codes (LACs) while
restoring a Fiery server using Fiery System Restore. This issue has been fixed.

Fiery XF

• A system user name containing space or special characters caused Job Editor not to display job previews.

• On an Italian-language system, after you upgraded Fiery Command WorkStation 6.5 to the latest version, Job
Editor stopped responding.

Issues fixed in Fiery Command WorkStation Package v6.5.0.367

Fiery Command WorkStation

• In some languages, text placed on tabs using Fiery Compose or Fiery JobMaster appeared correctly when viewed
on the computer, but the text was not displayed when the tabs were printed.

• When PDF forms with data entered in the form fields were saved from Fiery Compose or Fiery JobMaster, the
form fields were not displayed in Preview or in the printed output.

• You could not recalibrate a calibration set with custom paper size 241x330 mm, if you changed the paper size
from 241x330 mm to 13x19 inches.

• You could not measure a calibration page if you connected a spectrophotometer to any computer after printing
the calibration page.
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Fiery XF

• On some Windows platforms, Job Editor was not able to display the preview of jobs.

Issues fixed in Fiery Command WorkStation Package v6.5.0.292

Fiery Command WorkStation

• The Arial font was displayed as italic on some Windows computers after you installed the Fiery Command
WorkStation Package 6.5.

• The default settings that you defined with the Set Defaults feature were not applied to the Sequential Print
queue.

• In Fiery JobMaster, if you inserted or deleted pages from a PDF job with bookmarks while inserting tabs or blank
sheets, the bookmarks shifted to different pages.

• Occasionally, macOS computers with a non-English language operating system generated corrupt IT8
measurement data.

Fiery XF

• In Color Tools > Create Calibration > Gray Balance, the delta E values changed every time you opened a saved EPL
file

• With the system language of the Fiery server set to Polish, the Cut Server application did not recognize nesting
jobs.

• When you recalibrated the Fiery XF server, the default Workflow that you set in the Server Manager window was
not applied.

Issue fixed in Fiery Command WorkStation Package v6.5.0.171 SP1

• When you used the Assign Media action in Fiery Impose, a message warned about an incorrect sRGB profile.

Issues fixed in Fiery Command WorkStation Package v6.5.0.171

Fiery XF

• Unable to create Base Line for EPSON SC-P75x0/SC-P95x0 RGB

• Unable to select label printing for EPSON SC-P75x0 and SC-P95x0

• Unable to calibrate EPSON 9500 with 44-inch media
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Notes de mise à jour client
Fiery Command WorkStation Package, version 6.5

Le présent document contient des informations importantes concernant cette version. Distribuez-le à tous les
utilisateurs avant de procéder à l’installation.

À propos de cette version

Cette version comprend les applications suivantes :

• Fiery Command WorkStation Package version 6.5.0.599

• Fiery Command WorkStation version 6.5.0.57

• Fiery Hot Folders pour Mac 4.1.0.21

• Fiery Hot Folders pour Windows 4.1.0.21

• Fiery Software Manager version 4.4.0.18

Mise à niveau

Cet installateur met à niveau tout Fiery Command WorkStation Package existant vers le dernier package contenant
Fiery Command WorkStation et des Fiery Hot Folders. Vous pouvez également installer Fiery Remote Scan à l'aide
de Fiery Software Manager.
Fiery Command WorkStation Package prend en charge les Fiery servers exécutant le logiciel FS 100 et ses versions
ultérieures ainsi que Fiery proServer et Fiery XF 7.0 et ses versions ultérieures. Il ne se connecte pas aux serveurs
suivants :

• Fiery servers exécutant le logiciel Fiery System 9/9e Rel2, ainsi que le logiciel System 10 et ses versions
antérieures

• Les serveurs Fiery XF 6.x et versions antérieures ;

• Serveurs Fiery Central

S'il vous faut accéder à ces serveurs, n'effectuez pas la mise à niveau. Fiery Extended Applications Le package est
toujours disponible sur www.efi.com/cws. Pour une liste complète des imprimantes à feuilles prises en charge,
consultez http://fiery.efi.com/CWS/supported-printers.
Pour plus d’informations sur les spécifications techniques, consultez le site www.efi.com/cws.
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Nouvelles fonctionnalités

Nouveautés

Pour plus d’informations sur les nouvelles fonctionnalités ajoutées à la publication initiale de la version 6.5,
visitez http://fiery.efi.com/CWS/Whats-New.
Pour plus d’informations sur les nouvelles fonctionnalités ajoutées après la publication initiale de la version 6.5,
voir les informations ci-dessous.

Fiery Spot Pro

Fiery Command WorkStation6.5 permet de gérer les tons directs avec Fiery Spot Pro, qui remplace Fiery Spot-
On. Pour obtenir la liste complète des améliorations, consultez https://www.EFI.com/spotpro.
Fiery Spot Pro est disponible pour les serveurs sélectionnés suivants :

• Logiciel FS200 Pro et versions ultérieures

• Fiery Graphic Arts Package, Premium Edition

Pour en savoir plus, visitez le site http://fiery.efi.com/spotpro/supported-printers.
Si Fiery Spot Pro n'est pas activé sur votre Fiery server, Fiery Command WorkStation continuera de prendre en
charge Fiery Spot-On.

Remarques relatives à l’utilisation de Fiery Spot Pro

• N’utilisez pas le symbole "@" dans les noms des tons directs.

• Une fois que vous avez démarré Spot Pro, attendez environ 60 à 120 secondes avant d’utiliser la fonction de
recherche ou de changer de profil de sortie.

• L’optimisation des tons directs après plusieurs itérations peut entraîner des différences plus prononcées
entre les tons directs d'origine et les tons directs convertis.

• Il existe un léger arrondissement des valeurs numériques L*a*b* converties et des valeurs CMYK du
périphérique.

• Deux occurrences de Spot Pro sur différents systèmes utilisateur connectés au même Fiery server peuvent
entraîner des erreurs si les deux utilisateurs effectuent des opérations de modification.

Prise en charge d’EFI ES-3000

Le nouvel instrument de mesure EFI ES-3000 est pris en charge par une émulation EFI ES-2000 dans Fiery
Command WorkStation 6.5. L’EFI ES-3000 est une mise à niveau de l’EFI ES-2000 et prend en charge les
mesures de numérisation unique des modes de mesure M1 et M2. Vous pouvez utiliser l’instrument EFI ES-3000
(en sélectionnant l’entrée « EFI ES-2000 » dans l’interface utilisateur) avec les fonctions Fiery Calibrator, Fiery
Spot Pro et simulation papier de Fiery Command WorkStation.

Remarque : L’émulation ES-2000 (« EFI ES-2000 » dans l’interface utilisateur) peut être utilisée conjointement
avec l’EFI ES-2000.
Pour plus d’informations sur l’utilisation de l’EFI ES-3000 avec d’autres applications, consultez la documentation
de ces applications.
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Notifications de licences pour le package d'options Fiery

Les notifications relatives aux mises à jour disponibles du serveur sont désormais répertoriées dans la nouvelle
section Notifications de Fiery Command WorkStation. Les notifications s’affichent lorsque les licences des
options Fiery installées approchent de leur date d’expiration ou qu’elles ont expiré. Les notifications s'affichent
dans Fiery Command WorkStation, Fiery Hot Folders et Fiery WebTools.

Remarque : Vous pouvez afficher à tout moment les informations d’expiration de licence dans WebTools >
Accueil Assemblage Fiery Command WorkStation > Vue périphérique > Général > Informations générales.
Les notifications d'expiration offrent les options suivantes :

• Renouveler maintenant

• Ignorer

• En savoir plus

Prise en charge de Fiery JobExpert Report

La Fiery Command WorkStation 6.5 connectée aux serveurs FS400 vous permet de prévisualiser les
améliorations apportées à la tâche à l’aide de Fiery JobExpert.
Fiery JobExpert Report fournit une présentation des paramètres des propriétés de tâche suggérés appliqués à vos
tâches à l’aide de Fiery JobExpert.

Prise en charge d'Adobe Acrobat Pro 2017 et Enfocus PitStop Edit 2019

L’option Adobe Acrobat Pro 2017 et Enfocus PitStop Edit 2019 est disponible en téléchargement à partir de
Fiery Software Manager.

Prise en charge des instruments de mesure dans Fiery XF Color Editor

Les instruments de mesure à échantillon unique et optimisation simple suivants sont pris en charge :

Instrument de mesure Échantillon unique Optimisation

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

Prise en charge du point final de l'encre claire variable

Fiery XF permet de configurer un point final de l'encre claire en vue d'économiser l'encre claire sur les fichiers
de calibrage.
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Pour créer un fichier de calibrage de gain d'encre, diminuez la quantité d'encre claire en modifiant la valeur
Point final de l'encre claire dans l’onglet Limite d’encre et calibrage de Color Tools.

Prise en charge de la mise en page du correctif 1617 (CGATS IT8.7/5)

Fiery XF prend en charge une charte de profil dans Color Tools avec les correctifs  1617.
La cible 1617 est une cible de caractérisation imprimante CMYK associant les valeurs d'échantillons uniques à la
cible standard IT8.7/4 avec toutes les valeurs d'échantillons dans les colonnes 4 et 5 de la cible P2P51.

Prise en charge de la création de préréglages personnalisés de Verifier à partir de Server Manager

Vous pouvez créer des préréglages personnalisé dans XF-Verifier à partir de Server Manager.

Prise en charge de la conservation de l'emplacement du dossier d'un fichier de sauvegarde Hot
Folder

Lorsque vous restaurez Hot Folders à partir d'un fichier de sauvegarde, vous pouvez désormais conserver les
emplacements des dossiers d'origine du fichier de sauvegarde.

EFI IQ applications Web

Vous pouvez enregistrer les applications web EFI IQ à partir de l'écran d'accueil de la Command WorkStation.
Les applications web EFI IQ donnent plus de visibilité à votre production d'impression grâce à de puissantes
analyses d'impression.

Configuration système requise :

Versions prises en charge

La Fiery Command WorkStation prend en charge ces systèmes d’exploitation pour votre ordinateur :

• macOS 11 (uniquement avec les processeurs Intel)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10, 64 bits

• Windows Server 2019, 64 bits

• Windows Server 2016, 64 bits

• Windows 8.1, 64 bits

• Windows 7, 64 bits

• Windows Server 2012 R2, 64 bits

• Windows Server 2008 R2, 64 bits

Notes de mise à jour client
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Prise en charge interrompue

• macOS 10.11

• macOS 10.12

• System 10 et versions antérieures

Lorsque vous effectuez une mise à jour de la Fiery Command WorkStation vers la version 6.5, tous les serveurs
sous System  10 précédemment ajoutés seront supprimés de la liste de serveurs. Vous ne pouvez pas utiliser un
Fiery server sous System 10 ou sa version antérieure car seul un Fiery server exécutant FS100 ou ses versions
ultérieures est pris en charge.

Application 64 bits

Fiery Command WorkStation 6.5 (CWS) est une application 64 bits native pour les plateformes macOs et
Windows.
Les systèmes d’exploitation 32 bits ne sont pas pris en charge par CWS 6.5. Si Fiery Software Manager est déjà
en cours d’exécution sur un système d’exploitation 32 bits comme Windows 7 32 bits, il n'affichera pas les
notifications de mise à jour du package CWS 6.5. Si vous essayez d’installer cette version de Fiery Software
Manager sur un système d’exploitation de 32 bits, une erreur de compatibilité se produira et Fiery Software
Manager ne s'exécutera pas. Pour afficher les systèmes d’exploitation pris en charge, consultez le site http://
fiery.efi.com/cws-specifications.

Prise en charge de l’abonnement Adobe Acrobat DC pour une utilisation avec Fiery Impose, Fiery
Compose ou Fiery JobMaster

Fiery Command WorkStation Package v6.5.0.292 prend en charge l’utilisation des abonnements personnels/
individuels d’Acrobat DC installés sur un ordinateur client, pour une utilisation avec Fiery Impose, Fiery
Compose ou Fiery JobMaster.

Remarque : Pour utiliser Acrobat dans Fiery Impose, Fiery Compose ou Fiery JobMaster, vous ne devez installer
qu’une seule instance d’Acrobat DC sur l’ordinateur client. En outre, assurez-vous que d’autres versions
d’Acrobat ne sont pas installées sur le même ordinateur client.

Problèmes identifiés

Aperçu en lecture seule

Dans Fiery Impose, Fiery Compose, Fiery JobMaster ou Fiery Preview, l'Affichage du mode de lecture a été
supprimé sur macOS 11 et versions ultérieures.

ImageEnhance Visual Editor

Lorsque vous maximisez la fenêtre ImageEnhance Visual Editor sur macOS  11, le moniteur peut clignoter
pendant quelques secondes.
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Conversion PS en PDF

Lorsque vous utilisez macOS 10.14.5 et ses versions ultérieures avec Fiery Impose, Fiery Compose, ou Fiery
JobMaster, vous pouvez être invité à autoriser l'accès d'Acrobat Distiller à la Fiery Command WorkStation.
Cette autorisation est nécessaire pour la conversion des fichiers PS au format PDF. Les conversions ne sont pas
effectuées correctement lorsque la permission n'est pas accordée. Vous devrez modifier la fonction de sécurité
automatique dans macOS.

1 Fermer toutes les applications Fiery.

2 Fermez Acrobat Distiller.

3 Atteindre Préférences du système > Sécurité et confidentialité > Confidentialité > Automatisation.

4 Cliquez sur l'icône du verrou dans le coin inférieur gauche et saisissez le mot de passe.

5 Dans la liste des applications, localisez Fiery Command WorkStation. app.

6 Sélectionnez l’option Acrobat Distiller. app.
Cela permet à la Fiery Command WorkStation d’accéder à Acrobat Distiller.

informations sur macOS 10.15 (Catalina)

Aperçu Fiery, Fiery Impose, Fiery Compose, ou Fiery JobMaster sous macOS 10.15

Kit d'applications de prise en charge PDF

Le kit d’applications de prise en charge PDF (fourni par EFI) constitué d'Adobe Acrobat et d'Enfocus PitStop est
incompatible avec macOS 10.15 (Catalina). Si vous utilisez Acrobat et/ou PitStop, veuillez ne pas effectuer de
mise à niveau vers macOS 10.15. Le programme d’installation des applications de prise en charge PDF ne
s’exécute pas pour les nouvelles installations.
Lorsque le kit d’applications de prise en charge PDF est en cours d'utilisation, la mise à niveau vers macOS 10.15
peut causer les problèmes suivants :

• Si Acrobat DC est déjà installé avant de procéder à la mise à niveau vers macOS 10.15, il s'exécute
normalement. Toutefois, le programme d’installation d’Acrobat DC est incompatible avec macOS 10.15.
Impossible donc de procéder à de nouvelles installations d’Acrobat DC. En outre, le logiciel inclus Enfocus
PitStop n’est pas pris en charge par macOS 10.15.

• Acrobat XI ne s’exécute pas et n’est pas pris en charge par macOS 10.15 s'il est déjà installé avant de
procéder à sa mise à niveau vers macOS 10.15. Il est recommandé de désinstaller Acrobat XI avant de
procéder à la mise à niveau vers macOS 10.15. Le programme de désinstallation d’Acrobat XI ne s’exécute
pas sur macOS 10.15. En effectuant donc une mise à niveau vers macOS 10.15 avec Acrobat XI encore
installé, il ne pourra ni fonctionner, ni être désinstallé.

Si aucune version compatible d’Acrobat n’est installée, les problèmes suivants surviennent :

• La fonction Modifier dans Acrobat est indisponible dans Fiery Impose, Fiery Composeet Fiery JobMaster.

• L’ouverture d’une tâche PostScript avec Aperçu Fiery peut entraîner une erreur dans Fiery ImposeFiery
Composeou Fiery JobMaster.

• Les modèles Fiery Imposequi utilisent les flux de production Taille de finition définie par l’utilisateur ou Basé
sur la zone de coupe risquent de ne pas fonctionner correctement avec les tâches PostScript.

• Fiery Hot Foldersne dispose pas d'options de conversion des fichiers PostScript au format PDF.
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Autres types de problèmes

Après la mise à niveau d'une version plus ancienne de macOS vers macOS 10.15, le lancement de l'Aperçu Fiery,
Fiery Impose, Fiery Compose, ou Fiery JobMaster peut faire afficher l’un des messages suivants :

• "ICUConverter.Framework" endommage votre ordinateur. Veuillez l'envoyer à la corbeille.

• "ICUData.Framework" endommage votre ordinateur. Veuillez l'envoyer à la corbeille.

macOS 10.15 assimile par erreur ces fichiers à des logiciels malveillants. Pour résoudre ce problème, veuillez
réinstallez Fiery Command WorkStation Package version 6.4.0.396 ou ultérieure, qui est compatible avec macOS
10.15.
Les infobulles ne s'affichent pas lorsque vous plaçez le curseur de la souris sur l’une des icônes de paramètre de
l'Aperçu Fiery Fiery Impose, Fiery Compose ou Fiery JobMaster

Accès complet au disque

En raison des améliorations apportées dans la façon dont macOS 10.15 gère la protection, des opérations
supplémentaires sont désormais nécessaires pour que les applications Fiery fonctionnent correctement.
Il est nécessaire de modifier les options de protection d'Accès complet au disque dans macOS afin que les
applications Fiery puissent gérer les mises à jour et accéder aux fichiers tels que les modèles Impose et les hot
folders. Activer l’Accès complet au disque pour les applications Fiery telles que Fiery Command WorkStation.

1 Fermer toutes les applications Fiery.

2 Aller à Préférences du système > Sécurité et confidentialité > Confidentialité > Accès complet au disque.

3 Cliquer sur l'icône du verrou dans le coin inférieur gauche et saisir le mot de passe.

4 Cliquer sur le bouton +.

5 Dans le dossier Applications, sélectionner Fiery Software Manager et Fiery Software Uninstaller et cliquer sur
Ouvrir.
Ces applications nécessitent un accès complet au disque pour pouvoir conserver et mettre à jour les
applications Fiery sur votre ordinateur.

6 Ouvrir le dossier Applications, sélectionner l'application Fiery Command WorkStation et cliquer sur Ouvrir.

7 Si vous utilisez Fiery Hot Folders ou Fiery Remote Scan, sélectionnez chaque application, puis cliquez sur
Ouvrir.
Fiery Hot Folders génère un message demandant un accès complet au disque lorsqu'il détecte que les dossiers
Documents, Bureau et Téléchargements sont en cours d'utilisation. Ce message continue de s’afficher même
après l’autorisation d’accès. Vous pouvez supprimer ce message et continuer de travailler.

Erreurs du navigateur Safari sur macOS 10,15

Si vous utilisez Safari sous macOS 10,15, vous rencontrez des erreurs récurrentes sur votre navigateur lorsque
vous essayez d’ouvrir les pages Web suivantes à partir de la Fiery Command WorkStation Vue périphérique >
Général > Onglet:

• Restauration système Fiery

• Image du système Fiery

• Paramètres et ressources Fiery

Ces erreurs peuvent également se produire lorsque vous ouvrez Fiery WebTools dans le navigateur Safari.
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Utilisez chrome ou Firefox pour accéder à ces pages.

Fiery XF sur macOS 10.15

Si vous utilisez Fiery XF sur macOS 10.15, vous devez mettre à niveau Fiery Color Profiler Suite vers la
version 5.3.1. Avec Fiery Color Profiler Suite version 5.3.1, la version de Fiery Verify compatible macOS 10.15 est
désormais disponible pour les utilisateurs de Fiery XF en tant qu'application de vérification par défaut.
La fonction Color Verifier n’est pas compatible avec macOS 10.15, mais est toujours prise en charge par les
versions plus anciennes de macOS. Vous devez cependant installer Color Verifier séparément. Téléchargez
Color Verifier pour macOS 10.14 et les versions antérieures à partir du Centre de téléchargement.

Fiery Color Profiler Suite et Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) et les versions antérieures ne sont pas entièrement compatibles avec Fiery
Command WorkStation Package 6.5 (CWS) pour les imprimantes à feuilles. Nous vous recommandons
d’effectuer une mise à jour vers Fiery Color Profiler Suite 5.1.
Lorsque vous utilisez CPS 5.0 avec CWS 6.5, vous pouvez rencontrer les problèmes suivants :

• Si vous voyez le message suivant dans CWS « Connectez le spectrophotomètre à votre ordinateur » alors que
CPS est ouvert, fermez CPS et cliquez sur OK pour continuer.

• Après avoir créé un nouveau paramètre de calibrage dans Calibrator, le bouton Créer nouveau profil
permettant de lancer CPS est masqué. Ce problème est résolu après la mise à niveau vers CPS 5.1.

L’option Modifier dans Acrobat de Fiery Impose, Fiery Compose ou Fiery JobMaster ouvre deux
fenêtres Acrobat.

Sur les ordinateurs Windows, lorsque l’option Modifier dans Acrobat est sélectionnée dans Fiery Impose, Fiery
Compose ou Fiery JobMaster, Acrobat peut s’ouvrir dans deux fenêtres au lieu d’une. Il s’agit d’un problème
connu. Vous pouvez fermer la fenêtre Adobe Acrobat et continuer à travailler dans la fenêtre avec le PDF.

Définition des préférences dans Adobe Acrobat Distiller pour la conversion de PostScript en PDF

Fiery Impose, Fiery Compose et Fiery JobMaster nécessitent Acrobat Distiller pour convertir les fichiers
PostScript (PS) en PDF sur un ordinateur client.
En raison des paramètres de sécurité améliorée dans Acrobat Distiller, vous devez vérifier que le fichier PS à
convertir provient d’une source fiable dans : Acrobat Distiller > Fichier > Préférences > Préférences - Acrobat
Distiller, sélectionnez Approuver tous les fichiers ouverts via Acrobat Distiller sous Sécurité.

Remarque : Si vous ne sélectionnez pas Approuver tous les fichiers ouverts via Acrobat Distiller, vous êtes invité
à confirmer que le fichier provient d’une source fiable pour chaque fichier PS à convertir en PDF. Cela s’applique
également aux Hot Folders lorsque le filtre Microsoft Office est sélectionné, que le Type de fichier de sortie
spécifié est PDF et qu’un fichier joboptions est sélectionné en tant que Profil Distiller.

Impossible de démarrer Configure à partir d'un ordinateur macOS

Si votre Fiery server fonctionne sous système FS100, vous ne pouvez pas démarrer Configure à partir de des
versions du système d’exploitation suivantes :

• Mac 10.14.6 et versions ultérieures de 10.14

• macOS 10.15 (toutes versions confondues)
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Pour vous connecter à la Fiery Command WorkStation, utilisez un ordinateur macOS doté d’une version
antérieure de macOS ou utilisez un ordinateur Windows.

Retard lors du démarrage de Fiery Impose Fiery Compose, ou Fiery JobMaster

Fiery Impose, Fiery Composeet Fiery JobMaster peut être plus long à démarrer que pour les versions
précédentes. Pour réduire la durée d’ouverture de l’une de ces applications, lancez tout d'abord Fiery Preview,
puis l’application que vous souhaitez utiliser.

Problèmes résolus dans Fiery Command WorkStation Package version 6.5.0.599

Fiery Command WorkStation

• Les résultats des mesures effectuées avec le spectrophotomètre ES-3000 n’étaient pas précis.

Problèmes résolus dans Fiery Command WorkStation Package version 6.5.0.581

Fiery Command WorkStation

• Lorsque vous utilisiez le format d’entrée TIFF dans les Fiery Hot Folders, les paramètres de positionnement de
l’image n’étaient pas appliqués correctement pour quelques langues.

• Fiery Command WorkStation Package 6.5 prend en charge Windows 10 version 20H2.

Fiery XF

• Lorsque vous ajoutez un serveur Fiery XF avec la préférence Enregistrer le mot de passe activée et que vous
redémarrez le serveur Fiery XF, Fiery Command WorkStation Package ne démarre pas correctement.

Problèmes résolus dans Fiery Command WorkStation Package v6.5.0.563

Fiery Command WorkStation

• Lorsque vous vous connectez avec un nouveau compte administrateur sur un système en langue japonaise, Fiery
Spot Pro ne parvient pas à s'ouvrir.

Fiery XF

• Dans la Vue tâches de la Fiery Command WorkStation, la colonne Statut de la tâche signale que la vérification
n’a pas abouti, même si la tâche a réussi tous les tests de Fiery Verify.

• Dans la Vue tâches de la Fiery Command WorkStation, si le statut d’une tâche imbriquée était À vérifier, Fiery
Verify ne démarrait pas lorsque vous cliquiez sur Vérifier à partir du volet Résumé de la tâche de la tâche parent.
Fiery Verify s’ouvre si vous cliquez sur Optimiser ou sur Détails à partir du volet Résumé de la tâche d’une tâche
enfant.
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Problèmes résolus dans Fiery Command WorkStation Package version 6.5.0.539

Fiery Command WorkStation

• Après avoir imposé une tâche PPML avec un modèle 4 poses et le traitement de celle-ci, certaines pages de la
tâche ne s’affichaient pas dans Fiery ImageViewer .

Fiery XF

• Vous ne pouviez pas spécifier une valeur supérieure à 59,4 cm pour le paramètre de largeur personnalisé dans la
Command WorkStation Server Manager > Mise en page > Répétition > Motif.

Problèmes résolus dans Fiery Command WorkStation Package version 6.5.0.512

Fiery Command WorkStation

• Sur un système en langue japonaise, lorsque vous imprimez une tâche qui a été modifiée à l’aide de Fiery
ImageViewer, le Fiery server cesse de répondre.

• L'affichage des zones de modification d'une tâche dans la vue mode filaire dans Fiery Impose est maintenant
aligné avec les modes filaires.

Fiery XF

• Si vous avez modifié le nom du support ou associé un fichier de calibrage (*.EPL) à un profil de support portant
un nom différent dans Outils couleur > Connecter les profils, les informations relatives à l'imprimante compatible
ont été supprimées du fichier de calibrage (*.EPL).

• Il n'a pas été possible d'enregistrer les paramètres de la Zone de collage dans Job Editor > Chevauchement/colle.

• XF 7.2 prend en charge les instruments de mesure X-Rite i1Pro3 et EFI ES-3000 sur les ordinateurs macOS.

Problèmes résolus dans Fiery Command WorkStation Package version 6.5.0.475

Fiery Command WorkStation

• Dans Fiery Spot Pro, vous pouvez maintenant spécifier les valeurs de séparation des tons directs et des couleurs
de remplacement à une seule décimale.

• Dans Fiery Spot Pro, l’option Revenir aux réglages d'usine est désormais désactivée pour les tons directs dans un
groupe dupliqué.

• Vous pouvez réinstaller et activer Adobe Acrobat Pro 2017 et Enfocus PitStop Edit 2019 à partir de Fiery
Software Manager.

Fiery XF

• Avec les imprimantes VUTEk au format roll-to-roll très grand format, le paramètre de mode d’impression dans
Paramètres spéciaux > Impression à l'encre blanche se modifiait toujours en ton direct WHITE_INK.

• Sur le Fiery server, lorsque la langue du système était définie sur le polonais, l’application Serveur de coupe (Cut
Server) ne reconnaissait pas les tâches d’imbrication.
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Problèmes résolus dans Fiery Command WorkStation Package version 6.5.0.433

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 prend en charge Windows 10 version 2004.

• Lorsque vous imprimiez une brochure à l’aide d’un modèle Fiery Impose enregistré en tant que préréglage, le
paramètre de support de couverture n’était parfois pas appliqué.

• Parfois, vous ne pouviez pas démarrer Fiery Impose, Fiery Compose ou Fiery JobMaster car un message d’erreur
incorrect indiquait que l’application était déjà ouverte. Ce problème a été résolu.

• Lorsque plusieurs licences étaient activées, vous ne pouviez pas restaurer les codes d’activation de licence (LAC)
lors de la restauration d’un Fiery server à l’aide de la Restauration système Fiery. Ce problème a été résolu.

Fiery XF

• Job Editor n'affichait pas les aperçus des tâches à cause d'un nom d’utilisateur système contenant un espace ou
des caractères spéciaux.

• Sur un système en langue italienne, après avoir mis à niveau Fiery Command WorkStation 6.5 vers la dernière
version, Job Editor cessait de répondre.

Problèmes résolus dans Fiery Command WorkStation Package v6.5.0.367

Fiery Command WorkStation

• Dans certaines langues, le texte placé sur les onglets à l’aide de Fiery Compose ou Fiery JobMaster apparaissait
correctement lorsqu’il était affiché sur l’ordinateur, mais le texte ne s’affichait pas lorsque les onglets étaient
imprimés.

• Lorsque des formulaires au format PDF avec des données saisies dans les champs de formulaire étaient
enregistrés à partir de Fiery Compose ou Fiery JobMaster, les champs de formulaire ne s’affichaient pas dans la
prévisualisation ou dans la production d'impression.

• Vous ne pouviez pas recalibrer des données de calibrage avec un format papier personnalisé de 241x330 mm, si
vous modifiiez le format papier de 241x330 mm à 13x19 pouces.

• Vous ne pouviez pas mesurer une page de calibrage si vous connectiez un spectrophotomètre à un ordinateur
quelconque après l’impression de la page de calibrage.

Fiery XF

• Sur certaines plateformes Windows, Job Editor n'était pas capable d'afficher la prévisualisation des tâches.

Problèmes résolus dans Fiery Command WorkStation Package v6.5.0.292

Fiery Command WorkStation

• La police Arial s’affichait en italique sur certains ordinateurs Windows après avoir installé Fiery Command
WorkStation Package 6.5.

• Les paramètres par défaut que vous avez définis avec la fonction Définir les paramètres par défaut n’étaient pas
appliquées à la file d’attente d’impression séquentielle.
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• Dans Fiery JobMaster, si vous insériez ou supprimiez des pages à partir d’une tâche PDF et que vous insériez des
onglets ou des feuilles vierges, les signets étaient transférés vers d’autres pages.

• Parfois, les ordinateurs macOS dotés d’un système d’exploitation dans une langue autre que l’anglais généraient
des données de mesure IT8 corrompues.

Fiery XF

• Dans Color Tools > Créer un calibrage > Balance des gris, les valeurs delta E étaient modifiées chaque fois que
vous ouvriez un fichier EPL enregistré.

• Sur le Fiery server, lorsque la langue du système était définie sur le polonais, l’application Serveur de coupe ne
reconnaissait pas les tâches d’imbrication.

• Lors du recalibrage du serveur Fiery XF, le flux de production par défaut défini dans la fenêtre Server Manager
n’était pas appliqué.

Problèmes résolus dans Fiery Command WorkStation Package v6.5.0.171 SP1

• Lorsque vous utilisez l'action Attribuer un support dans Fiery Impose, un message vous avertit d'un profil sRGB
incorrect.

Problèmes résolus dans Fiery Command WorkStation Package v6.5.0.171

Fiery XF

• Impossible de créer la ligne de base RGB pour l'EPSON SC-P75x0/SC-P95x0

• Impossible de sélectionner l'impression d'étiquette pour l'EPSON SC-P75x0 et SC-P95x0

• Impossible de calibrer l'EPSON 9500 avec un support de 44 pouces
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Note di release per l’utente
Fiery Command WorkStation Package, v6.5

Questo documento contiene importanti informazioni su questa release. Distribuire una copia di questo documento a
tutti gli utenti prima di procedere con l’installazione.

Informazioni su questa release

Questa release comprende le seguenti applicazioni:

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Fiery Hot Folders per Mac 4.1.0.21

• Fiery Hot Folders per Windows 4.1.0.21

• Fiery Software Manager v4.4.0.18

Aggiornamento

Questo programma di installazione aggiornerà qualsiasi Fiery Command WorkStation Package esistente all'ultima
versione del pacchetto contenente Fiery Command WorkStation e Fiery Hot Folders. Facoltativamente, è possibile
installare Fiery Remote Scan utilizzando Fiery Software Manager.
Fiery Command WorkStation Package supporta Fiery servers che eseguono FS100 e versioni successive, Fiery
proServer e Fiery XF 7.0 e versioni successive. Non si collega a:

• Fiery servers con software Fiery System 9/9e Rel2, System 10 e versioni precedenti

• Server Fiery XF 6.x e versioni precedenti

• Server Fiery Central

Se è necessario accedere a questi prodotti, non eseguire l'aggiornamento. Fiery Extended Applications Il pacchetto è
disponibile all'indirizzo www.efi.com/cws. Per l’elenco completo delle stampanti a foglio singolo supportate, vedere 
http://fiery.efi.com/CWS/supported-printers.
Per ulteriori informazioni sulle specifiche tecniche, vedere www.efi.com/cws.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


Nuove funzioni

Novità

Per informazioni sulle nuove funzioni aggiunte nella release iniziale della versione 6.5, visitare http://
fiery.efi.com/CWS/Whats-New.
Per informazioni sulle nuove funzioni aggiunte nella release iniziale della versione 6.5, vedere le informazioni qui
sotto.

Fiery Spot Pro

Fiery Command WorkStation 6.5 consente di gestire le tinte piatte con Fiery Spot Pro, che sostituisce Fiery
Spot-on. Per un elenco completo dei miglioramenti, vedere https://www.EFI.com/spotpro.
Fiery Spot Pro è disponibile per i server selezionati con i seguenti requisiti:

• Software FS200 Pro e versioni successive

• Fiery Graphic Arts Package, Premium Edition

Ulteriori informazioni disponibili su http://fiery.efi.com/spotpro/supported-printers.
Se il vostro Fiery server non dispone di Fiery Spot Pro abilitato, Fiery Command WorkStation continuerà a
supportare Fiery Spot-on.

Considerazioni sull'uso di Fiery Spot Pro

• Non usare il simbolo "@" nei nomi di tinte piatte.

• Dopo aver avviato Spot Pro, attendere circa 60-120 secondi prima di usare la funzione di ricerca o cambiare i
profili di destinazione.

• L'ottimizzazione delle tinte piatte dopo diverse iterazioni potrebbe causare differenze più evidenti tra la tinta
piatta originale e una tinta piatta convertita.

• Vi è un leggero arrotondamento numerico dei valori L*a*b* convertiti e dei valori CMYK del dispositivo.

• Due istanze di Spot Pro su diversi sistemi utente che si collegano allo stesso Fiery server potrebbero causare
errori se entrambi gli utenti eseguono operazioni di modifica.

Assistenza per EFI ES-3000

Il nuovo strumento di misurazione EFI ES-3000 è supportato tramite un'emulazione di EFI ES-2000 in Fiery
Command WorkStation 6.5. EFI ES-3000 è un aggiornamento di EFI ES-2000 e supporta le misurazioni a
scansione singola nelle modalità di misurazione M1 e M2. È possibile utilizzare lo strumento EFI ES-3000
(selezionando la voce "EFI ES-2000" nell'interfaccia utente) con le funzionalità Fiery Calibrator, Fiery Spot Pro e
Simulazione carta di Fiery Command WorkStation.

Nota: L'emulazione ES-2000 (la voce "EFI ES-2000" nell'interfaccia utente) può essere usata anche insieme a EFI
ES-2000.
Per informazioni su come usare EFI ES-3000 con applicazioni diverse, vedere la documentazione fornita con tali
applicazioni.
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Notifiche licenza Pacchetto di opzioni Fiery

Le notifiche relative agli aggiornamenti del server disponibili sono ora elencate nella sezione Nuove notifiche in
Fiery Command WorkStation . Le notifiche vengono visualizzate quando le licenze delle opzioni Fiery installate
si avvicinano alla data di scadenza o sono scadute. Le notifiche vengono visualizzate in Fiery Command
WorkStation , Fiery Hot Folders e Fiery WebTools.

Nota: È possibile visualizzare le informazioni sulla scadenza della licenza in qualsiasi momento in WebTools >
Pagina iniziale e Fiery Command WorkStation > Centro periferica > Generale > Informazioni generali.
Le notifiche di scadenza forniscono le seguenti opzioni:

• Rinnova ora

• Chiudi

• Ulteriori informazioni

Supporto per il report Fiery JobExpert

Fiery Command WorkStation 6.5 collegato ai server FS400 consente di visualizzare in anteprima i miglioramenti
apportati al lavoro tramite Fiery JobExpert.
Il report Fiery JobExpert fornisce una panoramica delle impostazioni delle proprietà del lavoro suggerite
applicate ai lavori utilizzando Fiery JobExpert.

Supporto per Adobe Acrobat Pro 2017 ed Enfocus PitStop Edit 2019

L'opzione Adobe Acrobat Pro 2017 ed Enfocus PitStop Edit 2019 è disponibile per il download da Fiery Software
Manager.

Supporto per strumenti di misurazione in Color Editor di Fiery XF

Sono supportati i seguenti strumenti di misurazione di campione singolo e ottimizzazione:

Strumento di misurazione Campione singolo Ottimizzazione

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

Supporto per punto finale inchiostro chiaro

Fiery XF consente di impostare un punto finale inchiostro chiaro per risparmiare inchiostro chiaro sui file
calibrazione.
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Per creare un file di calibrazione di risparmio di inchiostro, ridurre la quantità di inchiostro chiaro modificando
il valore Punto finale inchiostro chiaro nella scheda Limite inchiostro e calibrazione di Color Tools.

Supporto per 1617 (CGATS IT 8.7/5) layout campione

Fiery XF supporta un grafico per la creazione dei profili in Color Tools con i campioni 1617.
Il target 1617 è un target di caratterizzazione della stampante CMYK che combina i valori dei campioni univoci
nel target IT8.7/4 standard con tutti i valori dei campioni nelle colonne 4 e 5 del target P2P51.

Supporto per la creazione di preimpostazioni personalizzate di Verifier da Server Manager

È possibile creare preimpostazioni personalizzate in XF-Verifier da Server Manager.

Supporto per il mantenimento del percorso della cartella di un file di backup di una cartella
automatica

Quando si ripristinano le cartelle automatiche da un file di backup è ora possibile mantenere le ubicazioni
originali della cartella del file di backup.

Applicazioni web di EFI IQ

È possibile registrare le applicazioni web EFI IQ dalla pagina iniziale di Command WorkStation. Le applicazioni
web di EFI IQ forniscono maggiore visibilità alla produzione di stampa con utili dati analitici sulla stampa.

Aggiornamenti ai requisiti di sistema

Versioni supportate

Fiery Command WorkStation supporta i seguenti sistemi operativi dei computer:

• macOS 11 (solo con processori Intel)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10 (64 bit)

• Windows Server 2019 (64 bit)

• Windows Server 2016 (64 bit)

• Windows 8.1 (64 bit)

• Windows 7 (64 bit)

• Windows Server 2012 R2 (64 bit)

• Windows Server 2008 R2 (64 bit)
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Supporto non disponibile

• macOS 10.11

• macOS 10.12

• System 10 e versioni precedenti

Quando si esegue l'aggiornamento di Fiery Command WorkStation alla versione 6.5, tutti i server System 10
aggiunti in precedenza verranno rimossi dall'elenco dei server. Se si tenta di accedere a un Fiery server che
esegue System 10 o versioni precedenti, non è possibile utilizzare questo server perché è supportato
esclusivamente un Fiery server che esegue FS100 e versioni successive.

Applicazione a 64 bit

Fiery Command WorkStation 6.5 (CWS) è un'applicazione nativa a 64 bit per piattaforme Mac OS e Windows.
I sistemi operativi a 32 bit non sono supportati per CWS 6.5. Se Fiery Software Manager è già in esecuzione su
un sistema operativo a 32 bit, ad esempio Windows 7 a 32 bit, non verranno visualizzate le notifiche di
aggiornamento per il pacchetto CWS 6.5. Se si tenta di eseguire questa versione di Fiery Software Manager su un
sistema operativo a 32 bit, verrà visualizzato un errore di compatibilità e Fiery Software Manager non verrà
eseguito. Per visualizzare i sistemi operativi supportati, vedere http://fiery.efi.com/cws-specifications.

Assistenza per l'abbonamento ad Adobe Acrobat DC per l'uso con Fiery Impose, Fiery Compose o
Fiery JobMaster

Fiery Command WorkStation Package versione 6.5.0.292 supporta l'uso di abbonamenti personali/di proprietà
di Acrobat DC installati su un computer client, da utilizzare con Fiery Impose, Fiery Compose o Fiery
JobMaster.

Nota: Per usare Acrobat su Fiery Impose, Fiery Compose o Fiery JobMaster, è necessario installare un'unica
istanza di Acrobat DC sul computer client. Inoltre, assicurarsi che altre versioni di Acrobat non siano installate
sullo stesso computer client.

Problemi noti

Layout di lettura

In Fiery Impose, Fiery Compose, Fiery JobMaster o Fiery Preview, layout di lettura è stato rimosso su macOS 11
e versioni successive.

ImageEnhance Visual Editor

Quando si ottimizza la finestra ImageEnhance Visual Editor su macOS 11, il monitor potrebbe lampeggiare per
alcuni secondi.

Conversione da PS a PDF

Quando si utilizza macOS 10.14.5 e versioni successive con Fiery Impose, Fiery Compose o Fiery JobMaster, è
possibile che venga richiesto di consentire a Fiery Command WorkStation di accedere ad Acrobat Distiller.
Questa autorizzazione è necessaria per la conversione dei file PS in PDF. Se non si concede l'autorizzazione, le
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conversioni non avranno esito positivo e sarà necessario modificare la funzionalità di sicurezza di automazione
in macOS.

1 Chiudere tutte le applicazioni Fiery.

2 Chiudere Acrobat Distiller.

3 Vai a Preferenze di sistema > Sicurezza e Privacy > Privacy > Automazione.

4 Fare clic sul lucchetto nell'angolo in basso a sinistra e immettere la propria password.

5 Nell'elenco App, individuare Fiery Command WorkStation.app.

6 Selezionare l'opzione Acrobat Distiller.app.
Ciò consente a Fiery Command WorkStation di accedere ad Acrobat Distiller.

Informazioni su macOS 10.15 (Catalina)

Anteprima Fiery, Fiery Impose, Fiery Compose o Fiery JobMaster su macOS 10.15

Kit applicazioni di supporto PDF

Il kit di applicazioni di supporto PDF (fornito da EFI), composto da Adobe Acrobat ed Enfocus PitStop, non è
compatibile con macOS 10.15 (Catalina). Se si usano Acrobat e/o PitStop, non eseguire l'aggiornamento a
macOS 10.15. Per le nuove installazioni, il programma di installazione delle applicazioni di supporto PDF non
viene eseguito.
L'aggiornamento a macOS 10.15, mentre si utilizza il kit di applicazioni di supporto PDF corrente, può causare i
seguenti problemi:

• Se Acrobat DC è già stato installato prima di eseguire l'aggiornamento a macOS 10.15, verrà eseguito
normalmente. Tuttavia, il programma di installazione di Acrobat DC non è compatibile con macOS 10.15,
quindi non sono possibili nuove installazioni di Acrobat DC. Inoltre, la versione di Enfocus PitStop inclusa
non è supportata da macOS 10.15.

• Se Acrobat XI è già stato installato prima di eseguire l'aggiornamento a macOS 10.15, non verrà eseguito e
non è supportato per macOS 10.15. Si consiglia di disinstallare Acrobat XI prima di eseguire l'aggiornamento
a macOS 10.15. Acrobat XI Uninstaller non viene eseguito su macOS 10.15, quindi, se si esegue
l'aggiornamento a macOS 10.15 con Acrobat XI ancora installato, il sistema si troverà in uno stato in cui
Acrobat XI non funziona e non può essere disinstallato.

Se non è installata una versione compatibile di Acrobat, si verificano i seguenti problemi:

• La funzione Modifica in Acrobat non è disponibile su Fiery Impose, Fiery Compose e Fiery JobMaster.

• L'apertura di un lavoro PostScript con Anteprima Fiery, Fiery Impose, Fiery Compose o Fiery JobMaster
potrebbe causare un errore.

• I modelli di Fiery Impose che utilizzano i flussi di lavoro Formato di finitura definito dall’utente o Basato su
riquadro di rifilatura potrebbero non funzionare correttamente con i lavori PostScript.

• Fiery Hot Folders non fornisce l'opzione per convertire i file PostScript in PDF.
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Altri problemi

Dopo aver eseguito l'aggiornamento a macOS 10.15 da una versione macOS precedente, il lancio di Anteprima
Fiery, Fiery Impose, Fiery Compose o Fiery JobMaster potrebbe causare la visualizzazione di uno dei seguenti
messaggi:

• "ICUConverter.framework" danneggia il computer. È necessario spostarlo nel Cestino.

• "ICUData.framework" danneggia il computer. È necessario spostarlo nel Cestino.

macOS 10.15 identifica erroneamente questi file come malware. Per risolvere questi problemi, reinstallare la
versione 6.4.0.358 o successiva di Fiery Command WorkStation Package, compatibile con macOS 10.15.
Quando si passa il mouse sopra i pulsanti per le icone di controllo in Anteprima Fiery, Fiery Impose, Fiery
Compose o Fiery JobMaster, i suggerimenti per gli strumenti non vengono visualizzati.

Accesso completo al disco

A causa delle modifiche apportate alla modalità in cui macOS 10.15 gestisce la sicurezza, sono necessari altri
passaggi per consentire il corretto funzionamento delle applicazioni Fiery.
È necessario apportare modifiche alla funzionalità di sicurezza dell'Accesso completo al disco in macOS per
consentire alle applicazioni Fiery di gestire gli aggiornamenti e accedere ai file come i modelli Impose e le
cartelle automatiche. Abilitare l'Accesso completo al disco per le applicazioni Fiery quali Fiery Command
WorkStation.

1 Chiudere tutte le applicazioni Fiery.

2 Vai a Preferenze di sistema > Sicurezza e Privacy > Privacy > Accesso completo al disco.

3 Fare clic sul lucchetto nell'angolo in basso a sinistra e immettere la propria password.

4 Fare clic sul pulsante +.

5 Aprire la cartella Applicazioni, selezionare Fiery Software Manager e Fiery Software Uninstaller e fare clic su
Apri.
Queste applicazioni richiedono l'accesso completo al disco per poter mantenere e aggiornare le applicazioni
Fiery sul computer.

6 Selezionare l'applicazione Fiery Command WorkStation nella cartella Applicazioni e fare clic su Apri.

7 Se si usa Fiery Hot Folders o Fiery Remote Scan, selezionare ogni applicazione e fare clic su Apri.
Quando Fiery Hot Folders rileva che vengono utilizzate le cartelle Documenti, Desktop e Download, invia un
messaggio con la richiesta di accesso completo al disco. Questo messaggio viene ancora visualizzato anche
dopo che è stato concesso l'accesso. È possibile ignorare questo messaggio e continuare a lavorare.

Errori del browser Safari su macOS 10.15

Se si utilizza Safari su macOS 10.15, si verificheranno errori ripetitivi del browser quando si provano ad aprire le
seguenti pagine web da Fiery Command WorkStation Centro periferica > Generale > Scheda:

• Ripristino sistema Fiery

• Immagine di Fiery System

• Risorse e impostazioni Fiery

Questi errori possono verificarsi anche quando si apre Fiery WebTools nel browser Safari.
Usare Chrome o Firefox per accedere a queste pagine Web.
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Fiery XF su macOS 10.15

Se si utilizza Fiery XF su macOS 10.15, è necessario eseguire l'aggiornamento Fiery Color Profiler Suite alla
versione 5.3.1. Con la versione 5.3.1 di Fiery Color Profiler Suite, è ora disponibile per gli utenti di Fiery XF Fiery
Verify compatibile con macOS 10.15 come applicazione di verifica predefinita.
Color Verifier non è compatibile con macOS 10.15, ma è supportato dalle versioni precedenti di macOS. Ma è
necessario installare Color Verifier separatamente. Scaricare Color Verifier per macOS 10.14 e versioni
precedenti dal Download Center.

Fiery Color Profiler Suite e Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) e versioni precedenti non sono totalmente compatibili con Fiery Command
WorkStation Package 6.5 (CWS) per stampanti a foglio singolo. Si consiglia di eseguire l'aggiornamento a Fiery
Color Profiler Suite 5.1.
Quando si usa Color Profiler Suite 5.0 con CWS 6.5, si potrebbero verificare i seguenti problemi:

• Se in CWS viene visualizzato il messaggio "Connetti lo spettrofotometro al computer" mentre Color Profiler
Suite è aperto, chiudere l'applicazione e fare clic su OK per continuare.

• Dopo aver creato una nuova impostazione di calibrazione in Calibrazione, il pulsante Crea nuovo profilo per
avviare Color Profiler Suite è nascosto. Tale problema viene risolto dopo l'aggiornamento a Color Profiler
Suite 5.1.

L'opzione modifica in Acrobat da Fiery Impose, Fiery Compose o Fiery JobMaster apre due finestre
di Acrobat

Su computer Windows, quando si seleziona l'opzione Modifica in Acrobat da Fiery Impose, Fiery Compose o
Fiery JobMaster, Acrobat potrebbe aprirsi in due finestre invece di una. Questo è un problema noto. È possibile
chiudere la finestra di Adobe Acrobat e continuare a lavorare nella finestra con il PDF.

Impostazioni delle preferenze in Adobe Acrobat Distiller per la conversione da PostScript a PDF

Fiery Impose, Fiery Compose e Fiery JobMaster richiedono ad Acrobat Distiller di convertire i file PostScript
(PS) in formato PDF su un computer client.
A causa delle impostazioni di sicurezza ottimizzate in Acrobat Distiller, è necessario confermare che il file PS da
convertire abbia un'origine attendibile in: Acrobat Distiller. > File > Preferenze > Preferenze - Acrobat Distiller,
selezionare Considera attendibili tutti i file aperti tramite Acrobat Distiller in Sicurezza.

Nota: Se l'opzione Considera attendibili tutti i file aperti tramite Acrobat Distiller non è selezionata, sarà necessari
confermare che il file abbia un'origine attendibile per ogni file PS da convertire in PDF. Ciò è valido anche per le
cartelle automatiche quando si seleziona il filtro Microsoft Office, il Tipo di file di output viene specificato come
PDF e viene selezionato un file joboptions come Profilo Distiller.

Impossibile avviare Configure dal computer macOS

Se Fiery server funziona con sistema FS100, non è possibile avviare Configure da queste versioni del sistema
operativo:

• mac10.14.6 e versioni successive di 10.14

• macOS 10.15 (tutte le versioni)
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Per connettersi a Fiery Command WorkStation, utilizzare un computer macOS con una versione precedente di
macOS o utilizzare un computer Windows.

Ritardo nell'avvio di Fiery Impose, Fiery Compose oFiery JobMaster

Fiery Impose, Fiery Compose e Fiery JobMaster potrebbero richiedere più tempo rispetto alle versioni
precedenti. Per ridurre il periodo di tempo necessario per aprire una di queste applicazioni, avviare prima Fiery
Preview e quindi l'applicazione che si desidera utilizzare.

Problemi risolti in Fiery Command WorkStation Package versione 6.5.0.599

Fiery Command WorkStation

• I risultati delle misurazioni con lo spettrofotometro ES-3000 non erano precisi.

Problemi risolti in Fiery Command WorkStation Package v6.5.0.581

Fiery Command WorkStation

• Quando si utilizza il formato di input TIFF in Fiery Hot Folders, le impostazioni di posizionamento
dell'immagine non venivano applicate correttamente per alcune lingue.

• Fiery Command WorkStation Package 6.5 supporta Windows 10 versione 20H2.

Fiery XF

• Quando si aggiunge un server Fiery XF con la preferenza Salva password attivata e si riavvia il server Fiery XF,
Fiery Command WorkStation Package non si avvia correttamente.

Problemi risolti in Fiery Command WorkStation Package v 6.5.0.563

Fiery Command WorkStation

• In un sistema in lingua giapponese, quando si accede con un account amministratore appena creato, Fiery Spot
Pro non si apre.

Fiery XF

• In Centro lavori Fiery Command WorkStation, la colonna Stato del lavoro indica che la verifica non è riuscita,
anche se il lavoro ha superato tutti i test in Fiery Verify.

• In Centro lavori Fiery Command WorkStation, se lo stato di un lavoro raggruppato è Da Verificare, Fiery Verify
non si avvia quando si fa clic su Verifica dal pannello Riepilogo lavori del lavoro primario. Fiery Verify si apre se si
fa clic su Ottimizza o Dettagli dal riquadro Riepilogo lavori di un lavoro secondario.
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Problemi risolti in Fiery Command WorkStation Package v6.5.0.539

Fiery Command WorkStation

• Dopo aver impostato un lavoro PPML con un modello 4 pagine e averlo elaborato, alcune pagine del lavoro non
venivano visualizzate in Fiery ImageViewer.

Fiery XF

• Non era possibile specificare un valore superiore a 59,4 cm per l'impostazione di larghezza personalizzata in
Command WorkStation Server Manager > Layout >Step & Repeat > Modello.

Problemi risolti in Fiery Command WorkStation Package versione 6.5.0.512

Fiery Command WorkStation

• In un sistema in lingua giapponese, quando si stampa un lavoro che è stato modificato con Fiery ImageViewer,
Fiery server smette di rispondere.

• La visualizzazione delle caselle di modifica di un lavoro nella vista layout in Fiery Impose è ora allineata con i
layout.

Fiery XF

• Se è stato modificato il nome del supporto o è stato associato un file di calibrazione (*.EPL) al profilo supporto
con un nome diverso in Color Tools > Profili Connect, le informazioni compatibili con la stampante sono state
rimosse dal file di calibrazione (*.EPL).

• Non è stato possibile salvare l'impostazione di Area colla in Job Editor > Sovrapposizione/colla.

• XF 7.2 supporta gli strumenti di misurazione X-Rite i1Pro3 ed EFI ES-3000 sui computer macOS.

Problemi risolti in Fiery Command WorkStation Package versione 6.5.0.475

Fiery Command WorkStation

• In Fiery Spot Pro, è ora possibile specificare i valori di separazione per le tinte piatte e i colori sostitutivi con una
cifra decimale.

• In Fiery Spot Pro, l'opzione Ripristina i valori di fabbrica è ora disabilitata per le tinte piatte in un gruppo
duplicato.

• È possibile reinstallare e attivare Adobe Acrobat Pro 2017 ed Enfocus PitStop Edit 2019 da Fiery Software
Manager.

Fiery XF

• Nelle stampanti VUTEk per formati superwide roll-to-roll, l'impostazione modalità di stampa in Impostazioni
speciali > Stampa con inchiostro bianco ripristinava Tinta piatta WHITE_INK.

• Con la lingua di sistema del Fiery server impostata su polacco, l'applicazione Cut Server non riconosceva il
raggruppamento di lavori.
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Problemi risolti in Fiery Command WorkStation Package versione 6.5.0.433

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 supporta Windows 10 versione 2004.

• Durante la stampa di un lavoro in formato booklet con un modello Fiery Impose salvato come preimpostazione,
talvolta l'impostazione per il supporto della copertina non è stata applicata.

• Occasionalmente non è stato possibile avviare Fiery Impose, Fiery Compose o Fiery JobMaster perché veniva
visualizzato un messaggio di errore non corretto che indicava che l'applicazione era già aperta. Questo problema
è stato risolto.

• Dopo aver attivato più licenze, non è stato possibile ripristinare i codici di attivazione della licenza durante il
ripristino di un Fiery server tramite Ripristino sistema Fiery. Questo problema è stato risolto.

Fiery XF

• Un nome utente di sistema che contiene spazi o caratteri speciali ha causato la mancata visualizzazione delle
anteprime dei lavori da parte di Job Editor.

• Su un sistema in lingua italiana, dopo l'aggiornamento alla versione più recente di Fiery Command WorkStation
6.5, Job Editor ha smesso di rispondere.

Problemi risolti in Fiery Command WorkStation Package versione 6.5.0.367

Fiery Command WorkStation

• In alcune lingue, il testo posizionato sui separatori utilizzando Fiery Compose o Fiery JobMaster appariva
correttamente quando visualizzato sul computer, ma non era visualizzato quando i separatori venivano stampati.

• Quando i moduli PDF con i dati immessi nei campi venivano salvati da Fiery Compose o Fiery JobMaster, i
campi non venivano visualizzati in Anteprima o sulla stampa.

• Non era possibile ricalibrare un set di calibrazione con formato carta personalizzato 241x330 mm, se il formato
carta veniva modificato da 241x330 mm a 13x19 pollici.

• Non era possibile misurare una pagina di calibrazione se si collegava uno spettrofotometro a un computer dopo
aver stampato la pagina di calibrazione.

Fiery XF

• Su alcune piattaforme Windows, Job Editor non era in grado di visualizzare l'anteprima dei lavori.

Problemi risolti in Fiery Command WorkStation Package versione 6.5.0.292

Fiery Command WorkStation

• Il font Arial veniva visualizzato in corsivo su alcuni computer Windows dopo aver installato Fiery Command
WorkStation Package versione 6.5.

• Le impostazioni predefinite impostate con la funzionalità Imposta valori predefiniti non sono state applicate alla
coda di stampa sequenziale.

Note di release per l’utente

Fiery Command WorkStation Package, v6.5

34



• In Fiery JobMaster, se le pagine vengono inserite o eliminate da un lavoro PDF con segnalibri durante
l'inserimento di separatori o fogli vuoti, i segnalibri si spostano in pagine diverse.

• Occasionalmente, i computer macOS con un sistema operativo non in lingua inglese hanno generato dati di
misurazione corrotti IT8.

Fiery XF

• In Color Tools > Crea calibrazione > Bilanciamento del grigio, i valori delta E cambiano ogni volta che si apre un
file EPL salvato

• Con la lingua di sistema del Fiery server impostata su polacco, l'applicazione Cut Server non riconosceva il
raggruppamento di lavori.

• Una volta ricalibrato il server di Fiery XF, il flusso di lavoro predefinito impostato nella finestra Server Manager
non veniva applicato.

Problemi risolti in Fiery Command WorkStation Package v6.5.0.171 SP1

• Quando si utilizzava l'azione Assegna supporto in Fiery Impose, veniva visualizzato un messaggio di avviso
relativo a un profilo sRGB non corretto.

Problemi risolti in Fiery Command WorkStation Package v 6.5.0.171

Fiery XF

• Impossibile creare la linea di base per EPSON SC-P75x0/SC-P95x0 RGB

• Impossibile selezionare stampa etichetta per EPSON SC-P75x0 e SC-P95x0

• Impossibile calibrare EPSON 9500 con supporti da ≈111 cm
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Release-Informationen
Fiery Command WorkStation Package, v6.5

Dieses Dokument enthält wichtige Informationen zu diesem Release. Stellen Sie diese Informationen allen Benutzern
zur Verfügung, bevor Sie die Installation vornehmen.

Informationen zum Release

Diese Release-Version umfasst die folgenden Anwendungen:

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Fiery Hot Folders für Mac 4.1.0.21

• Fiery Hot Folders für Windows 4.1.0.21

• Fiery Software Manager v4.4.0.18

Aktualisieren

Dieses Installationsprogramm aktualisiert jedes vorhandene Fiery Command WorkStation Package auf die aktuelle
Version, die Fiery Command WorkStation und Fiery Hot Folders beinhaltet. Mithilfe von Fiery Software Manager
können Sie optional Fiery Remote Scan installieren.
Fiery Command WorkStation Package unterstützt Fiery servers bei der Ausführung von FS100 und höher sowie
Fiery proServer und Fiery XF 7.0 und höher. Es stellt keine Verbindung zu folgenden Systemen her:

• Fiery servers, das Fiery System 9/9e Rel2 sowie System 10-Software und frühere Versionen ausführt

• Fiery XF 6.x Server und frühere Versionen

• Fiery Central Server

Wenn Sie weiterhin auf diese Produkte zugreifen müssen, dürfen Sie das Upgrade nicht vornehmen. Fiery Extended
Applications Das Paket ist weiterhin auf www.efi.com/cws verfügbar. Eine vollständige Liste der unterstützten
digitalen Bogendruckmaschinen finden Sie unter http://fiery.efi.com/CWS/supported-printers.
Weitere Informationen zu den technischen Spezifikationen finden Sie unter www.efi.com/cws.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


Neue Funktionen

Neuerungen

Weitere Informationen zu den neuen Funktionen, die nach dem ersten Release der Version 6.5 hinzugefügt
wurden, finden Sie unter http://fiery.efi.com/CWS/Whats-New.
Weitere Informationen zu den neuen Funktionen, die nach dem ersten Release der Version 6.5 hinzugefügt
wurden, finden Sie weiter unten.

Fiery Spot Pro

Mit der Fiery Command WorkStation 6.5 haben Sie die Möglichkeit, Spot-Farben mit Fiery Spot Pro zu
verwalten. Fiery Spot Pro ersetzt Fiery Spot-On. Eine vollständige Liste der Verbesserungen finden Sie unter 
https://www.efi.com/spotpro.
Fiery Spot Pro ist für ausgewählte Server mit den folgenden Anforderungen verfügbar:

• FS200 Pro und neuere Software

• Fiery Graphic Arts Package, Premium Edition

Weitere Informationen unter http://fiery.efi.com/spotpro/supported-printers.
Wenn Fiery Spot Pro auf Ihrem Fiery server nicht aktiviert ist, wird Fiery Spot-On weiterhin von der Fiery
Command WorkStation unterstützt.

Überlegungen zur Verwendung von Fiery Spot Pro

• Verwenden Sie das „@“-Symbol nicht in Namen von Spot-Farben.

• Warten Sie nach dem Start von Spot Pro ca. 60-120 Sekunden, bevor Sie die Suchfunktion verwenden oder
Ausgabeprofile wechseln.

• Die Optimierung von Spot-Farben nach mehreren Iterationen kann zu deutlicheren Unterschieden
zwischen der ursprünglichen Spot-Farbe und einer konvertierten Spot-Farbe führen.

• Es gibt eine leichte numerische Rundung bei konvertierten L*a*b*-Werten und geräteabhängigen CMYK-
Werten.

• Zwei Instanzen von Spot Pro auf verschiedenen Anwendersystemen, die mit demselben Fiery server
verbunden sind, können zu Fehlern führen, wenn beide Anwender Bearbeitungsvorgänge durchführen.

Unterstützung für EFI ES-3000

Das neue Messgerät EFI ES-3000 wird durch eine EFI ES-2000-Emulation in Fiery Command WorkStation 6.5
unterstützt. Das EFI ES-3000 ist ein Upgrade für das EFI ES-2000 und unterstützt Einzelscanmessungen in den
Messmodi M1 und M2. Sie können das Gerät EFI ES-3000 (durch Auswählen der Zuführung „EFI ES-2000“ in
der Benutzeroberfläche) mit Fiery Calibrator, Fiery Spot Pro sowie den Papiersimulationsfunktionen von Fiery
Command WorkStation verwenden.

Hinweis:  Die ES-2000-Emulation (Zuführung „EFI ES-2000“ in der Benutzeroberfläche) kann auch in
Verbindung mit einem EFI ES-2000 verwendet werden.
Informationen zur Verwendung des EFI ES-3000 mit verschiedenen Anwendungen finden Sie in der
Dokumentation, die diesen Anwendungen beiliegt.
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Benachrichtigungen über die Package-Lizenz für Fiery Optionen

Benachrichtigungen über verfügbare Server-Updates werden jetzt im Abschnitt „neue Benachrichtigungen“ in
der Fiery Command WorkStation aufgelistet. Benachrichtigungen werden angezeigt, wenn die Lizenzen für die
installierten Fiery Optionen bald ablaufen oder bereits abgelaufen sind. Benachrichtigungen werden in Fiery
Command WorkStation, Fiery Hot Folders und Fiery WebTools angezeigt.

Hinweis:  Sie können jederzeit Informationen zum Ablauf von Lizenzen anzeigen, und zwar unter WebTools >
Startseite und Fiery Command WorkStation > Gerätecenter > Allgemein > Allgemeine Info.
Die Benachrichtigungen über den Ablauf von Lizenzen bieten Ihnen folgende Optionen:

• Jetzt erneuern

• Verwerfen

• Weitere Informationen

Support für Fiery JobExpert Bericht

Wenn Fiery Command WorkStation 6.5 an FS400 Server angeschlossen ist, können die mithilfe von Fiery
JobExpert am Auftrag vorgenommenen Verbesserungen in der Vorschau angezeigt werden.
Der Fiery JobExpert Bericht bietet einen Überblick über die vorgeschlagenen Einstellungen für
Auftragseigenschaften, die mithilfe von Fiery JobExpert auf die Aufträge angewendet werden.

Support für Adobe Acrobat Pro 2017 und Enfocus PitStop Edit 2019

Die Optionen Adobe Acrobat Pro 2017 und Enfocus PitStop Edit 2019 stehen zum Download von Fiery Software
Manager zur Verfügung.

Support für Messinstrumente in Fiery XF Color Editor

Für einzelne Farbfelder und Optimierungen werden folgende Messinstrumente unterstützt:

Messinstrument Einzelnes Farbfeld Optimierung

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

Support für variablen Endpunkt für helle Tinte

Fiery XF ermöglicht es Ihnen, einen Endpunkt für helle Tinte einzurichten, um helle Tinte auf
Kalibrierungsdateien einzusparen.
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Um eine tintensparende Kalibrierungsdatei zu erstellen, reduzieren Sie die Menge an heller Tinte, indem Sie den
Endpunktwert für helle Tinte auf der Registerseite Tintenlimit und Kalibrierung des Color Toolsändern.

Unterstützung für Farbfeldlayout 1617 (CGATS IT8.7/5)

Fiery XF unterstützt ein Profilerstellungsdiagramm in Color Tools mit 1617 Farbfeldern.
Beim Ziel 1617 handelt es sich um ein CMYK-Charakterisierungsziel des Druckers, das die einzigartigen
Farbfeldwerte im Standardziel IT8.7/4 mit allen Farbfeldwerten in den Spalten 4 und 5 des Ziels P2P51
kombiniert.

Unterstützung für das Erstellen eigener Vorgaben für Verifier über Server Manager

Sie können eigene Vorgaben in XF-Verifier über Server Manager erstellen.

Unterstützung für die Beibehaltung des Speicherorts einer Sicherungsdatei eines überwachten
Ordners

Wenn Sie überwachte Ordner aus einer Sicherungsdatei wiederherstellen, können Sie nun den ursprünglichen
Speicherort der Sicherungsdatei beibehalten.

EFI IQ Webanwendungen

Sie können EFI IQ Webanwendungen über den Startbildschirm von Command WorkStation registrieren. EFI IQ
Webanwendungen verschaffen Ihnen mit leistungsstarken Analysefunktionen einen besseren Überblick über
Ihre Druckproduktion.

Updates zu Systemvoraussetzungen

Unterstützte Versionen

Fiery Command WorkStation unterstützt folgende Betriebssysteme auf Ihrem Computer:

• macOS 11 (nur mit Intel-Prozessoren)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10, 64 Bit

• Windows Server 2019, 64 Bit

• Windows Server 2016, 64 Bit

• Windows 8.1, 64 Bit

• Windows 7, 64 Bit

• Windows Server 2012 R2, 64 Bit

• Windows Server 2008 R2, 64 Bit
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Eingestellte Unterstützung

• macOS 10.11

• macOS 10.12

• System 10 und frühere Versionen

Wenn Sie Fiery Command WorkStation auf Version 6.5 aktualisieren, werden alle zuvor hinzugefügten
System10-Server aus der Serverliste entfernt. Wenn Sie versuchen, sich bei einem Fiery server, der mit System
10 oder einer früheren Version arbeitet, anzumelden, können Sie nicht diesen Server verwenden, da nur eine
Fiery server mit FS100 und höher unterstützt wird.

64-Bit-Anwendung

Fiery Command WorkStation 6.5 (CWS) ist eine native 64-Bit-Anwendung für Mac OS- und Windows-
Plattformen.
32-Bit-Betriebssysteme werden für CWS 6.5 nicht unterstützt. Wenn Fiery Software Manager bereits auf einem
32-Bit-Betriebssystem wie Windows 7, 32-Bit-Version, ausgeführt wird, werden die Update-Benachrichtigungen
für das Paket CWS 6.5 nicht angezeigt. Wenn Sie versuchen, diese Version von Fiery Software Manager auf
einem 32-Bit-Betriebssystem zu installieren, wird ein Kompatibilitätsfehler angezeigt und Fiery Software
Manager kann nicht ausgeführt werden. Informationen zu den unterstützten Betriebssystemen finden Sie unter 
http://fiery.efi.com/cws-specifications.

Unterstützung für Adobe Acrobat DC-Abonnement für die Verwendung mit Fiery Impose, Fiery
Compose oder Fiery JobMaster

Fiery Command WorkStation Package v6.5.0.292 unterstützt die Nutzung von individuellen und persönlichen
Abonnements von Acrobat DC, die auf einem Client-Computer installiert sind, für die Verwendung mit Fiery
Impose, Fiery Compose oder Fiery JobMaster.

Hinweis:  Um Acrobat in Fiery Impose, Fiery Compose oder Fiery JobMaster zu verwenden, müssen Sie nur eine
Instanz von Acrobat DC auf dem Client-Computer installieren. Stellen Sie außerdem sicher, dass andere
Acrobat-Versionen nicht auf demselben Client-Computer installiert sind.

Bekannte Problemsituationen

Leseansicht

In Fiery Impose, Fiery Compose, Fiery JobMaster oder Fiery Preview wurde die Leseansicht unter macOS 11 und
höher entfernt.

ImageEnhance Visual Editor

Wenn Sie das Fenster „ImageEnhance Visual Editor“ unter macOS 11 maximieren, kann der Bildschirm für
einige Sekunden flimmern.
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Konvertierung von PS in PDF

Wenn Sie macOS 10.14.5 und später mit Fiery Impose, Fiery Compose oder Fiery JobMaster verwenden, werden
Sie möglicherweise aufgefordert, den Zugriff des Fiery Command WorkStation auf Acrobat Distiller zu
ermöglichen. Dieses Zugriffsrecht ist für die Konvertierung von PS-Dateien in PDF erforderlich. Wenn Sie keine
Berechtigung erteilen, werden die Konvertierungen nicht ausgeführt und Sie müssen die Funktion für die
Automatisierungssicherheit in macOS ändern.

1 Schließen Sie alle Fiery Anwendungen.

2 Schließen Sie Acrobat Distiller.

3 Gehe zu Systemeinstellungen > Sicherheit und Datenschutz > Datenschutz > Automatisierung.

4 Klicken Sie in der unteren linken Ecke auf das Schloss-Symbol und geben Sie Ihr Kennwort ein.

5 Suchen Sie in der Liste „AppsFiery Command WorkStation.app.

6 Wählen Sie die Option Acrobat Distiller.app aus.
Dadurch kann Fiery Command WorkStation auf Acrobat Distiller zugreifen.

macOS 10.15 (Catalina)-Informationen

Fiery Preview, Fiery Impose, Fiery Compose oder Fiery JobMaster unter macOS 10.15

PDF-Supportanwendungs-Kit

Das PDF-Supportanwendungs-Kit (bereitgestellt von EFI) besteht aus Adobe Acrobat und Enfocus PitStop und
ist nicht mit macOS 10.15 (Catalina) kompatibel. Wenn Sie Acrobat und/oder PitStop verwenden, sollten Sie
das Upgrade auf macOS 10.15 unterlassen. Bei neuen Installationen wird das Installationsprogramm für die PDF
Support Applications nicht ausgeführt.
Das Upgrade auf macOS 10.15 bei Verwendung des aktuellen PDF-Supportanwendungs-Kits kann zu folgenden
Problemen führen:

• Wenn Sie Acrobat DC bereits installiert haben, bevor Sie auf macOS 10.15 aktualisieren, wird es normal
ausgeführt. Das Installationsprogramm von Acrobat DC ist jedoch nicht mit macOS 10.15 kompatibel,
sodass neue Installationen von Acrobat DC nicht möglich sind. Darüber hinaus wird das mitgelieferte
Enfocus PitStop unter macOS 10.15 nicht unterstützt.

• Wenn Sie Acrobat XI bereits installiert haben, bevor Sie auf macOS 10.15 aktualisieren, wird es nicht
ausgeführt und wird unter macOS 10.15 nicht unterstützt. Es wird empfohlen, Acrobat XI vor dem Upgrade
auf macOS 10.15 zu deinstallieren. Das Deinstallationsprogramm von Acrobat XI wird unter macOS 10.15
nicht ausgeführt. Wenn Sie also die Aktualisierung auf macOS 10.15 durchführen, während Acrobat XI noch
installiert ist, befindet sich Ihr System in einem Zustand, in dem Acrobat XI nicht funktioniert und nicht
deinstalliert werden kann.

Wenn eine kompatible Version von Acrobat nicht installiert ist, gelten die folgenden Probleme:

• Die Funktion In Acrobat bearbeiten ist in Fiery Impose, Fiery Compose und Fiery JobMaster nicht verfügbar.

• Das Öffnen eines PostScript-Auftrags mit Fiery Preview, Fiery Impose, Fiery Compose oder Fiery JobMaster
kann zu einem Fehler führen.

• Fiery Impose Schablonen, die die Workflows Eigene Endgröße oder Auf Basis des Endformatrahmens
verwenden, funktionieren mit PostScript-Aufträgen möglicherweise nicht ordnungsgemäß.

• Die Option PostScript Dateien in PDF-Dateien umzuwandeln wird von Fiery Hot Folders nicht angeboten.
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Andere Probleme

Nach dem Upgrade von einer älteren macOS-Version auf macOS 10.15 kann das Starten von Fiery Preview,
Fiery Impose, Fiery Compose oder Fiery JobMaster dazu führen, dass eine der folgenden Meldungen angezeigt
wird:

• „ICUConverter.framework“ wird Ihren Computer beschädigen. Verschieben Sie die Datei in den Papierkorb.

• „ICUData.framework“ wird Ihren Computer beschädigen. Verschieben Sie die Datei in den Papierkorb.

macOS 10.15 identifiziert diese Dateien fälschlicherweise als Malware. Um diese Probleme zu beheben,
installieren Sie Fiery Command WorkStation Package Version 6.4.0.396 oder höher neu. Diese Versionen sind
mit macOS 10.15 kompatibel.
Wenn Sie mit der Maus über die Schaltflächen der Steuersymbole in Fiery Preview, Fiery Impose, Fiery
Compose oder Fiery JobMaster bewegen, wird die QuickInfo nicht angezeigt.

Festplattenvollzugriff

Aufgrund von Änderungen in der Art und Weise, wie macOS 10.15 die Sicherheit verwaltet, sind jetzt
zusätzliche Schritte erforderlich, um die ordnungsgemäße Funktion von Fiery Anwendungen zu gewährleisten.
Sie müssen Änderungen an der Sicherheitsfunktion Festplattenvollzugriff in macOS vornehmen, damit Fiery
Anwendungen Updates verwalten und auf Dateien wie Impose Schablonen und Hot Folders zugreifen können.
Aktivieren Sie den Festplattenvollzugriff für Fiery Anwendungen wie Fiery Command WorkStation.

1 Schließen Sie alle Fiery Anwendungen.

2 Navigieren Sie zu Systemeinstellungen > Sicherheit und Datenschutz > Datenschutz > Festplattenvollzugriff.

3 Klicken Sie in der unteren linken Ecke auf das Schloss-Symbol und geben Sie Ihr Kennwort ein.

4 Klicken Sie auf die Schaltfläche +.

5 Wählen Sie im Ordner Anwendungen Fiery Software Manager und Fiery Software Uninstaller und klicken
Sie auf Öffnen.
Diese Anwendungen benötigen Festplattenvollzugriff, um Fiery Anwendungen auf Ihrem Computer zu
verwalten und zu aktualisieren.

6 Wählen Sie im Ordner Anwendungen die Anwendung Fiery Command WorkStation und klicken Sie auf
Öffnen.

7 Wenn Sie Fiery Hot Folders oder Fiery Remote Scan verwenden, wählen Sie jede Anwendung aus und
klicken Sie auf Öffnen.
Wenn Fiery Hot Folders erkennt, dass die Ordner „Dokumente“, „Desktop“ und „Downloads“ verwendet
werden, wird eine Meldung ausgegeben, in der der Festplattenvollzugriff angefordert wird. Diese Meldung
wird weiterhin angezeigt, auch nachdem der Zugriff erteilt wurde. Sie können diese Meldung schließen und
weiterarbeiten.

Fehler mit Safari-Browser unter macOS 10.15

Wenn Sie Safari unter macOS 10.15 verwenden, treten beim Versuch folgende Webseiten über Fiery Command
WorkStation zu öffnen, sich wiederholende Browser-Fehler auf. Gerätecenter > Allgemein > Werkzeuge:

• Fiery Systemwiederherstellung

• Fiery Systemabbild

• Fiery Ressourcen und Einstellungen
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Diese Fehler können auch auftreten, wenn Sie Fiery WebTools im Safari-Browser öffnen.
Verwenden Sie Chrome oder Firefox, um auf diese Webseiten zuzugreifen.

Fiery XF unter macOS 10.15

Wenn Sie Fiery XF unter macOS 10.15 verwenden, müssen Sie Fiery Color Profiler Suite auf Version 5.3.1
aktualisieren. Mit der Fiery Color Profiler Suite Version 5.3.1 ist das mit macOS 10.15 kompatible Fiery Verify
jetzt für Fiery XF Anwender als Standard-Prüfungsanwendung verfügbar.
Color Verifier ist nicht mit macOS 10.15 kompatibel, wird aber immer noch von den älteren macOS-Versionen
unterstützt. Aber Sie müssen Color Verifier separat installieren. Laden Sie Color Verifier für macOS 10.14 und
frühere Versionen aus dem Download Center herunter.

Fiery Color Profiler Suite und Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) und frühere Versionen sind nicht vollständig mit dem Fiery Command
WorkStation Package 6.5 (CWS) für digitale Bogendruckmaschinen kompatibel. Wir empfehlen die
Aktualisierung auf Fiery Color Profiler Suite 5.1.
Bei der Verwendung von CPS 5.0 mit CWS 6.5, können die folgenden Probleme auftreten:

• Wenn in CWS die Meldung „Spektralfotometer mit Ihrem Computer verbinden“ angezeigt wird, während
CPS geöffnet ist, schließen Sie CPS und klicken Sie zum Fortfahren auf OK.

• Nachdem Sie in Calibrator eine neue Kalibrierungseinstellung erstellt haben, wird die Schaltfläche Neues
Profil erstellen für den Start von CPS ausgeblendet. Dieses Problem wird nach dem Upgrade auf CPS 5.1
behoben.

Mit der Option „In Acrobat bearbeiten“ aus Fiery Impose, Fiery Compose oder Fiery JobMaster
werden zwei Acrobat-Fenster geöffnet.

Wenn die Option In Acrobat bearbeiten in Fiery Impose, Fiery Compose oder Fiery JobMaster ausgewählt
wurde, wird Acrobat auf Windows-Computern möglicherweise in zwei Fenstern anstatt in einem Fenster
geöffnet. Dies ist ein bekanntes Problem. Sie können das Fenster „Adobe Acrobat“ schließen und weiterhin mit
der PDF-Datei im Fenster arbeiten.

Festlegen von Voreinstellungen in Adobe Acrobat Distiller für das Konvertieren von PostScript in
PDF

Für Fiery Impose, Fiery Compose und Fiery JobMaster ist Acrobat Distiller erforderlich, um auf einem Client-
Computer PostScript (PS)-Dateien in PDF zu konvertieren.
Aufgrund der verbesserten Sicherheitseinstellungen in Acrobat Distiller müssen Sie bestätigen, dass die zu
konvertierende PS-Datei aus einer vertrauenswürdigen Quelle stammt, und zwar unter: Acrobat Distiller >
Datei > Voreinstellungen > Voreinstellungen: Acrobat Distiller, wählen Sie Allen mittels Acrobat Distiller
geöffneten Dateien vertrauen unter Sicherheit.

Hinweis:  Wenn Allen mittels Acrobat Distiller geöffneten Dateien vertrauen nicht ausgewählt wurde, werden
Sie aufgefordert, für jede in PDF zu konvertierende PS-Datei zu bestätigen, dass sie aus einer
vertrauenswürdigen Quelle stammt. Dies gilt auch für Hot Folders, wenn der Filter Microsoft Office ausgewählt,
PDF als Ausgabedateityp angegeben und eine Joboptions-Datei als Distiller-Profil ausgewählt wurde.

Release-Informationen

Fiery Command WorkStation Package, v6.5

43



Kann nicht „Configure“ von einem macOS-Computer starten

Wenn Ihr Fiery server System FS100 ausführt, können Sie „Configure“ nicht über diese Betriebssystemversionen
starten:

• mac10.14.6 und neuere Versionen von 10.14

• macOS 10.15 (alle Versionen)

Sie können eine Verbindung mit Fiery Command WorkStation über einen macOS-Computer mit einer früheren
Version von macOS oder über einen Windows-Computer herstellen.

Verzögerung beim Starten von Fiery Impose, Fiery Compose oder Fiery JobMaster

Das Starten von Fiery Impose, Fiery Compose und Fiery JobMaster dauert möglicherweise länger als in früheren
Versionen. Um den Zeitraum des Öffnens dieser Anwendungen zu verkürzen, starten Sie zuerst Fiery Preview
und dann die Anwendung, die Sie verwenden möchten.

Behobene Probleme in Fiery Command WorkStation Package v6.5.0.599

Fiery Command WorkStation

• Die Messergebnisse mit dem Spektralphotometer ES-3000 waren nicht genau.

In Fiery Command WorkStation Package v6.5.0.581 behobene Probleme

Fiery Command WorkStation

• Wenn Sie das Eingabeformat TIFF in Fiery Hot Folders verwendeten, wurden die Einstellungen für die
Bildpositionierung für einige Sprachen nicht richtig angewendet.

• Fiery Command WorkStation Package 6.5 unterstützt Windows 10, Version 20H2.

Fiery XF

• Wenn Sie bei aktivierter Voreinstellung Kennwort speichern einen Fiery XF Server hinzufügen und den Fiery XF
Server neu starten, wird Fiery Command WorkStation Package nicht erfolgreich gestartet.

Behobene Probleme in Fiery Command WorkStation Package v6.5.0.563

Fiery Command WorkStation

• Wenn Sie sich in einem System in japanischer Sprache mit dem neu erstellten Administratorkonto anmelden,
wird Fiery Spot Pro nicht geöffnet.

Fiery XF

• Im Auftragscenter der Fiery Command WorkStation gibt die Spalte Auftragsstatus an, dass die Prüfung nicht
erfolgreich war, selbst wenn der Auftrag alle Tests in Fiery Verify bestanden hat.

• Im Auftragscenter der Fiery Command WorkStation wurde Fiery Verify für einen Sammelformauftrag mit dem
Status Prüfbereit nicht gestartet, wenn Sie im Bereich Auftragszusammenfassung des übergeordneten Auftrags
auf Prüfen geklickt haben. Fiery Verify wird geöffnet, wenn Sie auf Optimieren oder Details aus dem Bereich
Auftragszusammenfassung des untergeordneten Auftrags klicken.
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Behobene Probleme in Fiery Command WorkStation Package 6.5.0.539

Fiery Command WorkStation

• Nachdem Sie einen PPML-Auftrag mit einer 4up-Vorlage ausgeschossen und verarbeitet hatten, wurden einige
Seiten des Auftrags nicht in Fiery ImageViewer angezeigt.

Fiery XF

• Für die Einstellung „Eigene Breite“ konnte in Command WorkStation Server Manager > Layout > Mehrfach
duplizieren > Muster kein Wert von mehr als 59,4 cm angegeben werden.

Behobene Probleme in Fiery Command WorkStation Package v6.5.0.512

Fiery Command WorkStation

• Wenn Sie auf einem japanischen System einen Auftrag druckten, der mit Fiery ImageViewer verarbeitet wurde,
reagierte der Fiery server nicht mehr.

• Die Anzeige von Eingabefeldern eines Auftrags in der Strukturansicht in Fiery Impose ist nun an den
Drahtgittern ausgerichtet.

Fiery XF

• Wenn Sie in Color Tools > Profile verbinden den Namen des Mediums änderten oder eine Kalibrierungsdatei
(*.epl) mit einem Medienprofil mit einem anderen Namen verknüpften, wurden die Informationen zum
kompatiblen Drucker aus der Kalibrierungsdatei (*.epl) entfernt.

• Die Einstellung Klebebereich konnte in Job Editor > Überlappen/Kleben nicht gespeichert werden.

• XF 7.2 unterstützt die Messinstrumente X-Rite i1Pro3 und EFI ES-3000 auf Computern unter macOS.

Behobene Probleme in Fiery Command WorkStation Package v6.5.0.475

Fiery Command WorkStation

• In Fiery Spot Pro können Sie nun die Separationswerte für Sonderfarben und Ersatzfarben auf eine Dezimalstelle
festlegen.

• In Fiery Spot Pro ist die Option Auf Werkseinstellungen zurücksetzen nun für Sonderfarben in einer duplizierten
Gruppe deaktiviert.

• Sie können Adobe Acrobat Pro 2017 und Enfocus PitStop Edit 2019 über den Fiery Software Manager neu
installieren und aktivieren.

Fiery XF

• Mit VUTEk Rolle-zu-Rolle-Drucker im Supergroßformat wurde die Druckmoduseinstellung in speziellen
Einstellungen > Druck mit weißer Tinte immer zurück auf Spot-Farbe WHITE_INK geändert.

• Mit der Systemsprache des Fiery server, die auf Polnisch eingestellt ist, erkannte die Cut Server-Anwendung
keine Sammelformaufträge.
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In Fiery Command WorkStation Package v6.5.0.433 behobene Probleme

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 unterstützt Windows 10 Version 2004.

• Wenn Sie einen Broschürenauftrag mit einer Fiery Impose Schablone gedruckt haben, die als Vorgabe
gespeichert ist, wurde die Medieneinstellung für das Deckblatt teilweise nicht angewendet.

• Gelegentlich konnte Fiery Impose, Fiery Compose oder Fiery JobMaster nicht starten, weil gemäß einer falschen
Fehlermeldung die Anwendung bereits geöffnet war. Dieses Problem wurde behoben.

• Wenn Sie mehrere aktivierte Lizenzen hatten, konnten Sie die Lizenzaktivierungscodes (LACs) nicht
wiederherstellen, während Sie einen Fiery server mithilfe der Fiery Systemwiederherstellung wiederherstellten.
Dieses Problem wurde behoben.

Fiery XF

• Ein Systemanwendername, der Leerzeichen oder Sonderzeichen enthielt, führte dazu, dass Job Editor keine
Auftragsvorschau anzeigte.

• Nachdem Sie Fiery Command WorkStation 6.5 in einem italienischsprachigen System auf die neueste Version
aktualisiert hatten, reagierte Job Editor nicht mehr.

Behobene Probleme in Fiery Command WorkStation Package V6.5.0.367

Fiery Command WorkStation

• In einigen Sprachen wurde mithilfe von Fiery Compose oder Fiery JobMaster auf Registerseiten platzierter Text
zwar auf dem Computer korrekt dargestellt, jedoch wurde der Text nicht wiedergegeben, wenn die
Registerseiten ausgedruckt wurden.

• Wenn PDF-Formulare mit Dateneingaben in den Formularfeldern in Fiery Compose oder Fiery JobMaster
gespeichert wurden, wurden die Formularfelder in der Vorschau oder in der Druckausgabe nicht angezeigt.

• Die Neukalibrierung eines Kalibrierungssets mit eigener Papiergröße von 241 x 330 mm war nicht möglich,
wenn die Papiergröße von 241 x 330 mm in 13 x 19 Zoll geändert wurde.

• Die Messung einer Kalibrierungsseite war nicht möglich, wenn ein Spektralfotometer nach dem Drucken der
Kalibrierungsseite an einen Computer angeschlossen wurde.

Fiery XF

• Auf einigen Windows-Plattformen konnte Job Editor die Vorschau von Aufträgen nicht anzeigen.

Probleme in Fiery Command WorkStation Package v6.5.0.292 behoben

Fiery Command WorkStation

• Die Schriftart Arial wurde auf einigen Windows-Computern nach der Installation von Fiery Command
WorkStation Package 6.5 als kursiv angezeigt.

• Die Standardeinstellungen, die Sie mit der Funktion „Als Standard festlegen“ definiert haben, wurden nicht für
die Warteschlange „Sequenzielles Drucken“ übernommen.
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• Haben Sie in Fiery JobMaster Seiten in einen PDF-Auftrag mit Lesezeichen eingefügt oder aus diesem gelöscht,
während Sie Registerseiten und Leerbogen eingefügt haben, wurden die Lesezeichen auf verschiedene Seiten
verschoben.

• Gelegentlich haben macOS-Computer mit einem nicht-englischsprachigen Betriebssystem beschädigte IT8-
Messdaten generiert.

Fiery XF

• In Color Tools > Kalibrierung erstellen > Graubalanceänderten sich die delta E-Werte jedes Mal, wenn eine
gespeicherte EPL-Datei geöffnet wurde.

• Mit der Systemsprache des Fiery server, die auf Polnisch eingestellt ist, erkannte die Cut Server-Anwendung
keine Sammelformaufträge.

• Wenn Sie den Fiery XF Server erneut kalibriert haben, wurde der Standard-Workflow, den Sie im Fenster Server
Manager eingestellt haben, nicht angewendet.

Problem in Fiery Command WorkStation Package Version 6.5.0.171 SP1 behoben

• Wenn Sie die Aktion Substrat zuweisen in Fiery Imposeverwendet haben, wurde vor einem falschen sRGB-Profil
gewarnt.

Probleme in Fiery Command WorkStation Package v6.5.0.171 behoben

Fiery XF

• Base Line für EPSON SC-P75x0/SC-P95x0 RGB kann nicht erstellt werden

• Etikettendruck kann nicht für EPSON SC-P75x0 und SC-P95x0 ausgewählt werden

• EPSON 9500 kann nicht für 44-Inch-Substrate kalibriert werden
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Notas de la versión para el cliente
Fiery Command WorkStation Package, v6.5

Este documento contiene información importante acerca de esta versión. Asegúrese de proporcionar esta
información a todos los usuarios antes de continuar con la instalación.

Acerca de esta versión

En esta versión se incluyen las siguientes aplicaciones:

• Fiery Command WorkStation Package 6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Fiery Hot Folders para Mac 4.1.0.21

• Fiery Hot Folders para Windows 4.1.0.21

• Fiery Software Manager 4.4.0.18

Actualizaciones

El instalador actualizará cualquier Fiery Command WorkStation Package existente al último paquete que contenga
Fiery Command WorkStation y Fiery Hot Folders. Opcionalmente, puede instalar Fiery Remote Scan mediante Fiery
Software Manager.
Fiery Command WorkStation Package es compatible con Fiery servers con FS100 y posteriores, Fiery proServer y
Fiery XF 7.0 y posteriores. No se conectará a:

• Fiery servers con Fiery System 9/9e Rel2 y el software System 10 y versiones anteriores

• Servidores Fiery XF 6.x y anteriores

• Servidores de Fiery Central

Si necesita tener acceso a estos productos no actualice. Fiery Extended Applications Package sigue estando
disponible en www.efi.com/cws. Para obtener una lista completa de las impresoras de hojas admitidas, consulte 
http://fiery.efi.com/CWS/supported-printers.
Para obtener más información acerca de las especificaciones técnicas, consulte www.efi.com/cws.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


Nuevas funciones

Novedades

Para obtener información acerca de las nuevas funciones añadidas en la publicación inicial de la versión 6.5,
visite http://fiery.efi.com/CWS/Whats-New.
Para obtener información acerca de las nuevas funciones añadidas después de la publicación inicial de la versión
6.5, consulte la información que aparece a continuación.

Fiery Spot Pro

Fiery Command WorkStation 6.5 le permite administrar colores planos con Fiery Spot Pro, que sustituye a Fiery
Spot-On. Para ver una lista completa de las mejoras, consulte https://www.efi.com/spotpro.
Fiery Spot Pro se puede instalar en determinados servidores con los siguientes requisitos:

• Software FS200 Pro y posterior

• Fiery Graphic Arts Package, Premium Edition

Más información en http://fiery.efi.com/spotpro/supported-printers
Si su Fiery server no tiene Fiery Spot Pro habilitado, Fiery Command WorkStation seguirá siendo compatible
con Fiery Spot-On.

Consideraciones para el uso de Fiery Spot Pro

• No utilice el símbolo "@" en ningún nombre de color plano.

• Después de iniciar Spot Pro, espere aproximadamente entre 60-120 segundos antes de utilizar la función de
búsqueda o cambiar entre perfiles de salida.

• La optimización de los colores planos después de varias iteraciones puede dar lugar a diferencias más
pronunciadas entre el color plano original y el color plano convertido.

• Hay un ligero redondeo numérico de los valores L*a*b* convertidos y los valores de CMYK de dispositivo.

• Si hay dos instancias de Spot Pro en diferentes sistemas de usuarios que se conectan al mismo Fiery server
pueden producirse errores si ambos usuarios realizan actividades de edición.

Compatibilidad de EFI ES-3000

El nuevo instrumento de medición EFI ES-3000 es compatible a través de una emulación de EFI ES-2000 en
Fiery Command WorkStation 6.5. El dispositivo EFI ES-3000 es una actualización del EFI ES-2000 y es
compatible con medidas individuales en los modos de medición M1 y M2. Puede utilizar el instrumento EFI
ES-3000 (seleccionando la entrada "EFI ES-2000" en la interfaz de usuario) con las funciones Fiery Calibrator,
Fiery Spot Pro y Paper Simulation de Fiery Command WorkStation.

Nota: La emulación del dispositivo ES-2000 (entrada "EFI ES-2000" en la interfaz de usuario) también puede
utilizarse con un sistema EFI ES-2000.
Para obtener más información acerca de la utilización del sistema EFI ES-3000 con otras aplicaciones, consulte
la documentación que se suministra con esas aplicaciones.
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Notificaciones de licencia del paquete de opciones de Fiery

Las notificaciones sobre las actualizaciones del servidor disponibles ahora se muestran en la nueva sección
Notificaciones en Fiery Command WorkStation. Las notificaciones se muestran cuando se aproxima la fecha de
caducidad de las licencias de las opciones de Fiery instaladas o cuando estas han caducado. Las notificaciones se
muestran en Fiery Command WorkStation, Fiery Hot Folders y en Fiery WebTools.

Nota: Puede ver la información de vencimiento de licencia en cualquier momento en WebTools > Inicio y Fiery
Command WorkStation > Centro de dispositivo > General > Información general.
Las notificaciones de vencimiento ofrecen las opciones siguientes:

• Renovar ahora

• Descartar

• Más información

Compatibilidad con el informe de Fiery JobExpert

La conexión de Fiery Command WorkStation 6.5 a los servidores FS400 permite ver una presentación
preliminar de las mejoras realizadas en el trabajo con Fiery JobExpert.
El informe de Fiery JobExpert proporciona información general sobre los valores de propiedades del trabajo
recomendados que se aplican a sus trabajos con Fiery JobExpert.

Compatibilidad con Adobe Acrobat Pro 2017 y Enfocus PitStop Edit 2019

La opción Adobe Acrobat Pro 2017 y Enfocus PitStop edición 2019 está disponible para su descarga desde Fiery
Software Manager.

Compatibilidad con instrumentos de medición en Fiery XF Color Editor

A continuación se describen los instrumentos de medición de optimización y de muestras individuales
compatibles:

Instrumento de medición Muestra individual Optimización

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

Compatibilidad con el extremo de tinta clara variable

Fiery XF permite configurar un extremo de tinta clara para guardar tinta clara en archivos de calibración.
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Para crear un archivo de calibración de ahorro de tinta, reduzca la cantidad de tinta clara modificando el valor
de Extremo de tinta clara en la pestaña Límite de tinta y calibración de Color Tools.

Compatibilidad con el diseño de muestras 1617 (CGATS IT 8.7/5)

Fiery XF admite un diagrama de creación de perfiles en Color Tools con 1617 muestras.
El destino 1617 es un destino de caracterización de impresora CMYK que combina los valores de muestras
únicos en el destino estándar IT8.7/4 con todos los valores de muestras en las columnas 4 y 5 del destino P2P51.

Compatibilidad con la creación de valores predefinidos de Verifier personalizados en Server
Manager

Puede crear valores predefinidos personalizados en XF-Verifier desde Server Manager.

Compatibilidad con la ubicación de la carpeta de conservación de un archivo de copia de seguridad
de Hot Folder

Al restaurar Hot Folders desde un archivo de copia de seguridad, ahora puede conservar las ubicaciones de la
carpeta original del archivo de copia de seguridad.

Aplicaciones web EFI IQ

Puede registrar las aplicaciones Web EFI IQ en la pantalla Inicio de Command WorkStation. Las aplicaciones
web EFI IQ proporcionan mayor visibilidad de su producción de impresión gracias a las potentes funciones de
análisis de impresión.

Requisitos de las actualizaciones del sistema

Versiones compatibles

Fiery Command WorkStation es compatible con estos sistemas operativos en su ordenador:

• macOS 11 (solo con procesadores Intel)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10, 64 bits

• Windows Server 2019, 64 bits

• Windows Server 2016, 64 bits

• Windows 8.1, 64 bits

• Windows 7, 64 bits

• Windows Server 2012 R2, 64 bits

• Windows Server 2008 R2, 64 bits
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Asistencia discontinuada

• macOS 10,11

• macOS 10.12

• System 10 y anteriores

Al actualizar Fiery Command WorkStation a la versión 6.5, se eliminan de la lista de servidores todos los
servidores System 10 previamente añadidos. Si intenta iniciar sesión en un Fiery server que ejecute System 10 o
anterior, se le impide utilizar este servidor porque solo se admite el Fiery server que ejecute FS100 y posterior.

Aplicación de 64 bits

Fiery Command WorkStation 6.5 (CWS) es una aplicación nativa de 64 bits para las plataformas MacOS y
Windows.
No se admiten los sistemas operativos de 32 bits en CWS 6.5. Si Fiery Software Manager ya se está ejecutando
Fiery Software Manager en un sistema operativo de 32 bits, como la versión de 32 bits de Windows 7, no se
mostrarán las notificaciones de actualización del paquete 6.5. Si intenta instalar esta versión de Fiery Software
Manager en un sistema operativo de 32 bits, se producirá un error de compatibilidad y Fiery Software Manager
no se ejecutará. Para ver los sistemas operativos admitidos, consulte http://fiery.efi.com/cws-specifications.

Compatibilidad con la suscripción a Adobe Acrobat DC para el uso con Fiery Impose, Fiery Compose
oFiery JobMaster

Fiery Command WorkStation Package 6.5.0.292 es compatible con el uso de suscripciones individuales/
personales de Acrobat DC instaladas en un equipo cliente, para el uso con Fiery Impose, Fiery Compose o Fiery
JobMaster.

Nota: Para utilizar Acrobat desde Fiery Impose, Fiery Compose o Fiery JobMaster, debe instalar solo una
instancia de Acrobat DC en el equipo cliente. Además, asegúrese de que otras versiones de Acrobat no estén
instaladas en el mismo equipo cliente.

Problemas conocidos

Vista de lector

En Fiery Impose, Fiery Compose, Fiery JobMaster o Fiery Preview, la Vista de lector ha sido eliminada en macOS
11 y posterior.

ImageEnhance Visual Editor

Al maximizar la ventana de ImageEnhance Visual Editor en macOS 11, es posible que el monitor parpadee
durante unos segundos.

Conversión de PS a PDF

Al utilizar macOS 10.14.5 y posterior con Fiery Impose, Fiery Compose o Fiery JobMaster, es posible que se le
pida que permita el acceso de Fiery Command WorkStation a Acrobat Distiller. Este permiso es necesario para
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la conversión de archivos PS a PDF. Si no otorga este permiso, las conversiones no serán correctas y deberá
cambiar la función de seguridad de Automatización en macOS.

1 Cierre todas las aplicaciones Fiery.

2 Cierre Acrobat Distiller.

3 Ir a Preferencias del sistema > Seguridad y privacidad > Privacidad > Automatización.

4 Haga clic en el icono de candado de la esquina inferior izquierda y escriba su contraseña.

5 En la lista aplicaciones, busque Fiery Command WorkStation.app.

6 Seleccione la opción Acrobat Distiller.app.
Esto permite a Fiery Command WorkStation acceder a Acrobat Distiller.

Información de macOS 10.15 (Catalina)

Presentación preliminar de Fiery, Fiery Impose, Fiery Compose o Fiery JobMaster en MacOS 10.15

Kit de aplicaciones de compatibilidad con PDF

El kit de aplicaciones de compatibilidad con PDF (proporcionado por EFI), que consiste en Adobe Acrobat y
Enfocus PitStop, no es compatible con macOS 10.15 (Catalina). Si utiliza Acrobat o PitStop, no actualice a
macOS 10.15. Para nuevas instalaciones, el instalador de aplicaciones de compatibilidad con PDF no se
ejecutará.
La actualización a macOS 10.15 mientras utiliza el kit de aplicaciones de compatibilidad con PDF actual puede
generar los siguientes problemas:

• Si tiene Acrobat DC instalado antes de actualizar a macOS 10.15, se ejecutará normalmente. Sin embargo, el
instalador de Acrobat DC no es compatible con macOS 10.15, de forma que no es posible instalar Acrobat
DC después de la actualización. Además, Enfocus PitStop no es compatible con macOS 10.15.

• Si tiene Acrobat XI instalado antes de actualizar a macOS 10.15, no se ejecutará, ya que no es compatible con
este sistema operativo. Le recomendamos que desinstale Acrobat XI antes de actualizar a macOS 10.15. La
desinstalación de Acrobat XI no se puede ejecutar en macOS 10.15, de forma que si actualiza a esa versión
con Acrobat XI aún instalado, Acrobat XI no funcionará y no podrá desinstalarse.

Si no hay una versión compatible de Acrobat instalada, se generarán los siguientes problemas:

• La función Editar en Acrobat no estará disponible en Fiery Impose, Fiery Compose ni Fiery JobMaster.

• Abrir un trabajo de PostScript con Presentación preliminar de Fiery, Fiery Impose, Fiery Compose o Fiery
JobMaster puede provocar errores.

• Las plantillas de Fiery Impose que utilicen flujos de trabajo de Tamaño de terminación definido por el
usuario o Basado en Cuadro de guillotinado podrían generar errores con los trabajos de PostScript.

• Fiery Hot Folders no permite convertir archivos de PostScript a PDF.

Otros problemas

Después de actualizar a MacOS 10.15 desde una versión anterior, ejecutar Presentación preliminar de Fiery,
Fiery Impose, Fiery Compose o Fiery JobMaster puede provocar que aparezca uno de los siguientes mensajes:

• "ICUConverter.framework" dañará su equipo. Debe moverlo a la Papelera.

• "ICUData.framework" dañará su equipo. Debe moverlo a la Papelera.
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macOS 10.15 identifica erróneamente estos archivos como malware. Para resolver estos problemas, vuelva a
instalar la versión 6.4.0.396 o posterior de Fiery Command WorkStation Package, que es compatible con MacOS
10.15.
Al colocar el ratón sobre los botones de cualquiera de los iconos de control en Presentación preliminar de Fiery,
Fiery Impose, Fiery Compose o Fiery JobMaster, las sugerencias de la herramienta no se muestran.

Acceso al disco completo

Debido a los cambios en la forma en que macOS 10.15 gestiona la seguridad, ahora se necesitan más pasos para
permitir que las aplicaciones de Fiery funcionen correctamente.
Es necesario realizar cambios en la función de seguridad de Acceso al disco completo en macOS para que las
aplicaciones Fiery administren las actualizaciones y los archivos de acceso, como las plantillas de Impose y las
carpetas de proceso. Habilite la opción Acceso al disco completo para las aplicaciones Fiery, como, por ejemplo,
Fiery Command WorkStation.

1 Cierre todas las aplicaciones Fiery.

2 Ir a Preferencias del sistema > Seguridad y privacidad > Privacidad > Acceso al disco completo.

3 Haga clic en el icono de candado de la esquina inferior izquierda y escriba su contraseña.

4 Haga clic en el botón +.

5 En la carpeta Aplicaciones, seleccione Fiery Software Manager y Fiery Software Uninstaller y haga clic en
Abrir.
Estas aplicaciones requieren acceso al disco completo para poder mantener y actualizar las aplicaciones Fiery
de su equipo.

6 En la carpeta Aplicaciones, seleccione la aplicación Fiery Command WorkStation y haga clic en Abrir.

7 Si utiliza Fiery Hot Folders o Fiery Remote Scan, seleccione cada aplicación y haga clic en Abrir.
Cuando Fiery Hot Folders detecta que se utilizan las carpetas Documentos, Escritorio y Descargas, envía un
mensaje en el que solicita el acceso completo al disco. Este mensaje se sigue mostrando después de que se
haya concedido el acceso. Puede descartar este mensaje y seguir trabajando.

Errores del explorador Safari en macOS 10.15

Si utiliza Safari en macOS 10.15, encontrará errores repetitivos en el explorador al intentar abrir las siguientes
páginas web desde Fiery Command WorkStation. Centro de dispositivo > General > Herramientas:

• Restauración del sistema Fiery

• Imagen del sistema Fiery

• Recursos y configuración de Fiery

Estos errores también pueden producirse al abrir Fiery WebTools en el explorador Safari.
Utilice Chrome o Firefox para acceder a estas páginas web.

Fiery XF en macOS 10.15

Si utiliza Fiery XF en macOS 10.15, deberá actualizar Fiery Color Profiler Suite a la versión 5.3.1. Con la versión
5.3.1 de Fiery Color Profiler Suite, Fiery Verify compatible con macOS 10.15 ya está disponible para usuarios de
Fiery XF como aplicación de verificación por defecto.
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Color Verifier no es compatible con macOS 10.15, pero se puede utilizar con las versiones de macOS anteriores.
Sin embargo, Color Verifier debe instalarse por separado. Descargue Color Verifier para macOS 10.14 y
versiones anteriores desde el Centro de descargas.

Fiery Color Profiler Suite y Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) y versiones anteriores no son plenamente compatibles con Fiery Command
WorkStation Package 6.5 (CWS) en impresoras de hojas. Le recomendamos que se actualice a Fiery Color
Profiler Suite 5.1.
Al utilizar CPS 5.0 con CWS 6.5, puede experimentar los siguientes problemas:

• Si aparece en CWS el mensaje “Conecte el espectrofotómetro a su ordenador” mientras CPS está abierto,
cierre CPS y haga clic en Aceptar para continuar.

• Después de crear una nueva configuración de calibración en Calibrator, el botón Crear nuevo perfil para
iniciar CPS se encuentra oculto. Este problema se soluciona al actualizarse a CPS 5.1.

La selección de la opción Editar en Acrobat desde Fiery Impose, Fiery Compose o Fiery JobMaster
abre dos ventanas de Acrobat

En equipos Windows, cuando se selecciona la opción Editar en Acrobat desde Fiery Impose, Fiery Composeo
Fiery JobMaster, es posible que Acrobat se abra en dos ventanas en lugar de en una. Se trata de un problema
conocido. Puede cerrar la ventana de Adobe Acrobat y continuar trabajando en la ventana con el PDF.

Configuración de las preferencias de Adobe Acrobat Distiller para la conversión de PostScript a PDF

Fiery Impose, Fiery Compose y Fiery JobMaster requieren que Acrobat Distiller convierta los archivos PostScript
(PS) a PDF en un equipo cliente.
Debido a la configuración de seguridad mejorada de Acrobat Distiller, debe confirmar que el archivo PS que se
va a convertir tiene un origen fiable en: Adobe Acrobat Distiller > Archivo > Preferencias > Preferencias: Acrobat
Distiller, seleccione Confiar en todos los archivos abiertos a través de Acrobat Distiller en Seguridad.

Nota: Si no selecciona Confiar en todos los archivos abiertos a través de Acrobat Distiller, se le solicitará que
confirme que el archivo tiene un origen fiable para que todos los archivos PS se conviertan en PDF. También se
aplica a Hot Folders cuando el filtro de Microsoft Office está seleccionado, cuando el Tipo de archivo de salida se
especifica como PDF y se selecciona un archivo joboptions como Perfil de Distiller.

No se puede iniciar Configure desde un ordenador macOS

Si su Fiery server ejecuta el sistema FS100, no podrá iniciar Configure desde estas versiones del sistema
operativo:

• mac10.14.6 y versiones posteriores de 10.14

• macOS 10.15 (todas las versiones)

Para conectarse a Fiery Command WorkStation, utilice un ordenador macOS con una versión anterior de
macOS, o utilice un ordenador Windows.
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Retardo al iniciar Fiery Impose, Fiery Compose o Fiery JobMaster

Fiery Impose, Fiery Compose y Fiery JobMaster pueden tardar más en comenzar que en versiones anteriores.
Para reducir la duración del tiempo para abrir una de estas aplicaciones, inicie primero Fiery Preview y después
la aplicación que desea utilizar.

Problemas solucionados en Fiery Command WorkStation Package 6.5.0.599

Fiery Command WorkStation

• Los resultados de la medición con el espectrofotómetro ES-3000 no eran precisos.

Problemas solucionados en Fiery Command WorkStation Package 6.5.0.581

Fiery Command WorkStation

• Al utilizar el formato de entrada TIFF en Fiery Hot Folders, la configuración de posicionamiento de la imagen no
se aplicaba correctamente en algunos idiomas.

• Fiery Command WorkStation Package 6.5 es compatible con Windows 10, versión 20H2.

Fiery XF

• Al agregar un servidor Fiery XF con la opción Guardar contraseña activada y después reiniciar el servidor Fiery
XF, Fiery Command WorkStation Package no se iniciaba correctamente.

Problemas solucionados en Fiery Command WorkStation Package 6.5.0.563

Fiery Command WorkStation

• En un sistema en japonés, al iniciar sesión con una cuenta de administrador recién creada, Fiery Spot Pro no se
abre.

Fiery XF

• En el Centro de trabajos de Fiery Command WorkStation , la columna Estado del trabajo indica que la
verificación no se realizó correctamente, aunque el trabajo haya superado todas las pruebas de Fiery Verify.

• En el Centro de trabajos de Fiery Command WorkStation, si el estado de un trabajo anidado era Para verificar,
Fiery Verify no se iniciaba al hacer clic en Verificar en el panel Resumen de trabajos del trabajo principal. Fiery
Verify se abre al hacer clic en Optimizar o Detalles en el panel Resumen de trabajos de un trabajo secundario.

Notas de la versión para el cliente

Fiery Command WorkStation Package, v6.5

56



Problemas solucionados en Fiery Command WorkStation Package 6.5.0.539

Fiery Command WorkStation

• Tras imponer un trabajo PPML con una plantilla de 4 por cara y procesarlo, algunas páginas del trabajo no se
mostraron en Fiery ImageViewer.

Fiery XF

• No se podía especificar un valor de más de 59,4 cm para la configuración de ancho personalizado en Command
WorkStation Server Manager > Diseño > Pasar a siguiente y repetir > Patrón.

Problemas solucionados en Fiery Command WorkStation Package 6.5.0.512

Fiery Command WorkStation

• En sistemas en japonés, al imprimir un trabajo editado con Fiery ImageViewer, Fiery server dejaba de responder.

• La visualización de los cuadros de edición de un trabajo en la vista de líneas en Fiery Impose está ahora alineada
con las líneas.

Fiery XF

• Si modificó el nombre del soporte o un archivo calibración (*.EPL) asociado a un perfil de soportes por otro
nombre distinto en Color Tools > Conectar perfiles, comprobará que se ha eliminado la información de impresora
compatible del archivo calibración (*.EPL).

• No se puede guardar la configuración de Área de pegado en Job Editor > Superponer/Pegar.

• XF 7.2 admite los instrumentos de medida X-Rite i1Pro3 y EFI ES-3000 en equipos macOS.

Problemas solucionados en Fiery Command WorkStation Package 6.5.0.475

Fiery Command WorkStation

• En Fiery Spot Pro, ahora puede especificar los valores de separación de colores planos y de sustitución con un
decimal.

• En Fiery Spot Pro, la opción Devolver a valores de fábrica ahora está deshabilitada para colores planos en grupos
duplicados.

• Es posible volver a instalar y activar Adobe Acrobat Pro 2017 y Enfocus PitStop Edit 2019 desde Fiery Software
Manager.

Fiery XF

• Con las impresoras de formato superancho de bobina a bobina VUTEk, el ajuste de modo de impresión de
Configuración especial > Impresión de tinta blanca siempre cambiaba de nuevo al color plano WHITE_INK.

• Con el idioma del sistema de Fiery server definido en Polaco, la aplicación Cut Server no reconocía los trabajos
de anidamiento.

Notas de la versión para el cliente

Fiery Command WorkStation Package, v6.5

57



Problemas solucionados en Fiery Command WorkStation Package 6.5.0.433

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 es compatible con Windows 10, versión 2004.

• Al imprimir un trabajo de folleto con una plantilla de Fiery Impose guardada como valor predefinido, a veces no
se aplicaba la configuración del papel de la portada.

• A veces no se podía iniciar Fiery Impose, Fiery Compose ni Fiery JobMaster porque un mensaje de error
incorrecto indicaba que la aplicación ya estaba abierta. Este problema se ha solucionado.

• Cuando se tenían varias licencias activadas, no se podían restaurar los códigos de activación de licencia (LAC)
durante la restauración de Fiery server con la función Restauración del sistema Fiery. Este problema se ha
solucionado.

Fiery XF

• Los nombres de usuario del sistema con espacios o caracteres especiales hacían que Job Editor no pudiera
mostrar presentaciones preliminares de trabajos.

• En los sistemas de idioma italiano, tras actualizar Fiery Command WorkStation 6.5 a la versión más reciente, Job
Editor dejaba de responder.

Problemas solucionados en Fiery Command WorkStation Package 6.5.0.367

Fiery Command WorkStation

• En algunos idiomas, el texto que se colocaba en las pestañas mediante Fiery Compose o Fiery JobMaster se
mostraba correctamente cuando se veía en el equipo, pero no se mostraba al imprimir las pestañas.

• Cuando se guardaban formularios PDF con datos especificados en los campos de formulario desde Fiery
Compose o Fiery JobMaster, los campos de formulario no se mostraban en la Presentación preliminar ni en la
salida impresa.

• No se podía volver a calibrar un conjunto de calibración con un tamaño de papel personalizado de 241 x 330 mm
al cambiar el tamaño de papel de 241 x 330 mm a 13 x 19 pulgadas.

• No era posible medir una página de calibración al conectar un espectrofotómetro a cualquier equipo tras
imprimir la página de calibración.

Fiery XF

• En algunas plataformas de Windows, Job Editor no podía mostrar la presentación preliminar de los trabajos.

Problemas solucionados en Fiery Command WorkStation Package 6.5.0.292

Fiery Command WorkStation

• La fuente Arial se mostraba como cursiva en algunos equipos Windows tras instalar Fiery Command
WorkStation Package 6.5.

• La configuración por defecto definida en la función de Establecer valores por defecto no se aplicaba a la cola
Impresión secuencial.
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• En Fiery JobMaster, si se insertaban o eliminaban páginas de un trabajo en PDF con marcadores al mientras se
insertaban pestañas u hojas en blanco, los marcadores se desplazaban a páginas diferentes.

• En ocasiones, los equipos macOS con sistemas operativos que no son de lengua inglesa generaban datos de
medida IT8 dañados.

Fiery XF

• En Color Tools > Crear calibración > Balance de grises, los valores de delta E cambiaban cada vez que se abría un
archivo EPL guardado

• Con el idioma del sistema de Fiery server definido en Polaco, la aplicación Cut Server no reconocía los trabajos
de anidamiento.

• Al volver a calibrar el servidor de Fiery XF, no se aplicaba el flujo de trabajo por defecto establecido en la ventana
de Administrador del servidor.

Problema resuelto en Fiery Command WorkStation Package v6.5.0.171 SP1

• Cuando se utilizaba la acción Asignar papel en Fiery Impose, aparecía un mensaje de advertencia de perfil de
sRGB incorrecto.

Problemas solucionados en Fiery Command WorkStation Package v6.5.0.171

Fiery XF

• No es posible crear una línea de base para el sistema EPSON SC-P75x0/SC-P95x0 RGB

• No es posible seleccionar la impresión de etiquetas en los sistemas EPSON SC-P75x0 y SC-P95x0

• No es posible calibrar el sistema EPSON 9500 con soportes de 44 pulgadas
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Notas de Versão do Cliente
Fiery Command WorkStation Package, v6.5

Este documento contém informações importantes sobre esta versão. Certifique-se de fornecer essas informações a
todos os usuários antes de prosseguir com a instalação.

Sobre esta versão

Os aplicativos a seguir estão incluídos nesta versão:

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Fiery Hot Folders para Mac 4.1.0.21

• Fiery Hot Folders para Windows 4.1.0.21

• Fiery Software Manager v4.4.0.18

Upgrade

Esse instalador fará o upgrade de qualquer Fiery Command WorkStation Package existente para o pacote mais
recente contendo a Fiery Command WorkStation e o Fiery Hot Folders. Opcionalmente, você pode instalar o Fiery
Remote Scan usando o Fiery Software Manager.
O Fiery Command WorkStation Package é compatível com Fiery servers que executam o FS100 e versões
posteriores, o Fiery proServer e o Fiery XF 7.0 e versões posteriores. O pacote não se conecta a:

• Fiery servers que executam o Fiery System 9/9e Rel2 e o software System 10 e versões anteriores.

• Servidores Fiery XF 6.x e versões anteriores

• Servidores Fiery Central

Se você precisa ter acesso a esses produtos, não faça a atualização. O pacote do Fiery Extended Applications ainda
está disponível em www.efi.com/cws. Para obter uma lista completa de impressoras compatíveis com cutsheet,
consulte http://fiery.efi.com/CWS/supported-printers.
Para obter mais informações sobre as especificações técnicas, consulte www.efi.com/cws.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


Novos recursos

O que há de novo?

Para obter informações sobre os novos recursos adicionados na versão inicial da 6.5, acesse http://
fiery.efi.com/CWS/Whats-New.
Para obter informações sobre os novos recursos adicionados após a versão inicial do 6.5, consulte as informações
abaixo.

Fiery Spot Pro

A Fiery Command WorkStation 6.5 permite gerenciar cores especiais com o Fiery Spot Pro, que substitui o Fiery
Spot-On. Para ver uma lista completa de melhorias, consulte https://www.efi.com/spotpro.
O Fiery Spot Pro está disponível para alguns servidores com os seguintes requisitos:

• Software FS200 Pro e posterior

• Fiery Graphic Arts Package, Premium Edition

Saiba mais em http://fiery.efi.com/spotpro/supported-printers.
Se o Fiery Spot Pro não estiver habilitado no Fiery server, a Fiery Command WorkStation continuará sendo
compatível com o Fiery Spot-On.

Considerações sobre como usar o Fiery Spot Pro

• Não use o símbolo "@" no nome de cores especiais.

• Depois de iniciar Spot Pro, aguarde aproximadamente 60-120 segundos antes de usar a função de pesquisa
ou alternar os perfis de saída.

• A otimização de cores especiais após várias iterações pode resultar em diferenças mais pronunciadas entre a
cor especial original e a cor especial convertida.

• Há um pequeno arredondamento numérico de valores L*a*b* convertidos e valores de CMYK do dispositivo.

• Duas instâncias do Spot Pro em sistemas de usuário diferentes conectando-se ao mesmo Fiery server podem
causar erros se os dois usuários executarem operações de edição.

Compatibilidade com o EFI ES-3000

O novo instrumento de medição EFI ES-3000 é compatível por meio de uma emulação do EFI ES-2000 na Fiery
Command WorkStation 6.5. O EFI ES-3000 é uma atualização do EFI ES-2000 e é compatível com medições
com uma única leitura nos modos de medição M1 e M2. Você pode usar o instrumento EFI ES-3000
(selecionando a entrada "EFI ES-2000" na interface do usuário) com o Fiery Calibrator, Fiery Spot Pro e recursos
de Simulação de Papel da Fiery Command WorkStation.

Nota: A emulação ES-2000 (entrada “EFI ES-2000” na interface do usuário) também pode ser usada junto com
um EFI ES-2000.
Para obter informações sobre como usar o EFI ES-3000 com diferentes aplicativos, consulte a documentação que
acompanha esses aplicativos.
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Notificações de licença do pacote de opções do Fiery

As notificações sobre as atualizações disponíveis do servidor agora estão listadas na nova seção Notificações no
Fiery Command WorkStation. As notificações são exibidas quando as licenças das opções instaladas do Fiery se
aproximam da data de vencimento ou já expiraram. As notificações são exibidas no Fiery Command
WorkStation, Fiery Hot Folders e no Fiery WebTools.

Nota: É possível visualizar as informações de expiração da licença a qualquer momento em WebTools > Página
inicial e Fiery Command WorkStation > Centro de dispositivos > Geral > Informações gerais.
As notificações de expiração fornecem as seguintes opções:

• Renovar agora

• Descartar

• Saiba mais

Suporte para os relatórios do Fiery JobExpert

O Fiery Command WorkStation 6.5 conectado a servidores FS400 permite visualizar os aperfeiçoamentos feitos
na tarefa usando o Fiery JobExpert.
O relatório do Fiery JobExpert fornece uma visão geral das configurações das propriedades da tarefa sugeridas
aplicadas às tarefas usando Fiery JobExpert.

Suporte para o Adobe Acrobat Pro 2017 e Enfocus PitStop Edit 2019

A opção Adobe Acrobat Pro 2017 e Enfocus PitStop editar 2019 está disponível para download no Fiery Software
Manager .

Suporte para instrumentos de medição no Fiery XF Color Editor

Estes instrumentos de medição e otimização de amostra única são compatíveis:

Instrumento de medida Amostra única Otimização

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

Suporte para ponto final variável de tinta clara

O Fiery XF permite configurar um ponto final de tinta clara para salvar a tinta clara em arquivos de calibragem.
Para criar um arquivo de calibragem com economia de tinta, reduza a quantidade de tinta clara alterando o valor
do Ponto final de tinta clara na guia Limite de tinta e calibragem no Color Tools.
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Compatibilidade com layout de amostra 1617 (CGATS IT8.7/5)

O Fiery XF é compatível com um gráfico de criação de perfil no Color Tools com amostras 1617.
A meta 1617 é uma meta de caracterização de impressora CMYK que combina os valores de amostra exclusivos
na meta IT8.7/4 padrão com todos os valores de amostra nas colunas 4 e 5 do destino P2P51.

Suporte para criar predefinições personalizadas do Verifier com o Server Manager

É possível criar predefinições personalizadas no XF-Verifier com o Server Manager.

Suporte para reter a localização da pasta de um arquivo de backup de Hot Folder

Ao restaurar Hot Folders de um arquivo de backup, agora é possível manter os locais da pasta original do
arquivo de backup.

Aplicativo da Web EFI IQ

Você pode registrar aplicativos da Web EFI IQ na tela inicial do Command WorkStation. Os aplicativos da Web
EFI IQ dão mais visibilidade à sua produção de impressão com análises de impressão eficientes.

Atualizações nos requisitos do sistema

Versões compatíveis

A Fiery Command WorkStation é compatível com estes sistemas operacionais em seu computador:

• macOS 11 (somente com processadores Intel)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10 (64 bits)

• Windows Server 2019 (64 bits)

• Windows Server 2016 (64 bits)

• Windows 8.1 (64 bits)

• Windows 7 (64 bits)

• Windows Server 2012 R2 (64 bits)

• Windows Server 2008 R2 (64 bits)

Suporte descontinuado

• macOS 10.11

• macOS 10.12

• Sistema 10 e anterior
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Ao atualizar a Fiery Command WorkStation para a versão 6.5, todos os servidores do Sistema 10 adicionados
anteriormente serão removidos da lista do servidor. Se você tentar fazer login em um Fiery server com o Sistema
10 ou anterior, você está impedido de usar este servidor porque apenas um Fiery server com o FS100 ou mais
recente é compatível.

Aplicativo de 64 bits

A Fiery Command WorkStation 6.5 (CWS) é um aplicativo de 64 bits nativo para as plataformas Windows e
macOS
Sistemas operacionais de 32 bits não são compatíveis com a CWS 6.5. Se o Fiery Software Manager já estiver
sendo executado em um sistema operacional de 32 bits, como o Windows 7, ele não exibirá as notificações sobre
a atualização do pacote CWS 6.5. Ao tentar executar essa versão do Fiery Software Manager em um sistema
operacional de 32 bits, você verá um erro de compatibilidade e o Fiery Software Manager não será executado.
Para ver os sistemas operacionais compatíveis, consulte http://fiery.efi.com/cws-specifications.

Suporte para assinatura do Adobe Acrobat DC para usar com o Fiery Impose, Fiery Compose ou
Fiery JobMaster

A Fiery Command WorkStation Package v6.5.0.292 é compatível com assinaturas individuais/pessoais do
Acrobat DC instaladas em um computador cliente, para usar com o Fiery Impose, Fiery Compose ou Fiery
JobMaster.

Nota: Para usar o Acrobat no Fiery Impose, Fiery Compose ou Fiery JobMaster, você deve instalar apenas uma
instância do Acrobat DC no computador cliente. Além disso, verifique se outras versões do Acrobat não estão
instaladas no mesmo computador cliente.

Problemas conhecidos

Exibição do leitor

No Fiery Impose, Fiery Compose, Fiery JobMaster ou Fiery Preview, a Exibição do leitor foi removida no macOS
11 e posterior.

ImageEnhance Visual Editor

Quando você maximizar a janela ImageEnhance Visual Editor no macOS 11, o monitor poderá piscar por alguns
segundos.

Conversão de PS em PDF

Quando você usa o macOS 10.14.5 e posterior com o Fiery Impose, Fiery Compose ou Fiery JobMaster você
pode precisar permitir que a Fiery Command WorkStation tenha acesso ao Acrobat Distiller. Esta permissão é
necessária para a conversão de arquivos PS para PDF. Se você não conceder permissão, as conversões não serão
bem sucedidas e você precisará alterar o recurso de segurança de automação no macOS.

1 Feche todos os aplicativos do Fiery.

2 Feche o Acrobat Distiller.

3 Vá para Preferências do sistema > Segurança e privacidade > Privacidade > Automação.
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4 Clique no ícone do cadeado no canto inferior esquerdo e digite sua senha.

5 Na lista de Aplicativos, localize Fiery Command WorkStation.app.

6 Selecione a opção Acrobat Distiller.app.
Isso permite que o Fiery Command WorkStation tenha acesso ao Acrobat Distiller.

Informações do macOS 10.15 (Catalina)

Visualização do Fiery, Fiery Impose, Fiery Compose ou Fiery JobMaster no macOS 10.15

Kit de aplicativos de suporte em PDF

O kit de aplicativos de suporte em PDF (fornecido pela EFI), que consiste no Adobe Acrobat e Enfocus PitStop,
não é compatível com o macOS 10.15 (Catalina). Se você usa o Acrobat e/ou o PitStop, não atualize para o
macOS 10.15. Nas novas instalações, o instalador de Aplicativos de suporte em PDF não é executado.
Fazer a atualização do macOS 10.15 enquanto o kit de aplicativos de suporte em PDF atual estiver em uso pode
resultar nos seguintes problemas:

• Se você já tiver instalado o Acrobat DC antes de fazer a atualização para o macOS 10.15, ele será executado
normalmente. Entretanto, o instalador do Acrobat DC não é compatível com o macOS 10.15, portanto, não
é possível fazer novas instalações do Acrobat DC. Além disso, o Enfocus PitStop incluído não é compatível
com o macOS 10.15.

• Se você já tiver instalado o Acrobat XI antes de fazer a atualização para o macOS 10.15, ele não será
executado pois não é compatível com o macOS 10.15. Recomendamos desinstalar o Acrobat XI antes de
atualizar para o macOS 10.15. O desinstalador do Acrobat XI não funcionará no macOS 10.15. Portanto, se
você atualizar para o macOS 10.15 com o Acrobat XI ainda instalado, o sistema ficará em um estado em que
o Acrobat XI não funciona e não pode ser desinstalado.

Se uma versão compatível do Acrobat não estiver instalada, os seguintes problemas acontecerão:

• A função Editar no Acrobat não está disponível no Fiery Impose, Fiery Compose e Fiery JobMaster.

• Abrir uma tarefa do PostScript com a Visualização Fiery na Fiery Impose, Fiery Compose ou Fiery JobMaster
pode resultar em um erro.

• Os modelos do Fiery Impose que utilizam os fluxos de trabalho Tamanho do acabamento definido pelo
usuário ou Baseado na caixa de aparamento podem não funcionar corretamente com as tarefas do
PostScript.

• O Fiery Hot Folders não oferece a opção de converter arquivos do PostScript em PDF.

Outros problemas

Depois de atualizar para o MacOS 10.15 de uma versão mais antiga do MacOS, iniciar a visualização Fiery, Fiery
Impose, Fiery Composeou Fiery JobMaster pode fazer com que uma das seguintes mensagens seja exibida:

• "ICUConverter.framework" danificará o computador. Você deve movê-lo para o lixo.

• "ICUData.framework" danificará o computador. Você deve movê-lo para o lixo.

O macOS 10.15 identifica equivocadamente esses arquivos como malware. Para resolver esses problemas,
reinstale a Fiery Command WorkStation Package versão 6.4.0.396 ou posterior, que é compatível com o MacOS
10.15.
Ao passar o mouse sobre os botões de qualquer um dos ícones de controle na Visualização Fiery, Fiery Impose,
Fiery Compose ou Fiery JobMaster, as dicas de ferramenta não são exibidas.
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Acesso total ao disco

Devido a alterações no modo como o macOS 10.15 gerencia a segurança, agora há etapas adicionais necessárias
para permitir que os aplicativos do Fiery funcionem corretamente.
Você precisa fazer alterações no recurso de segurança Acesso total ao disco no MacOS para que os aplicativos
do Fiery gerenciem atualizações e acessem arquivos, como modelos do Impose e Hot Folders. Ative o Acesso
total ao disco para abrir aplicativos do Fiery como o Fiery Command WorkStation.

1 Feche todos os aplicativos do Fiery.

2 Vá para Preferências do sistema > Segurança e privacidade > Privacidade > Acesso total ao disco.

3 Clique no ícone do cadeado no canto inferior esquerdo e digite sua senha.

4 Clique no botão +.

5 Na pasta Aplicativos, selecione Fiery Software Manager e o Fiery Software Uninstaller e clique em Abrir.
Esses aplicativos exigem acesso total ao disco para manter e atualizar os aplicativos do Fiery no seu
computador.

6 Na pasta Aplicativos, selecione o aplicativo Fiery Command WorkStation e clique em Abrir.

7 Se você usar o Fiery Hot Folders ou Fiery Remote Scan, selecione cada aplicativo e clique em Abrir.
Quando o Fiery Hot Folders detecta que as pastas Documentos, Desktop e Downloads estão sendo usadas,
ele envia uma mensagem solicitando acesso total ao disco. Essa mensagem é exibida mesmo após o acesso ter
sido concedido. Você pode descartar essa mensagem e continuar trabalhando.

Erros do browser Safari no macOS 10.15

Ao usar o Safari no macOS 10.15, você encontrará erros de browser repetitivos ao tentar abrir as seguintes
páginas da Web no Fiery Command WorkStation Centro de dispositivos > Geral > Ferramentas:

• Restauração do sistema Fiery

• Imagem do sistema Fiery

• Recursos e configurações do Fiery

Esses erros também podem ocorrer ao abrir o Fiery WebTools no navegador Safari.
Use o Chrome ou o Firefox para acessar essas páginas da Web.

Fiery XF no macOS 10.15

Se você usar o Fiery XF no macOS 10.15, será necessário atualizar a Fiery Color Profiler Suite para a versão 5.3.1.
Com a Fiery Color Profiler Suite versão 5.3.1, o Fiery Verify fica em conformidade com o macOS 10.15 agora
está disponível para usuários do Fiery XF como o aplicativo de verificação padrão.
O Color Verifier não é compatível com o macOS 10.15, mas ainda é compatível com as versões mais antigas do
macOS. Mas você precisa instalar o Color Verifier separadamente. Faça o download do Color Verifier para
macOS 10.14 e versões anteriores no Centro de Download.

Fiery Color Profiler Suite e Fiery Command WorkStation 6.5

O Fiery Color Profiler Suite 5.0 (CPS) e as versões anteriores não são totalmente compatíveis com o Fiery
Command WorkStation Package 6.5 (CWS) para impressoras de folhas soltas. Recomendamos atualizar para o
Fiery Color Profiler Suite 5.1.
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Ao usar o CPS 5.0 com a CWS 6.5, você pode enfrentar os seguintes problemas:

• Se você visualizar a mensagem na CWS “Conecte o espectrofotômetro ao seu computador” enquanto o CPS
estiver aberto, feche o CPS e clique em OK para continuar.

• Depois de criar uma nova configuração de calibragem no Calibrator, o botão Criar novo perfil que inicia o
CPS ficará oculto. Esse problema é resolvido após a atualização para o CPS 5.1.

Editar na opção Acrobat pelo Fiery Impose, Fiery Compose ou Fiery JobMaster abre duas janelas do
Acrobat

Em computadores Windows, quando a opção Editar no Acrobat é selecionada pelo Fiery Impose, Fiery Compose
ou Fiery JobMaster, o Acrobat pode ser aberto em duas janelas em vez de uma. Este é um problema conhecido.
Você pode fechar a janela do Adobe Acrobat e continuar a trabalhar na janela com o PDF.

Configuração de preferências no Adobe Acrobat Distiller para PostScript para conversão em PDF

O Fiery Impose, Fiery Compose e Fiery JobMaster exigem que o Acrobat Distiller converta arquivos PostScript
(PS) em PDF em um computador cliente.
Devido às configurações de segurança aprimoradas no Acrobat Distiller, você deve confirmar que o arquivo PS
que será convertido é proveniente de uma fonte confiável em: Acrobat Distiller. > Arquivo > Preferências >
Preferências - Acrobat Distiller, selecione a opção Confiar em todos os arquivos abertos pelo Acrobat Distiller em
Segurança.

Nota: Se a opção Confiar em todos os arquivos abertos pelo Acrobat Distiller não estiver selecionada, você deve
confirmar que o arquivo é de uma fonte confiável para todo arquivo PS que deve ser convertido em PDF. Isso
também se aplica a Hot Folders quando o filtro do Microsoft Office estiver selecionado, o Tipo de arquivo de
Saída estiver especificado como PDF e um arquivo joboptions for selecionado como um Perfil do Distiller.

Não é possível iniciar o Configure por um computador com macOS

Se o Fiery server executar o sistema FS100, você não pode iniciar o Configure a partir dessas versões do sistema
operacional:

• mac10.14.6 e versões posteriores do 10.14

• macOS 10.15 (todas as versões)

Para se conectar ao Fiery Command WorkStation, use um computador com macOS com uma versão anterior do
macOS ou use um computador Windows.

Atraso no início do Fiery Impose, Fiery Compose ou Fiery JobMaster

Fiery Impose, Fiery Compose e Fiery JobMaster podem levar mais tempo para começar do que em versões
anteriores. Para reduzir o tempo para abrir um desses aplicativos, inicie o Fiery Preview primeiro e, em seguida,
o aplicativo que deseja usar.

Problemas corrigidos na Fiery Command WorkStation Package v6.5.0.599

Fiery Command WorkStation

• Os resultados de medição com o espectrofotômetro ES-3000 não eram precisos.
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Problemas corrigidos no Fiery Command WorkStation Package v6.5.0.581

Fiery Command WorkStation

• Quando você estava usando o formato de entrada TIFF no Fiery Hot Folders, as configurações de
posicionamento da imagem não eram aplicadas corretamente em alguns idiomas.

• O Fiery Command WorkStation Package 6.5 é compatível com o Windows 10 versão 20H2.

Fiery XF

• Ao adicionar um servidor Fiery XF com a preferência Salvar senha ativada e reinicializar o servidor Fiery XF o,
Fiery Command WorkStation Package não é iniciado com sucesso.

Problemas corrigidos no Fiery Command WorkStation Package v6.5.0.563

Fiery Command WorkStation

• Em um sistema de idioma japonês, quando você faz logon com uma conta de administrador recém-criada, ela
Fiery Spot Pro falha ao abrir.

Fiery XF

• No Centro de tarefas do Fiery Command WorkStation, a coluna Status da tarefa informa que a verificação não
foi bem-sucedida, mesmo que a tarefa tenha passado em todos os testes em Fiery Verify.

• No Centro de tarefas do Fiery Command WorkStation, se o status de uma tarefa aninhada foi Para verificar, o
Fiery Verify não foi iniciado quando você clicou em Verificar a partir do painel Resumo da tarefa da tarefa
principal. O Fiery Verify abre se você clicar em Otimizar ou em Detalhes no painel Resumo da tarefa de uma
tarefa derivada.

Problemas corrigidos no Fiery Command WorkStation Package v6.5.0.539

Fiery Command WorkStation

• Após a imposição de uma tarefa de PPML com um modelo de 4 pág. e a processou, algumas páginas da tarefa não
eram exibidas Fiery ImageViewer .

Fiery XF

• Não era possível especificar um valor de mais de 59,4 cm para a configuração de largura personalizada em
Command WorkStation Server Manager > Layout > Avançar e repetir > Padrão.

Problemas corrigidos no Fiery Command WorkStation Package v6.5.0.512

Fiery Command WorkStation

• Em um sistema em língua japonesa, ao imprimir uma tarefa que foi editada usando o Fiery ImageViewer, o Fiery
server parava de responder.

• A exibição de caixas de edição de uma tarefa na exibição de wireframe no Fiery Impose agora está alinhada com
os wireframes.
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Fiery XF

• Se você alterasse o nome da mídia ou associasse um arquivo de calibragem (*.EPL) para um perfil de mídia com
um nome diferente em Color Tools > Connect Profiles, as informações compatíveis da impressora eram
removidas do arquivo de calibragem (*.EPL).

• Não é possível salvar a configuração Área de colagem no Job Editor > Sobreposição/Cola.

• O XF 7.2 é compatível com os instrumentos de medição X-Rite i1Pro3 e EFI ES-3000 em computadores macOS.

Problemas corrigidos no Fiery Command WorkStation Package v6.5.0.475

Fiery Command WorkStation

• No Fiery Spot Pro, agora você pode especificar os valores de separação de cores especiais e cores substitutas com
uma única casa decimal.

• No Fiery Spot Pro, a opção Reverter para fábrica agora está desativada para cores especiais em um grupo
duplicado.

• Você pode reinstalar e ativar o Adobe Acrobat Pro 2017 e o Enfocus PitStop Edit 2019 pela Fiery Software
Manager.

Fiery XF

• Com as impressoras de supergrandes formatos rolo-a-rolo VUTEk, a configuração do modo de impressão em
Configurações especiais > Impressão com tinta branca sempre mudava para cor especial WHITE_INK.

• Com o idioma do sistema do Fiery server configurado para polonês, o aplicativo Servidor de corte não reconhecia
o encaixe de tarefas.

Problemas corrigidos no Fiery Command WorkStation Package v6.5.0.433

Fiery Command WorkStation

• O Fiery Command WorkStation Package 6.5 é compatível com o Windows 10 versão 2004.

• Quando você imprimia uma tarefa de livreto usando um modelo do Fiery Impose salvo como predefinição, às
vezes a configuração da mídia da capa não era aplicada.

• Ocasionalmente, não era possível iniciar o Fiery Impose, Fiery Compose ou o Fiery JobMaster porque uma
mensagem de erro incorreta afirmava que o aplicativo já estava aberto. Este problema foi resolvido.

• Quando você tinha várias licenças ativadas, não era possível restaurar os Códigos de ativação da licença (LACs)
enquanto restaurava um Fiery server usando uma restauração do Fiery System. Este problema foi resolvido.

Fiery XF

• Um nome de usuário do sistema contendo espaço ou caracteres especiais fazia com que o Job Editor não exibisse
as visualizações da tarefa.

• Em um sistema em italiano, após a atualização do Fiery Command WorkStation 6.5 para a última versão, o Job
Editor parava de responder.
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Problemas corrigidos no Fiery Command WorkStation Package v6.5.0.367

Fiery Command WorkStation

• Em alguns idiomas, o texto era colocado em separadores usando o Fiery Compose ou Fiery JobMaster e aparecia
corretamente quando visto no computador, mas o texto não era exibido quando os separadores eram impressos.

• Quando os formulários PDF com os dados inseridos nos campos de formulário eram salvos do Fiery Compose ou
Fiery JobMaster, os campos de formulário não eram exibidos na Visualização ou na impressão.

• Não era possível recalibrar um conjunto de calibragem com tamanho de papel personalizado 241x330 mm se
você alterasse o tamanho do papel de 241x330 mm para 13x19 polegadas.

• Não era possível medir uma página de calibragem se você conectasse um espectrofotômetro a qualquer
computador após imprimir a página de calibragem.

Fiery XF

• Em algumas plataformas Windows, o Job Editor não conseguia exibir a visualização das tarefas.

Problemas corrigidos na Fiery Command WorkStation Package v6.5.0.292

Fiery Command WorkStation

• A fonte Arial foi exibida como itálico em alguns computadores Windows depois da instalação da Fiery
Command WorkStation Package 6.5.

• As configurações padrão que você definiu com o recurso de Configuração de Padrões não foram aplicadas à fila
de Impressão Sequencial.

• No Fiery JobMaster, se você inseriu ou excluiu páginas de uma tarefa em PDF com marcadores ao inserir
separadores ou folhas em branco, os marcadores mudaram para páginas diferentes.

• Ocasionalmente, computadores macOS com um sistema operacional cujo idioma não é o inglês geraram dados
de medição IT8 corrompidos.

Fiery XF

• Em Color Tools > Criar calibragem > Balanço de cinza, os valores de delta E mudaram toda vez que você abriu um
arquivo EPL salvo

• Com o idioma do sistema do Fiery server configurado para polonês, o aplicativo Servidor de corte não
reconheceu encaixador de tarefas.

• Ao recalibrar o servidor Fiery XF, o Fluxo de trabalho padrão que você definiu na janela Server Manager não foi
aplicado.

Problema corrigido na Fiery Command WorkStation Package v6.5.0.171 SP1

• Ao usar a ação Atribuir mídia no Fiery Impose, uma mensagem alertava sobre um perfil sRGB incorreto.
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Problemas corrigidos na Fiery Command WorkStation Package v6.5.0.171

Fiery XF

• Não é possível criar linha de base para EPSON SC-P75x0/SC-P95x0 RGB

• Não é possível selecionar etiqueta impressão para EPSON SC-P75x0 e SC-P95x0

• Não é possível calibrar a EPSON 9500 com mídia de 44 polegadas
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Versienotities voor de klant
Fiery Command WorkStation Package, v6.5

Dit document bevat belangrijke informatie over deze versie. Zorg dat deze informatie bij alle gebruikers bekend is
voordat u doorgaat met de installatie.

Over deze release

Deze release bestaat uit de volgende toepassingen:

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Fiery Hot Folders voor Mac 4.1.0.21

• Fiery Hot Folders voor Windows 4.1.0.21

• Fiery Software Manager v4.4.0.18

Bezig met upgraden

Dit installatieprogramma zal een bestaand Fiery Command WorkStation Package upgraden naar het meest recente
pakket met Fiery Command WorkStation en Fiery Hot Folders. U kunt Fiery Remote Scan ook installeren met
behulp van Fiery Software Manager.
Fiery Command WorkStation Package ondersteunt Fiery servers met FS100 en hoger, en Fiery proServer en Fiery XF
7.0 en hoger. Het programma maakt geen verbinding met:

• Fiery servers met Fiery System 9/9e Rel2- en System 10-software en vorige versies

• Fiery XF 6.x-servers en eerder

• Fiery Central-servers

Als u toegang tot deze producten nodig hebt, moet u de upgrade niet uitvoeren. Fiery Extended Applications-pakket
is nog steeds beschikbaar op www.efi.com/cws. Raadpleeg http://fiery.efi.com/CWS/supported-printers voor een
volledige lijst met ondersteunde printers.
Ga voor meer informatie over de technische specificaties naar www.efi.com/cws.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


Nieuwe functies

Wat is nieuw?

Voor informatie over nieuwe functies die zijn toegevoegd in de eerste release van versie 6.5, gaat u naar http://
fiery.efi.com/CWS/Whats-New.
Voor informatie over nieuwe functies die zijn toegevoegd na de eerste release van versie 6.5, zie de onderstaande
informatie.

Fiery Spot Pro

Met Fiery Command WorkStation6.5 kunt u steunkleuren beheren met Fiery Spot Pro, de vervanger van Fiery
Spot-On. Voor een volledige lijst met verbeteringen gaat u naarhttps://www.efi.com/spotpro.
Fiery Spot Pro is beschikbaar voor geselecteerde servers met de volgende vereisten:

• FS200 Pro en nieuwere software

• Fiery Graphic Arts Package, Premium Edition

Vind meer informatie ophttp://fiery.efi.com/spotpro/supported-printers.
Als op uw Fiery server Fiery Spot Pro niet is ingeschakeld, blijft Fiery Command WorkStation Fiery Spot-On
ondersteunen.

Overwegingen voor het gebruik van Fiery Spot Pro

• Gebruik het "@"-symbool niet in een steunkleurnaam.

• Wacht na het starten van Spot Pro ongeveer 60-120 seconden voordat u de zoekfunctie gebruikt of van
uitvoerprofiel wisselt.

• Het herhaaldelijk optimaliseren van steunkleuren kan leiden tot grotere verschillen tussen de
oorspronkelijke steunkleur en een geconverteerde steunkleur.

• Geconverteerde L*a*b*-waarden en CMYK-waarden van het apparaat worden licht numeriek afgerond.

• Het gebruik van Spot Pro op twee verschillende gebruikerssystemen die verbinding maken met dezelfde
Fiery server kan tot fouten leiden als beide gebruikers bewerkingen uitvoeren.

Ondersteuning voor EFI ES-3000

Het nieuwe EFI ES-3000-meetinstrument wordt ondersteund door een EFI ES-2000-emulatie in Fiery Command
WorkStation 6.5. De EFI ES-3000 is een upgrade voor de EFI ES-2000 en ondersteunt enkele scanmetingen in
meetmodus M1 en M2. U kunt het EFI ES-3000-instrument gebruiken (door de optie "EFI ES-2000" in de
gebruikersinterface te selecteren) met Fiery Calibrator, Fiery Spot Pro en Papiersimulatiefuncties van Fiery
Command WorkStation.

Opmerking: De ES-2000-emulatie ("EFI ES-2000" in de gebruikersinterface) kan ook worden gebruikt in
combinatie met een EFI ES-2000.
Informatie over het gebruik van de EFI ES-3000 met verschillende toepassingen kunt u vinden in de
documentatie van de desbetreffende toepassingen.
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Meldingen over Fiery-optiepakketlicenties

Meldingen over beschikbare serverupdates worden nu weergegeven in het nieuwe Meldingen-gedeelte in Fiery
Command WorkStation. Meldingen worden weergegeven wanneer licenties van de geïnstalleerde Fiery-opties
de vervaldatum naderen of vervallen zijn. Meldingen worden weergegeven in Fiery Command WorkStation,
Fiery Hot Folders en Fiery WebTools.

Opmerking: U kunt op elk gewenst moment vervalinformatie voor de licenties bekijken in WebTools > Begin en
Fiery Command WorkStation > Apparaatcentrum > Algemeen > Algemene info.
De vervalmeldingen bieden de volgende opties:

• Nu verlengen

• Sluiten

• Meer info

Ondersteuning voor Fiery JobExpert-rapportering

Fiery Command WorkStation 6.5 verbonden met FS400-servers stelt u in staat om een voorbeeld te bekijken van
de verbeteringen die in de taak zijn aangebracht met Fiery JobExpert.
Fiery JobExpert-rapportering geeft een overzicht van de aanbevolen instellingen voor taakeigenschappen die
worden toegepast op uw taken met behulp van Fiery JobExpert.

Ondersteuning voor Adobe Acrobat Pro 2017 en Enfocus PitStop Edit 2019

De opties Adobe Acrobat Pro 2017 en Enfocus PitStop Edit 2019 zijn beschikbaar om te downloaden vanuit
Fiery Software Manager.

Ondersteuning voor meetinstrumenten in Fiery XF Color Editor

Deze meetinstrumenten voor enkele vlakken en optimalisatie worden ondersteund:

Meetinstrument Enkel vlak Optimalisatie

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro 3 *

X-Rite i1Pro 3+ *

Ondersteuning voor variabel eindpunt voor lichte inkt

Met Fiery XF kunt u een eindpunt voor lichte inkt instellen om lichte inkt op kalibratiebestanden te besparen.
Als u een inktbesparend kalibratiebestand wilt aanmaken, verlaagt u de hoeveelheid lichte inkt door de waarde
van het Eindpunt voor lichte inkt te wijzigen in het tabblad Inktlimiet en kalibratie van Color Tools.
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Ondersteuning voor 1617-vlakopmaak (CGATS IT8.7/5)

Fiery XF ondersteunt een profileringsgrafiek in Color Tools met 1617-vlakken.
Het 1617-doel is een karakteriseringsdoel van de CMYK-printer dat de unieke vlakwaarden in het IT8.7/4-
standaarddoel combineert met alle vlakwaarden in de kolommen 4 en 5 van het P2P51-doel.

Ondersteuning voor het maken van aangepaste Verifier-voorkeuzen vanuit Server Manager

U kunt aangepaste voorkeuzen maken in XF-Verifier vanuit Server Manager.

Ondersteuning voor het behouden van de maplocatie van een back-upbestand voor
overdrachtmappen

Wanneer u overdrachtmappen herstelt vanuit een back-upbestand, kunt u nu de oorspronkelijke maplocaties
van het back-upbestand behouden.

EFI IQ-webtoepassingen

U kunt EFI IQ-webtoepassingen registreren vanaf het startscherm van Command WorkStation. EFI IQ-
webtoepassingen maken uw afdrukproductie inzichtelijker met krachtige afdrukanalyses.

Bijgewerkte systeemvereisten

Ondersteunde versies

Fiery Command WorkStation ondersteunt de volgende besturingssystemen voor uw computer:

• macOS 11 (alleen met Intel-processors)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10, 64-bits

• Windows Server 2019, 64-bits

• Windows Server 2016, 64-bits

• Windows 8.1, 64-bits

• Windows 7, 64-bits

• Windows Server 2012 R2, 64-bits

• Windows Server 2008 R2, 64-bits
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Beëindigde ondersteuning

• OS X 10.11

• macOS 10.12

• System 10 en ouder

Wanneer u Fiery Command WorkStation bijwerkt naar versie 6.5, worden alle eerder toegevoegde System 10-
servers uit de serverlijst verwijderd. Als u probeert in te loggen op een Fiery server met Systeem 10 of ouder,
kunt u deze server niet gebruiken omdat alleen een Fiery server met FS100 of nieuwer wordt ondersteund.

64-bits toepassing

Fiery Command WorkStation 6.5 (CWS) is een systeemeigen 64-bits applicatie voor zowel macOS- als
Windows-platforms.
32-bits besturingssystemen worden niet ondersteund voor CWS 6.5. Als Fiery Software Manager al wordt
uitgevoerd op een 32-bits besturingssysteem zoals Windows 7 32-bit, worden de updatemeldingen voor het
CWS 6.5-pakket niet weergegeven. Als u deze versie van Fiery Software Manager op een 32-bits
besturingssysteem probeert te installeren, ziet u een compatibiliteitsfout en werkt Fiery Software Manager niet.
Raadpleeg http://fiery.efi.com/cws-specifications voor meer informatie over ondersteunde besturingssystemen.

Ondersteuning voor Adobe Acrobat DC-abonnement voor gebruik met Fiery Impose, Fiery
Compose of Fiery JobMaster

Fiery Command WorkStation Package v6.5.0.292 ondersteunt het gebruik van particuliere/persoonlijke
abonnementen op Acrobat DC die zijn geïnstalleerd op een clientcomputer, voor gebruik met Fiery Impose,
Fiery Compose of Fiery JobMaster.

Opmerking: Als u Acrobat binnen Fiery Impose, Fiery Compose of Fiery JobMaster wilt gebruiken, moet u
slechts één exemplaar van Acrobat DC installeren op de clientcomputer. Zorg er daarnaast voor dat er geen
andere versies van Acrobat op dezelfde clientcomputer zijn geïnstalleerd.

Bekende problemen

Leesweergave

In Fiery Impose, Fiery Compose, Fiery JobMaster of Fiery Preview is de Leesweergave verwijderd op macOS 11
en hoger.

ImageEnhance Visual Editor

Wanneer u het venster ImageEnhance Visual Editor op macOS 11 maximaliseert, kan het zijn dat de monitor
een paar seconden knippert.

Conversie van PS naar PDF

Wanneer u macOS 10.14.5 en hoger met Fiery Impose, Fiery Compose of Fiery JobMaster gebruikt, wordt u
mogelijk gevraagd om Fiery Command WorkStation toegang te verlenen tot Acrobat Distiller. Deze
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toestemming is nodig voor de conversie van PS-bestanden naar PDF. Als u geen toestemming verleent, zijn de
conversies niet succesvol en moet u de beveiligingsfunctie Automation in macOS wijzigen.

1 Sluit alle Fiery-toepassingen.

2 Sluit Acrobat Distiller.

3 Ga naar Systeemvoorkeuren > Beveiliging en privacy > Privacy > Automation.

4 Klik op het slotje linksonder in de hoek en voer uw wachtwoord in.

5 Zoek Fiery Command WorkStation.app in de Apps-lijst.

6 Selecteer de optie Acrobat Distiller.app.
Dit geeft Fiery Command WorkStation toegang tot Acrobat Distiller.

Informatie over macOS 10.15 (Catalina)

Fiery-voorbeeld, Fiery Impose, Fiery Compose of Fiery JobMaster op macOS 10.15

Pakket met PDF-ondersteuningstoepassingen

Het pakket met PDF-ondersteuningstoepassingen (geleverd door EFI) bestaat uit Adobe Acrobat en Enfocus
PitStop en is niet compatibel met macOS 10.15 (Catalina). Voer geen upgrade uit naar macOS 10.15 als u
Acrobat en/of PitStop gebruikt. Voor nieuwe installaties werkt het installatieprogramma voor PDF-
ondersteuningstoepassingen niet.
Bij gebruik van het huidige pakket van PDF-ondersteuningstoepassingen kan het uitvoeren van een upgrade naar
macOS 10.15 leiden tot de volgende problemen:

• Acrobat DC zal normaal functioneren als dit al is geïnstalleerd voordat u een upgrade uitvoert naar macOS
10.15. Het Acrobat DC-installatieprogramma is echter niet compatibel met macOS 10.15, zodat nieuwe
installatie van Acrobat DC niet mogelijk is. Bovendien wordt de meegeleverde Enfocus PitStop niet
ondersteund op macOS 10.15.

• Acrobat XI zal niet functioneren als dit al is geïnstalleerd voordat u een upgrade uitvoert naar macOS 10.15
en wordt hierdoor niet ondersteund. We raden u aan Acrobat XI te verwijderen voordat u de upgrade naar
macOS 10.15 uitvoert. Het Acrobat XI-deïnstallatieprogramma werkt niet op macOS 10.15, dus als u een
upgrade uitvoert naar macOS 10.15 terwijl Acrobat XI nog is geïnstalleerd, zal Acrobat XI niet werken en
kan dit ook niet worden verwijderd.

Als er geen compatibele versie van Acrobat is geïnstalleerd, zijn de volgende problemen mogelijk:

• De functie Bewerken in Acrobat is niet beschikbaar in Fiery Impose, Fiery Compose en Fiery JobMaster.

• Bij het openen van een PostScript-taak met Fiery-voorbeeld kan Fiery Impose, Fiery Compose of Fiery
JobMaster een fout veroorzaken.

• Fiery Impose-sjablonen die de workflows Door gebruiker ingesteld afwerkformaat of Op basis van snijkader
gebruiken, werken mogelijk niet goed bij PostScript-taken.

• Fiery Hot Folders biedt niet de mogelijkheid om PostScript-bestanden om te zetten naar PDF.
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Overige problemen

Na het bijwerken van een oudere macOS-versie naar macOS 10.15 kan Fiery Impose, Fiery Compose of Fiery
JobMaster een van de volgende berichten veroorzaken bij het opstarten van Fiery-voorbeeld:

• "ICUConverter. framework" zal uw computer beschadigen. Verplaats het naar de prullenmand.

• "ICUData.framework" zal uw computer beschadigen. Verplaats het naar de prullenmand.

macOS 10.15 identificeert deze bestanden ten onrechte als malware. U kunt deze problemen oplossen door Fiery
Command WorkStation Package versie 6.4.0.358 of hoger opnieuw te installeren. Deze versie is compatibel met
macOS 10.15.
Wanneer u in Fiery-voorbeeld met de muis over bedieningsknoppen Fiery Impose, Fiery Compose of Fiery
JobMaster beweegt, wordt de knopinfo niet weergegeven.

Volledige schijftoegang

Als gevolg van wijzigingen in de manier waarop macOS 10.15 de beveiliging beheert, zijn er nu extra stappen
nodig om Fiery-toepassingen goed te laten werken.
U moet wijzigingen aanbrengen in de beveiligingsfunctie Volledige schijftoegang in macOS, zodat Fiery-
toepassingen updates kunnen beheren en toegang hebben tot bestanden zoals Impose-sjablonen en
overdrachtmappen. Volledige schijftoegang inschakelen voor Fiery-toepassingen zoals Fiery Command
WorkStation.

1 Sluit alle Fiery-toepassingen.

2 Ga naar Systeemvoorkeuren > Beveiliging en privacy > Privacy > Volledige schijftoegang.

3 Klik op het slotje linksonder in de hoek en voer uw wachtwoord in.

4 Klik op de +-knop.

5 Selecteer Fiery Software Manager en de Fiery Software Uninstaller in de map Toepassingen en klik
vervolgens op Openen.
Voor deze toepassingen hebt u volledige schijftoegang nodig om Fiery-toepassingen op uw computer te
kunnen onderhouden en bijwerken.

6 Selecteer de Fiery Command WorkStation-toepassing in de map Toepassingen en klik op Openen.

7 Als u Fiery Hot Folders of Fiery Remote Scan gebruikt, selecteert u elke toepassing en klikt u op Openen.
Wanneer Fiery Hot Folders detecteert dat de mappen Documenten, Bureaublad en Downloads in gebruik
zijn, wordt er een bericht weergegeven waarin volledige schijftoegang wordt gevraagd. Zelfs nadat toegang is
verleend, wordt dit bericht nog steeds weergegeven. U kunt dit bericht negeren en doorgaan met werken.

Browserfouten Safari in macOS 10.15

Als u Safari gebruikt op macOS 10.15, zult u terugkerende browserfouten tegenkomen wanneer u de volgende
pagina's probeert te openen vanaf Fiery Command WorkStation Apparaatcentrum > Algemeen >
Gereedschappen:

• Fiery-systeem herstellen

• Fiery-systeemkopie

• Fiery-hulpbronnen en -instellingen

Deze fouten kunnen ook optreden wanneer u Fiery WebTools opent in de Safari-browser.
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Gebruik Chrome of Firefox om deze pagina's te openen.

Fiery XF op macOS 10.15

Als u Fiery XF op macOS 10.15 gebruikt, moet u een upgrade van Fiery Color Profiler Suite naar versie 5.3.1
uitvoeren. Met Fiery Color Profiler Suite versie 5.3.1 is de met macOS 10.15 compatibele Fiery Verify nu
beschikbaar voor Fiery XF-gebruikers als de standaard verificatietoepassing.
Color Verifier is niet compatibel met macOS 10.15, maar wordt nog steeds ondersteund op oudere versies van
macOS. U moet de Color Verifier echter wel afzonderlijk installeren. Download Color Verifier voor macOS
10.14 en eerdere versies vanuit het Downloadcentrum.

Fiery Color Profiler Suite en Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) en eerdere versies zijn niet volledig compatibel met Fiery Command
WorkStation-pakket 6.5 (CWS) voor cut-sheetprinters. Wij raden u aan de update naar Fiery Color Profiler
Suite 5.1 uit te voeren.
Wanneer u CPS 5.0 gebruikt met CWS 6.5, kunt u de volgende problemen ondervinden:

• Als u het bericht "Connect the spectrophotometer to your computer" (Sluit de spectrofotometer aan op uw
computer) in CWS ziet terwijl CPS is geopend, sluit CPS dan en klik op OK om door te gaan.

• Nadat u een nieuwe kalibratie-instelling hebt gemaakt in Calibrator, is de knop Nieuw profiel maken om CPS
te starten, verborgen. Dit probleem is opgelost na het upgraden naar CPS 5.1.

Optie Bewerken in Acrobat van Fiery Impose, Fiery Compose of Fiery JobMaster opent twee
Acrobat-vensters

Wanneer op Windows-computers de optie Bewerken in Acrobat wordt geselecteerd vanuit Fiery Impose, Fiery
Composeof Fiery JobMaster, kan Acrobat in twee vensters worden geopend in plaats van in één. Dit is een
bekend probleem. U kunt het Adobe Acrobat-venster sluiten en doorgaan met werken in het venster met de
PDF.

Voorkeuren instellen in Adobe Acrobat Distiller voor conversie van PostScript naar PDF

Fiery Impose, Fiery Compose en Fiery JobMaster vereisen dat Acrobat Distiller PostScript-bestanden (PS-
bestanden) naar PDF converteert op een clientcomputer.
Vanwege verbeterde beveiligingsinstellingen in Acrobat Distiller moet u bevestigen dat het te converteren PS-
bestand afkomstig is van een betrouwbare bron in: Acrobat Distiller > Bestand > Voorkeuren > Voorkeuren -
Acrobat Distiller, selecteer Alle bestanden vertrouwen die via Acrobat Distiller zijn geopend onder Beveiliging.

Opmerking: Als Alle bestanden vertrouwen die via Acrobat Distiller zijn geopend niet is geselecteerd, wordt u
gevraagd te bevestigen dat het bestand afkomstig is van een betrouwbare bron voor alle naar PDF te converteren
PS-bestanden. Dit geldt ook voor Overdrachtsmappen wanneer het filter voor Microsoft Office is geselecteerd,
het Uitvoerbestandstype is opgegeven als PDF en een joboptions-bestand wordt geselecteerd als Distiller-profiel.
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Kan Configure niet starten vanaf een macOS-computer

Op een Fiery server met FS100-systeem kunt u Configure niet starten vanuit deze versies van het
besturingssysteem:

• macOS 10.14.6 en latere versies van 10.14

• macOS 10.15 (alle versies)

Als u verbinding wilt maken met Fiery Command WorkStation, gebruik dan een macOS-computer met een
oudere versie van macOS of een Windows-computer.

Vertraging bij het starten van Fiery Impose, Fiery Compose of Fiery JobMaster

Het starten van Fiery Impose, Fiery Compose en Fiery JobMaster kan langer duren dan in oudere versies. Om
een van deze toepassingen sneller te openen, start u eerst Fiery Preview en vervolgens de toepassing die u wilt
gebruiken.

Problemen opgelost in Fiery Command WorkStation Package v6.5.0.599

Fiery Command WorkStation

• De meetresultaten met de ES-3000-spectrofotometer waren niet nauwkeurig.

Opgeloste problemen in Fiery Command WorkStation Package v6.5.0.581

Fiery Command WorkStation

• Wanneer u de TIFF-invoerindeling gebruikte in Fiery Hot Folders, werden de positioneringsinstellingen voor
afbeeldingen bij een aantal talen niet correct toegepast.

• Fiery Command WorkStation Package 6.5 ondersteunt Windows 10 versie 20H2.

Fiery XF

• Wanneer u een Fiery XF-server toevoegt waarop de voorkeursinstelling Wachtwoord opslaan is ingeschakeld en
u de Fiery XF-server opnieuw opstart, wordt Fiery Command WorkStation Package niet correct gestart.

Problemen opgelost in Fiery Command WorkStation Package v6.5.0.563

Fiery Command WorkStation

• Op een Japanstalig systeem wordt Fiery Spot Pro niet geopend wanneer u inlogt met een nieuw aangemaakte
beheerdersaccount.

Fiery XF

• In het Fiery Command WorkStation-taakcentrum meldt de Taakstatus-kolom dat de verificatie niet gelukt is,
zelfs als de taak alle tests in Fiery Verifyheeft doorstaan.

• In het Fiery Command WorkStation-taakcentrum, als de status van een geneste taak Te verifiëren was, startte
Fiery Verify niet op als u op Verifiëren klikte in het deelvenster Taakoverzicht van de bovenliggende taak. Fiery
Verify wordt geopend als u in het deelvenster Taakoverzicht van een onderliggende taak op Optimaliseren of
Details klikt.
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Opgeloste problemen in Fiery Command WorkStation Package v6.5.0.539

Fiery Command WorkStation

• Nadat u een PPML-taak met een 4 per vel-sjabloon had ingeslagen en verwerkt, werden sommige pagina's van de
taak niet weergegeven in Fiery ImageViewer.

Fiery XF

• U kon geen waarde groter dan 59,4 cm opgeven voor de aangepaste breedte-instelling in Command WorkStation
Server Manager > Opmaak > Stap en herhalen > Patroon.

Problemen opgelost in Fiery Command WorkStation Package v6.5.0.512

Fiery Command WorkStation

• Wanneer u op een Japanstalig systeem een taak afdrukt die is bewerkt met Fiery ImageViewer, reageerde de Fiery
server niet meer.

• De weergave van bewerkingsvakken van een taak in lijnweergave in Fiery Impose is nu uitgelijnd met de lijnen.

Fiery XF

• Als u de medianaam wijzigde of een kalibratiebestand (*.EPL) koppelde aan een mediaprofiel met een andere
naam in Color Tools > Profielen verbinden, werd de compatibele printerinformatie verwijderd uit het
kalibratiebestand (*.EPL).

• U kon de instelling voor Lijmgebied niet opslaan in Job Editor > Overlapping/lijm.

• XF 7.2 ondersteunt de meetinstrumenten i1Pro3 en EFI ES-3000 op macOS-computers.

Problemen opgelost in Fiery Command WorkStation Package v6.5.0.475

Fiery Command WorkStation

• In Fiery Spot Pro kunt u nu de scheidingswaarden voor steunkleuren en vervangende kleuren opgeven tot één
decimaal.

• In Fiery Spot Pro is de optie Standaard herstellen nu uitgeschakeld voor steunkleuren in een gedupliceerde
groep.

• U kunt Adobe Acrobat Pro 2017 en Enfocus PitStop Edit 2019 opnieuw installeren en activeren vanuit Fiery
Software Manager.

Fiery XF

• Bij VUTEk-rol-tot-rol-grootformaatprinters veranderde de afdrukmodusinstelling in Speciale instellingen >
Afdrukken met witte inkt altijd terug naar steunkleur WHITE_INK.

• Als de systeemtaal van de Fiery server was ingesteld op Pools, herkende de Cut Server-toepassing geen nesttaken.
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Opgeloste problemen in Fiery Command WorkStation Package v6.5.0.433

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 ondersteunt Windows 10 versie 2004.

• Wanneer u een boekje-taak hebt afgedrukt met een Fiery Impose-sjabloon die is opgeslagen als voorkeuze, werd
de instelling voor omslagmedia soms niet toegepast.

• Af en toe kon u Fiery Impose, Fiery Compose of Fiery JobMaster niet opstarten omdat een onjuist foutbericht
werd weergegeven met de melding dat de toepassing al is geopend. Dit probleem is opgelost.

• Wanneer u meerdere licenties had geactiveerd, kon u met Fiery-systeem herstellen de Licentieactiveringscodes
(LACs) niet herstellen tijdens het herstellen van een Fiery server. Dit probleem is opgelost.

Fiery XF

• Een systeemgebruikersnaam met spaties of speciale tekens zorgde ervoor dat Job Editor taakvoorbeelden niet
weergaf.

• Op een Italiaanstalig systeem stopte Job Editor met reageren, nadat u Fiery Command WorkStation 6.5 naar de
nieuwste versie had bijgewerkt.

Problemen opgelost in Fiery Command WorkStation Package v6.5.0.367

Fiery Command WorkStation

• In sommige talen werd tekst die op tabbladen was geplaatst met Fiery Compose of Fiery JobMaster juist
weergegeven op de computer, maar deze tekst werd niet weergegeven wanneer de tabbladen werden afgedrukt.

• Wanneer PDF-formulieren met ingevoerde gegevens in de formuliervelden waren opgeslagen vanuit Fiery
Compose of Fiery JobMaster, werden de formuliervelden niet weergegeven in Voorbeeld of in de afgedrukte
uitvoer.

• U kon een kalibratieset niet opnieuw kalibreren met een aangepast papierformaat van 241 x 330 mm als u het
papierformaat had gewijzigd van 241 x 330 mm naar 13 x 19 inch.

• U kon een kalibratiepagina niet meten als u een spectrofotometer op een computer had aangesloten na het
afdrukken van de kalibratiepagina.

Fiery XF

• Op sommige Windows-platforms kon Job Editor geen voorbeeld van taken weergeven.

Problemen opgelost in Fiery Command WorkStation Package v6.5.0.292

Fiery Command WorkStation

• Het lettertype Arial werd cursief weergegeven op bepaalde Windows-computers nadat u de Fiery Command
WorkStation Package 6.5 had geïnstalleerd.

• De standaardinstellingen die u hebt opgegeven met de functie Standaardwaarden instellen, zijn niet toegepast op
de wachtrij voor op volgorde afdrukken.
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• Als u in Fiery JobMaster pagina's van een PDF-taak met bladwijzers invoegde of verwijderde tijdens het invoegen
van tabbladen of blanco vellen, verschoven de bladwijzers naar andere pagina's.

• Af en toe genereerden macOS-computers met een niet-Engelstalig besturingssysteem beschadigde IT8-
meetgegevens.

Fiery XF

• In Color Tools > Kalibratie maken > Grijsbalans, de delta E-waarden veranderden telkens wanneer u een
opgeslagen EPL-bestand opende

• Als de systeemtaal van de Fiery server is ingesteld op Pools, herkent de Cut Server-toepassing geen geneste taken.

• Wanneer u de Fiery XF server opnieuw kalibreerde, werd de standaard Workflow die u in het venster Server
Manager hebt ingesteld, niet toegepast.

Opgelost probleem in Fiery Command WorkStation Package v6.5.0.171 SP1

• Wanneer u de actie Media toewijzen in Fiery Impose gebruikte, verscheen er een waarschuwingsbericht over een
onjuist sRGB-profiel.

Opgeloste problemen in Fiery Command WorkStation Package v6.5.0.171

Fiery XF

• Kan geen basislijn aanmaken voor de EPSON SC-P75x0/SC-P95x0 RGB

• Kan het afdrukken van etiketten niet selecteren voor de EPSON SC-P75x0 en SC-P95x0

• Kan de EPSON 9500 niet kalibreren met 44-inch-media
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客户发行说明
Fiery Command WorkStation Package，v6.5

本文档包含关于此版本的重要信息。请确保先为所有用户提供这些信息，然后再继续安装。

关于此版本

此版本包含以下应用：

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• 适用于 Mac 4.1.0.21 的 Fiery Hot Folders

• 适用于 Windows 4.1.0.21 的 Fiery Hot Folders

• Fiery Software Manager v4.4.0.18

正在升级

此安装程序将任何现有 Fiery Command WorkStation Package 升级至包含 Fiery Command WorkStation 和
Fiery Hot Folders 的最新软件包。您也可以选择使用 Fiery Software Manager 安装 Fiery Remote Scan。

Fiery Command WorkStation Package 支持运行 FS100 及更高版本，Fiery proServer 和 Fiery XF 7.0 及更
高版本的 Fiery servers。它无法连接至：

• 运行 Fiery System 9/9e Rel2 和 System 10 软件和以前的版本的 Fiery servers

• Fiery XF 6.x 服务器和更早版本

• Fiery Central 服务器

如果您需要访问这些产品，请勿进行升级。Fiery Extended Applications 程序包仍可从 www.efi.com/cws 上
获取。有关受支持单页纸打印机的完整列表，请参见 http://fiery.efi.com/CWS/supported-printers。

有关技术规格方面的更多信息，请参见 www.efi.com/cws。

新功能

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


新功能

有关在 6.5 初始版本中新增功能的信息，请访问 http://fiery.efi.com/CWS/Whats-New。

有关在 6.5 初始版本后新增功能的信息，请参阅以下信息。

Fiery Spot Pro

Fiery Command WorkStation 6.5 允许您使用 Fiery Spot Pro 管理专色，它代替 Fiery Spot-On。有关
改进的完整列表，请参阅 https://www.efi.com/spotpro。

Fiery Spot Pro 可用于具有以下要求的选定服务器：

• FS200 Pro 和更新的软件

• Fiery Graphic Arts Package, Premium Edition

要了解更多信息，请访问 http://fiery.efi.com/spotpro/supported-printers。

如果您的 Fiery server 未启用 Fiery Spot Pro，Fiery Command WorkStation 将继续支持 Fiery Spot-
On。

使用 Fiery Spot Pro 的注意事项

• 不要在任何专色名称中使用 "@" 符号。

• 启动 Spot Pro 后，请在使用搜索功能之前等待大约 60-120 秒，或者切换输出特性档。

• 在几次重新执行后优化专色可能会导致原始专色和已转换的专色之间出现更明显的差异。

• 转换后的 L*a*b* 值和设备 CMYK 值的数值略有四舍五入。

• 如果两个用户都执行编辑操作，则在连接到相同的 Fiery server 的不同用户系统上的两个 Spot Pro
实例会导致错误。

支持 EFI ES-3000

新版 EFI ES-3000 测量仪器由 Fiery Command WorkStation 6.5 中的 EFI ES-2000 仿真支持。EFI
ES-3000 是 EFI ES-2000 的升级版且在测量模式 M1 和 M2 中支持单扫描测量。您可以利用 Fiery
Command WorkStation 的 Fiery Calibrator、Fiery Spot Pro 和纸张模拟功能使用 EFI ES-3000 仪器
（通过在用户界面中选择 “EFI ES-2000” 条目）。

注释：ES-2000-仿真（用户界面中的 “EFI ES-2000” 条目）也可以与 EFI ES-2000 一起使用。

有关结合不同应用程序使用 EFI ES-3000 的信息，请参阅相关应用程序随附的文档。

Fiery Option Package license notifications

有关可用服务器更新的通知现列在 Fiery Command WorkStation 中的新“通知”部分下。当已安装 Fiery
选项的许可证接近其有效期或过期时，将显示通知。通知显示在 Fiery Command WorkStation、Fiery Hot
Folders 和 Fiery WebTools 中。

注释：您可以随时查看许可证过期信息。 WebTools > 主页以及 Fiery Command WorkStation > 设备中心
> 常规 > 一般信息.
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过期通知提供以下选项：

• 立即续订

• 解除

• 了解详情

支持 Fiery JobExpert 报告

Fiery Command WorkStation 6.5 连接到 FS400 服务器，让您可以预览使用 Fiery JobExpert 对作业所
做的增强。

Fiery JobExpert 报告概述了使用 Fiery JobExpert 应用于作业的建议作业属性设定。

支持 Adobe Acrobat Pro 2017 和 Enfocus PitStop Edit 2019

Adobe Acrobat Pro 2017 和 Enfocus PitStop Edit 2019 选项可从 Fiery Software Manager 下载 。

Fiery XF Color Editor 中测量仪器的支持

支持的单个色块和优化测量仪器如下：

测量仪器 单个色块 优化

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

支持可变浅墨水端点

Fiery XF 允许您设置浅墨水端点以在校准文件上保存浅色墨水。

要创建节省墨水的校准文件，请通过更改 Color Tools 的墨水限制和校准标签中浅墨水端点值减少浅墨水
量。

支持 1617 (CGATS IT8.7/5) 色块布局

Fiery XF 支持具有 1617 色块的颜色工具中的分析图表。

1617 目标是将标准 IT8.7/4 目标中的唯一色块值与 P2P51 目标的第 4 列和第 5 列中的所有色块值组合
在一起的 CMYK 打印机特征目标。

支持从 Server Manager 创建 Verifier 自定义预设

您可以在 Server Manager 的 XF-Verifier 中创建自定义预设。
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支持保留热文件夹备份文件的文件夹位置

现在从备份文件还原热文件夹时，可以保留备份文件的原始文件夹位置。

EFI IQ 网络应用程序

您可以通过 Command WorkStation 的主屏幕注册 EFI IQ 网络应用程序。EFI IQ 网络应用程序通过强大
的打印分析让您的打印生产更加具有可见性。

系统要求更新呢

支持的版本

Fiery Command WorkStation 支持计算机的以下操作系统：

• macOS 11（仅搭载 Intel 处理器）

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10，64 位

• Windows Server 2019，64 位

• Windows Server 2016，64 位

• Windows 8.1，64 位

• Windows 7，64 位

• Windows Server 2012 R2，64 位

• Windows Server 2008 R2，64 位

停止支持

• macOS 10.11

• macOS 10.12

• System 10 及更早版本

更新 Fiery Command WorkStation 到版本 6.5 时，将从服务器列表中删除以前添加的所有 System 10 服
务器。如果尝试登录到运行 System 10 或更早版本的 Fiery server，则阻止使用此服务器，因为仅支持
运行 FS100 及更高版本的 Fiery server。

64 位应用程序

Fiery Command WorkStation 6.5 (CWS) 是用于 macOS 和 Windows 平台的原生 64 位应用。

CWS 6.5 不支持 32 位操作系统。如果已在 Windows 7 32 位等 32 位操作系统上运行 Fiery Software
Manager，则不会显示 CWS6.5 软件包的更新通知。如果尝试在 32 位操作系统上运行 Fiery Software
Manager 的这个版本，则您将看到兼容性错误，Fiery Software Manager 不会运行。要查看受支持的操作
系统，请参阅 http://fiery.efi.com/cws-specifications。

客户发行说明

Fiery Command WorkStation Package，v6.5

87

http://fiery.efi.com/cws-specifications


支持 Adobe Acrobat DC 订阅与 Fiery Impose、Fiery Compose 或 Fiery JobMaster 配合使用

Fiery Command WorkStation Package 版本 6.5.0.292 支持使用客户端计算机上安装的 Acrobat DC（个
人拥有/个人订阅）与 Fiery Impose、 Fiery Compose 或 Fiery JobMaster 配合使用。

注释：要在 Fiery Impose、Fiery Compose 或 Fiery JobMaster 中使用 Acrobat，您必须在客户端计算
机上仅安装一个 Acrobat DC 实例。另外，确保其他 Acrobat 版本未安装在同一台客户端计算机上。

已知问题

阅读器视图

在 macOS 11 和更高版本上，Fiery Impose、Fiery Compose、Fiery JobMaster 或 Fiery Preview 中的
阅读器视图已移除。

ImageEnhance Visual Editor

当您在 macOS 11 上最大化 ImageEnhance Visual Editor 窗口时，显示屏可能会闪烁几秒钟。

PS 到 PDF 转换

当您使用 macOS 10.14.5 及更高版本上使用 Fiery Impose、Fiery Compose 或 Fiery JobMaster 时，可
能会提示您允许 Fiery Command WorkStation 访问 Acrobat Distiller。此权限是 PS 文件转换为 PDF
所必需的。如果不授予权限，转换将不会成功，您需要更改 macOS 中的自动化安全功能。

1 关闭所有 Fiery 应用程序。

2 关闭 Acrobat Distiller。

3 转至 系统偏好设置 > 安全与隐私 > 隐私 > 自动化.

4 单击左下角的“锁定”图标并输入密码。

5 在“应用”列表中，找到 Fiery Command WorkStation.app。

6 选择 Acrobat Distiller.app 选项。
这允许 Fiery Command WorkStation 访问 Acrobat Distiller。

macOS 10.15 (Catalina) 信息

macOS 10.15 上的 Fiery Preview、Fiery Impose、Fiery Compose 或 Fiery JobMaster

PDF 支持应用程序套件

PDF 支持应用程序套件（由 EFI 提供）包含 Adobe Acrobat 和 Enfocus PitStop，与 macOS 10.15
(Catalina) 不兼容。如果您使用 Acrobat 和/或 PitStop，请勿升级至 macOS 10.15。对于新的安装，
PDF 支持应用程序安装程序不会运行。
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使用当前 PDF 支持应用程序套件时升级至 macOS 10.15 可能导致以下问题：

• 如果升级至 macOS 10.15 前安装了 Acrobat DC，它将正常运行。但是，Acrobat DC 安装程序与
macOS 10.15 不兼容，因此 Acrobat DC 无法进行新安装。另外，macOS 10.15 不支持包含的 Enfocus
PitStop。

• 如果升级至 macOS 10.15 前安装了 Acrobat XI，它将无法运行，也不支持 macOS 10.15。我们建议在
升级至 macOS 10.15 前卸载 Acrobat XI。Acrobat XI 卸载程序在 macOS 10.15 上无法运行，因此如
果您在安装了 Acrobat XI 情况下升级到 macOS 10.15，则系统将处于 Acrobat XI 无法运行且无法卸
载的状态。

如果未安装兼容版 Acrobat，则会出现以下问题：

• 在 Acrobat 中编辑功能在 Fiery Impose、Fiery Compose 和 Fiery JobMaster 中不可用。

• 用 Fiery Preview、Fiery Impose、Fiery Compose 或 Fiery JobMaster 打开 PostScript 作业可能
导致错误。

• 使用用户定义的成品尺寸工作流程或基于裁边框的 Fiery Impose 模板无法通过 PostScript 作业正常
运行。

• Fiery Hot Folders 不提供将 PostScript 文件转换为 PDF 的选项。

其他问题

从旧版 macOS 升级至 macOS 10.15 后，启动 Fiery Preview、Fiery Impose、Fiery Compose 或 Fiery
JobMaster 可能会显示以下任一消息：

• “ICUConverter.framework”会损坏您的计算机。您应该将其移至回收站。

• “ICUData.framework”会损坏您的计算机。您应该将其移至回收站。

macOS 10.15 将这些文件错误识别为恶意软件。要解决这些问题，请重新安装与 macOS 10.15 兼容的
Fiery Command WorkStation Package 版本 6.4.0.396 或更高版本。

当您将鼠标悬停在 Fiery Preview、Fiery Impose、Fiery Compose 或 Fiery JobMaster 中的任何控件图
标按钮上方时，不显示工具提示。

完全磁盘访问权限

由于 macOS 10.15 管理安全的方式改变，现在还需要额外的步骤才能让 Fiery 应用程序正常运行。
您需要改变 macOS 中的完全磁盘访问权限安全功能，Fiery 应用程序才能够管理更新和访问文件，如
Impose 模板和热文件夹。为 Fiery 应用程序如 Fiery Command WorkStation 启用完整磁盘访问。

1 关闭所有 Fiery 应用程序。

2 转至 系统偏好设置 > 安全与隐私 > 隐私 > 完全磁盘访问权限.

3 单击左下角的“锁定”图标并输入密码。

4 单击 + 按钮。

5 在应用程序文件夹中，选择 Fiery Software Manager 和 Fiery Software Uninstaller 并单击打开。

这些应用程序需要完全磁盘访问权限才能维护和更新计算机上的 Fiery 应用程序。

6 在应用程序文件夹中，选择 Fiery Command WorkStation 应用程序并单击打开。

7 如果您使用 Fiery Hot Folders 或 Fiery Remote Scan，选择每个应用程序并单击打开。

当 Fiery Hot Folders 检测到“文档”、“桌面”和“下载”文件夹正在使用时，会发出信息，请求
获得完全磁盘访问权限。即使授予访问权限后，此消息仍会显示。您可以消除此消息并继续工作。
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MacOS 10.15 上的 Safari 浏览器错误

如果您在 macOS 10.15 上使用 Safari，则在尝试打开以下网页时会遇到重复的浏览器错误 Fiery Command
WorkStation 设备中心 > 常规 > 工具:

• Fiery 系统还原

• Fiery 系统镜像

• Fiery 资源和设定

在 Safari 浏览器中打开 Fiery WebTools 时也会出现这些错误。

使用 Chrome 或 Firefox 访问这些网页。

macOS 10.15 上的 Fiery XF

如果您在 macOS 10.15 上使用 Fiery XF，则需要将 Fiery Color Profiler Suite 升级到版本 5.3.1。
Fiery XF 用户现在可以使用 Fiery Color Profiler Suite 版本 5.3.1，将兼容 macOS 10.15 的 Fiery
Verify 作为默认的验证应用。

Color Verifier 不兼容 macOS 10.15，但仍支持较早的 macOS 版本。但是您需要单独安装 Color
Verifier。从下载中心下载适用于 macOS 10.14 和更早版本的 Color Verifier。

Fiery Color Profiler Suite 和 Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) 和更早版本与适用于单张纸打印机的 Fiery Command
WorkStation Package 6.5(CWS) 不完全兼容。我们建议更新到 Fiery Color Profiler Suite 5.1。

当您将 CPS 5.0 与 CWS 6.5 搭配使用时，可能会遇到以下问题：

• 在 CPS 打开的情况下，如果在 CWS 中看到“将分光光度计连接到计算机”的消息，请关闭 CPS，然后
单击确定以继续。

• 在 Calibrator 中创建新的校准设定后，启动 CPS 的创建新的设定档按钮将隐藏。升级到 CPS 5.1 后
即可解决此问题。

从 Fiery Impose、Fiery Compose 或 Fiery JobMaster 中选择在 Acrobat 中编辑选项会打开两个

Acrobat 窗口

在 Windows 计算机上，当在 Fiery Impose、Fiery Compose 或 Fiery JobMaster 中选择在 Acrobat 中
编辑选项时，Acrobat 可能会在两个窗口打开，而非一个。这是已知的问题。您可以关闭 Adobe Acrobat
窗口并继续使用 PDF 所在窗口工作。

在 Adobe Acrobat Distiller 中设置 PDF 转换的 PostScript 首选项

Fiery Impose、Fiery Compose 和 Fiery JobMaster 要求 Acrobat Distiller 将 PostScript (PS) 文件
转换为客户端计算机上的 PDF。

由于 Acrobat Distiller 中增强的安全设定，您必须确认要转换的 PS 文件来自以下可信来源： Acrobat
Distiller > 文件 > 首选项 > 首选项 - Acrobat Distiller，请在安全下选择信任所有通过 Acrobat
Distiller 打开的文件。

注释：如果不选择信任所有通过 Acrobat Distiller 打开的文件，系统会提示您确认每个要转换为 PDF
的 PS 文件来自可信来源。选择 Microsoft Office 筛选器，输出文件类型指定为 PDF 并选择
joboptions 文件作为 Distiller 特性档时，这也适用于 Hot Folders。
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无法从 macOS 计算机启动配置

如果 Fiery server 运行系统 FS100，则无法从这些操作系统版本启动配置：

• mac10.14.6 和更高版本的 10.14

• macOS 10.15（所有版本）

要连接到 Fiery Command WorkStation，请使用具有早期版本的 macOS 的 macOS 计算机，或使用
Windows 计算机。

启动 Fiery Impose、Fiery Compose 或 Fiery JobMaster 时有延迟

Fiery Impose、Fiery Compose 和 Fiery JobMaster 可能需要比早期版本更长的时间才能启动。要缩短打
开这些应用程序的时间，请先启动 Fiery Preview，然后启动要使用的应用程序。

在 Fiery Command WorkStation Package v6.5.0.599 中修复的问题

Fiery Command WorkStation

• ES-3000 分光光度计测量结果不准确的问题。

Fiery Command WorkStation Package v6.5.0.581 修复了以下错误

Fiery Command WorkStation

• 在 Fiery Hot Folders 中使用 TIFF 输入格式时，图像定位设定未能正确应用于某些语言。

• Fiery Command WorkStation Package 6.5 支持 20H2 版 Windows 10。

Fiery XF

• 添加 Fiery XF 服务器时选择保存密码，再重新启动 Fiery XF 服务器时，Fiery Command WorkStation
Package 无法成功启动。

修复了 Fiery Command WorkStation Package v6.5.0.563 版本中的错误

Fiery Command WorkStation

• 在日语系统中，当您使用新创建的管理员帐户登录时， Fiery Spot Pro 无法打开。

Fiery XF

• 在 Fiery Command WorkStation 作业中心中， 作业状态列报告验证未成功，即使作业通过 Fiery Verify
中的所有测试。

• 在 Fiery Command WorkStation 作业中心中，如果嵌套作业的状态是要验证，当您从父作业的作业摘要窗
格单击验证时， Fiery Verify 未启动。如果单击子作业的作业摘要窗格中的 优化或 详细信息， Fiery
Verify 会打开。
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修复了 Fiery Command WorkStation Package v6.5.0.539 版本中的错误

Fiery Command WorkStation

• 在您使用四合一模板拼版 PPML 作业并对其进行处理之后，该作业的部分页面未显示在 Fiery ImageViewer
中。

Fiery XF

• 您无法在 Command WorkStation Server Manager > 版面 > 步骤和重复 > 模式中为自定义宽度设定指定大
于 59.4 厘米的值。

修复了 Fiery Command WorkStation Packagev6.5.0.512 版本中的错误

Fiery Command WorkStation

• 在日语系统中，当您打印使用 Fiery ImageViewer 编辑的作业时，Fiery server 停止响应。

• 在 Fiery Impose 中的线框视图中显示作业的编辑框现在与线框对齐。

Fiery XF

• 如果您用与颜色工具 > 连接特性档中不同名称更改了介质特性档的介质名称或关联的校准文件 (*.EPL) ，
兼容的打印机信息从校准文件 (*.EPL) 中移除。

• 无法在 Job Editor > 重叠/粘合中保存粘合区域设定。

• XF 7.2 支持 macOS 计算机上的 X-Rite i1Pro3 和 EFI ES-3000 测量仪器。

修复了 Fiery Command WorkStation Packagev6.5.0.475 版本中的错误

Fiery Command WorkStation

• 在 Fiery Spot Pro 中，您现在可以将专色和替代色的分色值指定到小数点后一位。

• 在 Fiery Spot Pro 中，对于重复组中的专色，恢复到出厂设置选项现在已禁用。

• 您可以从 Fiery Software Manager 重新安装并激活 Adobe Acrobat Pro 2017 和 Enfocus PitStop Edit
2019。

Fiery XF

• 使用 VUTEk 的卷对卷超宽幅格式打印机，特殊设定>白色墨水打印中的打印模式设定始终更改为专色
WHITE_INK。

• Fiery server 的系统语言设置为波兰语时，剪切服务器应用无法识别嵌套作业。

修复了 Fiery Command WorkStation Packagev6.5.0.433 版本中的错误

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 支持 Windows 10 版本 2004。

• 使用保存为预设的 Fiery Impose 模板打印小册子作业时，有时不应用封页承印材料设定。
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• 有时您无法启动 Fiery Impose、Fiery Compose 或者 Fiery JobMaster 是因为错误消息表示应用已打开。
该问题已得到修复。

• 激活多个许可证后，您无法在使用 Fiery System 还原 Fiery server 时还原许可证激活码 (LACs)。该问
题已得到修复。

Fiery XF

• 系统用户名称包含空白或特殊字符导致 Job Editor 不显示作业预览。

• 在意大利语系统上，升级 Fiery Command WorkStation 6.5 到最新版本后，Job Editor 停止响应。

修复了 Fiery Command WorkStation Package v6.5.0.367 版本中的错误

Fiery Command WorkStation

• 在某些语言中，在计算机上查看时，使用 Fiery Compose 或 Fiery JobMaster 放置在标签上的文本显示正
确，但在打印标签时文本未显示。

• 当带有表单字段中输入的数据的 PDF 表单已在 Fiery Compose 或 Fiery JobMaster 中保存时，表单字段
不会显示在预览或打印输出中。

• 如果将纸张大小从 241x330 mm 更改为 13x19 英寸，则无法重新校准具有自定义纸张大小 241x330 mm 的
校准集。

• 如果在打印校准页之后将分光光度计连接到任何计算机，则无法测量校准页面。

Fiery XF

• 在某些 Windows 平台上，Job Editor 无法显示作业预览。

修复了 Fiery Command WorkStation Package 6.5.0.292 版本中的问题

Fiery Command WorkStation

• 安装 Fiery Command WorkStation Package 6.5 后，在一些 Windows 计算机上，Arial 字体显示为斜体。

• 使用“设置默认值”功能定义的默认设定不适用于“顺序打印”队列。

• 在 Fiery JobMaster 中，如果您在插入标签或空白印张时，在有书签的 PDF 作业中插入或删除了页面，书
签将移至不同的页面。

• 有时，使用非英语语言操作系统的 macOS 计算机会生成损坏的 IT8 测量数据。

Fiery XF

• 在 Color Tools > 创建校准 > 灰平衡，每次打开已保存的 EPL 文件时，delta E 值都将更改

• Fiery server 的系统语言设置为波兰语时，剪切服务器应用无法识别嵌套作业。

• 重新校准 Fiery XF 服务器时，未应用在 Server Manager 窗口中设置的默认工作流程。

Fiery Command WorkStation Package v6.5.0.171 SP1 中解决的问题

• 在 Fiery Impose 中使用分配介质操作时，会显示一条消息，警告错误的 sRGB 特性档。
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修复了 Fiery Command WorkStation Package v6.5.0.171 版本中的错误

Fiery XF

• 无法为 EPSON SC-P75x0/SC-P95x0 RGB 创建基线

• 无法为 EPSON SC-P75x0 和 SC-P95x0 选择标签打印

• 无法使用 44 英寸承印材料校准 EPSON 9500

客户发行说明

Fiery Command WorkStation Package，v6.5

94



使用上の注意
Fiery Command WorkStation Package v6.5

本書には、このリリースに関する重要な情報が含まれています。インストールを進める前に、すべてのユーザ
ーにこの情報を提供するようにしてください。

今回のリリースについて
今回のリリースには、次のアプリケーションが含まれています。

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Mac 用 Fiery Hot Folders 4.1.0.21

• Windows 用 Fiery Hot Folders 4.1.0.21

• Fiery Software Manager v4.4.0.18

アップグレード

このインストーラーは、既存の Fiery Command WorkStation Package を Fiery Command WorkStation および Fiery
Hot Folders を含む最新のパッケージにアップグレードします。オプションで、Fiery Software Manager を使用し
て Fiery Remote Scan をインストールすることもできます。

Fiery Command WorkStation Package では、FS100 以降を実行している Fiery servers、Fiery proServer、Fiery XF
7.0 以降をサポートしています。次のサーバーには接続できません。

• Fiery System 9/9e Rel2、System 10 ソフトウェアおよびそれ以前のバージョンを搭載した Fiery servers

• Fiery XF 6.x サーバーおよびそれ以前のサーバー

• Fiery Central サーバー

上記の製品にアクセスする必要がある場合は、アップグレードを行わないでください。Fiery Extended
Applications Package は、www.efi.com/cws で入手できます。サポートされているカット紙プリンターの一覧に
ついては、http://fiery.efi.com/CWS/supported-printers を参照してください。

技術仕様の詳細は、www.efi.com/cws を参照してください。

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


新機能

新機能

6.5 バージョンの初期リリースに追加された新しい機能の詳細については、http://fiery.efi.com/CWS/Whats-
New を参照してください。

6.5 バージョンの初期リリースの後に追加された新しい機能の詳細については、以下の情報を参照してく
ださい。

Fiery Spot Pro

Fiery Command WorkStation 6.5 を使用すると、Fiery Spot-On に代わる Fiery Spot Pro でスポットカラーを管
理することができます。改善点の完全なリストについては、https://www.efi.com/spotpro を参照してくださ
い。

Fiery Spot Pro は、次の要件を満たす特定のサーバーで使用できます。

• FS200 Pro 以降のソフトウェア

• Fiery Graphic Arts Package, Premium Edition

詳細については、http://fiery.efi.com/spotpro/supported-printers を参照してください。

Fiery server で Fiery Spot Pro が有効にされていない場合、Fiery Command WorkStation は引き続き Fiery
Spot-On をサポートします。

Fiery Spot Pro の使用に関する考慮事項

• スポットカラー名で「@」記号を使用しないでください。

• Spot Pro を起動した後、検索機能を使用する前または出力プロファイルを切り替える前に、約 60～120
秒お待ちください。

• 複数回繰り返した後でスポットカラーを最適化すると、元のスポットカラーと変換後のスポットカラ
ーの違いがより顕著に出る場合があります。

• 変換された L*a*b*値とデバイス CMYK 値の端数は四捨五入されます。

• 同じ Fiery server に接続されている異なるユーザーシステム上に 2 つの Spot Pro インスタンスがある
場合、両方のユーザーが編集操作を実行すると、エラーが発生することがあります。

EFI ES-3000 サポート

新しい EFI ES-3000 測定器は、Fiery Command WorkStation 6.5 の EFI ES-2000 エミュレーションを通してサ
ポートされています。EFI ES-3000 は EFI ES-2000 のアップグレードで、測定モード M1 および M2 でシン
グルスキャン測定をサポートします。EFI ES-3000 計器では（ユーザーインターフェイスの EFI ES-2000 エ
ントリを選択）、Fiery Command WorkStation の Fiery Calibrator、Fiery Spot Pro、用紙シミュレーション機能
を使用することができます。

メモ：ES-2000 エミュレーション（ユーザーインターフェイスの EFI ES-2000 エントリ）は、EFI ES-2000
と組み合わせて使用することもできます。

EFI ES-3000 を異なるアプリケーションと共に使用する場合の情報は、各アプリケーションに付属の取扱
説明書を参照してください。
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Fiery オプションパッケージのライセンス通知

Fiery Command WorkStation の新しい通知セクションに、利用可能なサーバーアップデートに関する通知が
表示されるようになりました。インストールされている Fiery オプションのライセンスが有効期限に近づ
いたり、期限切れになった場合に通知が表示されます。通知は、Fiery Command WorkStation、Fiery Hot
Folders、Fiery WebTools に表示されます。

メモ：ライセンスの有効期限情報は、次でいつでも表示できます。 WebTools > ホームおよび Fiery
Command WorkStation > デバイスセンター > 一般 > 一般情報.

有効期限通知には、次のオプションがあります。

• 今すぐ更新

• 終了

• 詳細情報

Fiery JobExpert レポートのサポート

Fiery Command WorkStation 6.5 が FS400 サーバーに接続されている場合、Fiery JobExpert を使用してジョ
ブに加えられた機能強化をプレビューすることができます。

Fiery JobExpert レポートには、Fiery JobExpert を使用してジョブに適用されるジョブのプロパティの推奨
設定の概要が記載されています。

Adobe Acrobat Pro 2017 および Enfocus PitStop Edit 2019 のサポート

Adobe Acrobat Pro 2017 および Enfocus PitStop Edit 2019 オプションは、 Fiery Software Manager からダウン
ロードすることができます。

Fiery XF Color Editor での測定器のサポート

次の 1 つのパッチおよび最適化測定器がサポートされています。

測定器 1つのパッチ 最適化

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

バリアブルライトインクエンドポイントのサポート

Fiery XF では、ライトインクエンドポイントを設定して、キャリブレーションファイルのライトインクを
保存することができます。
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インク節約キャリブレーションファイルを作成するには、Color Tools のインク制限とキャリブレーション
タブのライトインクエンドポイント値を変更して、ライトインクの量を減らします。

1617（CGATS IT 8.7/5）パッチレイアウトのサポート

Fiery XF は、1617 パッチの Color Tools のプロファイルチャートをサポートしています。

1617 ターゲットは標準の IT8.7/4 ターゲットの一意のパッチ値と、P2P51 ターゲットの 4 列と 5 列のすべ
てのパッチ値を組み合わせた CMYK プリンターのキャラクタリゼーションターゲットです。

Server Manager からの Verifier カスタムプリセットの作成をサポート

カスタムプリセットは、Server Manager から XF Verifier で作成できます。

Hot Folders バックアップファイルのフォルダーの場所を保持するためのサポート

バックアップファイルから Hot Folders を復元する場合、バックアップファイルの元のフォルダーの場所を
保持できるようになりました。

EFI IQ web アプリケーション

Command WorkStation のホーム画面から EFI IQ web アプリケーションを登録できます。EFI IQ web アプ
リケーションを使用すると、強力な印刷解析を使用して印刷プロダクションの可視性を向上させることが
できます。

システム要件のアップデート

対応バージョン

Fiery Command WorkStation は、以下のオペレーティングシステムをサポートしています。

• macOS 11（インテルプロセッサー搭載の場合のみ）

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10（64 ビット）

• Windows Server 2019（64 ビット）

• Windows Server 2016（64 ビット）

• Windows 8.1（64 ビット）

• Windows 7（64 ビット）

• Windows Server 2012 R2（64 ビット）

• Windows Server 2008 R2（64-bit）
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サポート終了

• macOS 10.11

• macOS 10.12

• System 10 以前

Fiery Command WorkStation をバージョン 6.5 にアップデートすると、以前に追加されたすべての System
10 サーバーはサーバーリストから削除されます。FS100 以降を搭載している Fiery server のみがサポート
されるため、System 10 以前を搭載している Fiery server にログインしようとしても、サーバーを使用でき
ません。

64 ビットアプリケーション

Fiery Command WorkStation 6.5（CWS）は、macOS および Windows プラットフォームの両方でネイティブ
の 64 ビットアプリケーションです。

32 ビットオペレーティングシステムは、CWS 6.5 ではサポートされていません。Fiery Software Manager が
32 ビットオペレーティングシステム（Windows 7 32 ビットなど）ですでに実行されている場合、CWS 6.5
パッケージの更新の通知が表示されません。32 ビットオペレーティングシステムに Fiery Software
Manager のこのバージョンをインストールしようとすると、互換性エラーが表示され、Fiery Software
Manager が動作しません。サポートされているオペレーティングシステムについては、http://fiery.efi.com/
cws-specifications を参照してください。

Fiery Impose、Fiery Compose または Fiery JobMaster で使用する Adobe Acrobat DC サブスクリプショ
ンのサポート

Fiery Command WorkStation Package v6.5.0.292 は、Fiery Impose、Fiery Compose、Fiery JobMaster で使用す
るクライアントコンピューターにインストールされている、Acrobat DC の個人所有/パーソナルサブスク
リプションの使用をサポートしています。

メモ：Fiery Impose、Fiery Compose または Fiery JobMaster から Acrobat を使用するには、クライアントコ
ンピューターに Acrobat DC のインスタンスを 1 つだけインストールする必要があります。さらに、他の
Acrobat バージョンが同じクライアントコンピューターにインストールされていないことを確認します。

既知の問題

リーダービュー

macOS 11 以降では、Fiery Impose、Fiery Compose、Fiery JobMaster または Fiery Preview からリーダービュ
ーが削除されました。

ImageEnhance Visual Editor

macOS 11 で ImageEnhance Visual Editor ウィンドウを最大化すると、モニターが数秒間ちらつくことがあ
ります。
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PS から PDF に変換

Fiery Impose、Fiery Compose または Fiery JobMaster と一緒に macOS 10.14.5 以降を使用している場合、Fiery
Command WorkStation の Acrobat Distiller へのアクセスを許可するように求められることがあります。こ
の権限は、PS ファイルを PDF に変換するために必要です。アクセス許可を付与しないと、正常に変換さ
れず、macOS の自動化セキュリティ機能を変更する必要があります。

1 Fiery アプリケーションをすべて終了します。

2 Acrobat Distiller を終了します。

3 システム環境設定 セキュリティ&プライバシー > プライバシー > 自動化 > に移動します。

4 左下隅のロックアイコンをクリックし、パスワードを入力します。

5 アプリリストで Fiery Command WorkStation.app を探します。

6 Acrobat Distiller.app オプションを選択します。
この操作により、Fiery Command WorkStation は Acrobat Distiller にアクセスできます。

MacOS 10.15（Catalina）に関する情報

macOS 10.15 での Fiery Preview、Fiery Impose、Fiery Compose、または Fiery JobMaster

PDF サポートアプリケーションキット

Adobe Acrobat および Enfocus PitStop で構成される PDF サポートアプリケーションキット（EFI 提供）は、
macOS 10.15（Catalina）と互換性がありません。Acrobat および/または PitStop を使用している場合は、
macOS 10.15 をアップグレードしないでください。新規インストールでは、PDF サポートアプリケーショ
ンインストーラーは実行されません。

現在の PDF サポートアプリケーションキットを使用しているときに macOS 10.15 にアップグレードする
と、次の問題が発生することがあります。

• macOS 10.15 にアップグレードする前に、Acrobat DC がすでにインストールされている場合は、正常
に動作します。ただし、Acrobat DC インストーラーは macOS 10.15 と互換性がないため、Acrobat DC
の新規インストールは行えません。また、付属の Enfocus PitStop は macOS 10.15 ではサポートされて
いません。

• macOS 10.15 にアップグレードする前に、Acrobat XI がすでにインストールされている場合、Acrobat
XI は実行されません。また、macOS 10.15 で Acrobat XI はサポートされていません。macOS 10.15 に
アップグレードする前に、Acrobat XI をアンインストールすることを推奨します。Acrobat XI のアンイ
ンストールは macOS 10.15 上で実行されないため、Acrobat XI をインストールした状態で macOS 10.15
にアップグレードすると、システムで Acrobat XI は動作せず、アンインストールできない状態になり
ます。

互換性のあるバージョンの Acrobat がインストールされていない場合は、次の問題が生じます。

• Acrobat の編集機能は、Fiery Impose、Fiery Compose、および Fiery JobMaster では使用できません。

• Fiery プレビュー、Fiery Impose、Fiery Compose または Fiery JobMaster を使用して PostScript ジョブを開
くと、エラーが発生することがあります。

• ユーザー定義の仕上がりサイズまたはトリムボックスに合わせるを使用する Fiery Impose テンプレー
トは、PostScript ジョブで正しく動作しないことがあります。

• Fiery Hot Folders では、PostScript ファイルを PDF に変換するためのオプションは提供されていません。
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その他の問題

古い macOS バージョンから macOS 10.15 にアップグレードしてから、Fiery プレビュー、Fiery Impose、
Fiery Compose または Fiery JobMaster を起動した場合、次のいずれかのメッセージが表示されることがあ
ります。

• 「ICUConverter.framework」はお使いのコンピューターに損傷を与えます。そのため、ゴミ箱に移動さ
せる必要があります。

• 「ICUData.framework」はお使いのコンピューターに損傷を与えます。そのため、ゴミ箱に移動させる
必要があります。

macOS 10.15 は、これらのファイルをマルウェアとして誤って識別します。この問題を解決するには、
macOS 10.15 と互換性のある Fiery Command WorkStation Package バージョン 6.4.0.396 以降を再インスト
ールします。

Fiery プレビュー、Fiery Impose、Fiery Compose、または Fiery JobMaster で任意のコントロールアイコンの
ボタン上にマウスを移動させても、ツールヒントは表示されません。

フルディスクアクセス

macOS 10.15 のセキュリティ管理方法が変更されたため、Fiery アプリケーションが正しく機能するには、
追加の手順を実行する必要があります。
Fiery アプリケーションでアップデートの管理、および Impose テンプレートやホットフォルダーなどでフ
ァイルにアクセスできるように、フルディスクアクセスセキュリティ機能を変更する必要があります。
Fiery Command WorkStation などの Fiery アプリケーションで、フルディスクアクセスを有効にします。

1 Fiery アプリケーションをすべて終了します。

2 次に、 システム環境設定 > セキュリティ&プライバシー > プライバシー > フルディスクアクセスへ移
動します。

3 左下隅のロックアイコンをクリックし、パスワードを入力します。

4 +ボタンをクリックします。

5 アプリケーションフォルダーで、Fiery Software Manager および Fiery Software Uninstaller を選択してか
ら、開くをクリックします。

これらのアプリケーションでは、コンピューター上で Fiery アプリケーションを維持し、アップデート
するために、フルディスクアクセスが必要です。

6 アプリケーションフォルダーで、Fiery Command WorkStation アプリケーションを選択して、開くをク
リックします。

7 Fiery Hot Folders または Fiery Remote Scan を使用する場合は、各アプリケーションを選択し、開くをク
リックします。

Fiery Hot Folders が、書類、デスクトップ、ダウンロードフォルダーが使用されていることを検出する
と、フルディスクアクセスを要求するメッセージが表示されます。このメッセージは、アクセスが許
可された後も表示されたままになります。このメッセージを無視して作業を続行できます。
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macOS 10.15 での Safari ブラウザーエラー

macOS 10.15 で Safari を使用している場合、Fiery Command WorkStation から次の Web ページを開こうとす
ると、反復的なブラウザーエラーが発生します。 デバイスセンター > 一般 > ツール：

• Fiery システム復元

• Fiery システムイメージ

• Fiery リソースおよび設定

これらのエラーは、Safari ブラウザーで Fiery WebTools を開くときにも発生することがあります。

Chrome または Firefox を使用して、これらの Web ページにアクセスします。

macOS 10.15 での Fiery XF

MacOS 10.15 で Fiery XF を使用する場合は、Fiery Color Profiler Suite をバージョン 5.3.1 にアップグレード
する必要があります。Fiery Color Profiler Suite バージョン 5.3.1 では、Fiery XF ユーザーは MacOS 10.15 準
拠の Fiery Verify を、デフォルトの検証アプリケーションとして使用できるようになりました。

Color Verifier は MacOS 10.15 に準拠していませんが、古い MacOS バージョンでは引き続きサポートされ
ています。ただし、Color Verifier を別途インストールする必要があります。MacOS 10.14 以前のバージョ
ンには、Color Verifier をダウンロードセンターからダウンロードします。

Fiery Color Profiler Suite と Fiery Command WorkStation 6.5

Fiery Color Profiler Suite（CPS）5.0 およびそれ以前のバージョンは、カット紙プリンター用の Fiery
Command WorkStation Package（CWS）6.5 と完全には互換性がありません。Fiery Color Profiler Suite 5.1 に
アップデートすることをお勧めします。

CPS 5.0 と CWS 6.5 を併用する場合は、次の問題が発生する可能性があります。

• CPS が現在開いているときに「コンピューターに分光測色計を接続してください。」というメッセージ
が CWS に表示された場合は、CPS を閉じ、OK をクリックして続行してください。

• Calibrator で新しいキャリブレーション設定を作成すると、CPS を起動するための新規プロファイル作
成ボタンが非表示になります。この問題は、CPS 5.1 にアップグレードすると解決されます。

Fiery Impose、Fiery Compose、Fiery JobMaster の Acrobat で編集オプションでは、2 つの Acrobat ウィ
ンドウが開きます。

Windows コンピューターで、Acrobat で編集オプションが Fiery Impose、Fiery Compose、Fiery JobMaster
で選択されている場合は、Acrobat は 1 つではなく 2 つのウィンドウで開くことがあります。これは既知
の問題です。Adobe Acrobat ウィンドウを閉じて、PDF が表示されているウィンドウでの作業を続けるこ
とができます。

PostScript を PDF に変換するための Adobe Acrobat Distiller の環境設定

Fiery Impose、Fiery Compose、Fiery JobMaster で PostScript（PS）ファイルを PDF に変換するには、クライ
アントコンピューター上に Acrobat Distiller が必要です。

Acrobat Distiller のセキュリティ設定が強化されているため、次のような信頼性のあるソースからの PS フ
ァイルの変換が行われていることを確認する必要があります。 Acrobat Distiller > ファイル > 環境設定 >
環境設定 – Acrobat Distiller セキュリティで Acrobat Distiller 経由で開かれたすべてのファイルを信頼す
るを選択します。
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メモ：Acrobat Distiller 経由で開かれたすべてのファイルを信頼するが選択されていない場合は、PDF に
変換するすべての PS ファイルが、信頼できるソースからのファイルであることを確認するよう促すメッ
セージが表示されます。これは、 Microsoft Office フィルターが選択されていて、出力ファイルの種類が
PDF として指定され、joboptions ファイルが Distiller プロファイルとして選択されている場合には、Hot
Folders にも適用されます。

macOS コンピューターから設定を開始できない

Fiery server がシステム FS100 を実行している場合、次のオペレーティングシステムバージョンからは設定
を開始できません。

• mac10.14.6 および 10.14 以降のバージョン

• macOS 10.15（すべてのバージョン）

Fiery Command WorkStation に接続するには、以前の macOS バージョンの macOS コンピューターを使用す
るか、Windows コンピューターを使用します。

Fiery Impose、Fiery Compose または Fiery JobMaster の起動の遅れ

Fiery Impose、Fiery Compose、Fiery JobMaster は、以前のバージョンよりも起動に時間がかかる場合があり
ます。このアプリケーションを開く時間を短縮するには、まず Fiery Preview を起動してから、使用するア
プリケーションを起動します。

Fiery Command WorkStation Package v6.5.0.599 で修正された問題
Fiery Command WorkStation

• ES-3000 分光測色計の測定結果は正確ではありませんでした。

Fiery Command WorkStation Package v6.5.0.581 で修正された問題
Fiery Command WorkStation

• Fiery Hot Folders で TIFF 入力形式を使用している場合、イメージ位置設定が一部の言語で正しく適用され
ませんでした。

• Fiery Command WorkStation Package 6.5 は Windows 10 バージョン 20H2 をサポートしています。

Fiery XF

• パスワード保存環境設定を有効にして Fiery XF サーバーを追加し Fiery XF サーバーを再起動しても、Fiery
Command WorkStation Package は正常に起動しません。
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Fiery Command WorkStation Package v6.5.0.563 で修正された問題
Fiery Command WorkStation

• 日本語システムでは、新しく作成したシステム管理者アカウントでログインすると、Fiery Spot Pro を開く
ことができません。

Fiery XF

• Fiery Command WorkStation ジョブセンターでは、ジョブが Fiery Verify のすべてのテストに合格したとし
ても、ジョブ状況列に検証が成功しなかったことがレポートされます。

• Fiery Command WorkStation ジョブセンターで、ネスト済みジョブの状況が検証可能の場合、親ジョブのジ
ョブ概要ウィンドウで検証をクリックしたときに Fiery Verify が起動しませんでした。子ジョブのジョブ
概要ウィンドウで最適化または詳細情報をクリックすると、Fiery Verify が開きます。

Fiery Command WorkStation Package v6.5.0.539 で修正された問題
Fiery Command WorkStation

• 4-up テンプレートで PPML ジョブを投入して処理した後、Fiery ImageViewer でジョブの一部のページが表
示されませんでした。

Fiery XF

• Command WorkStation の Server Manager ＞レイアウト＞ステップと反復 ＞パターンで、カスタム幅の設
定において、59.4cm 以上の値を指定できませんでした。

Fiery Command WorkStation Package v6.5.0.512 で修正された問題
Fiery Command WorkStation

• 日本語システムでは Fiery ImageViewer を使用して編集したジョブを印刷すると、Fiery server の応答が停止
していました。

• Fiery Impose ワイヤーフレーム表示でのジョブの編集ボックスの表示が、ワイヤーフレームに合わせて調
整されました。

Fiery XF

• メディア名を変更、または Color Tools ＞接続プロファイルで用紙プロファイルにキャリブレーションフ
ァイル （*.EPL）を異なる名前で関連付けした場合 、互換性のあるプリンター情報がキャリブレーション
ファイル（*.EPL）から削除されていました。

• Job Editor ＞重複/接着で、接着領域の設定を保存できませんでした。

• XF 7.2 は、macOS コンピューターで、X-Rite i1Pro3 および EFI ES-3000 測定器をサポートしています。

使用上の注意
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Fiery Command WorkStation Package v6.5.0.475 で修正された問題
Fiery Command WorkStation

• Fiery Spot Pro で、スポットカラーと代替カラーの色分解値を小数点以下 1 桁まで指定できるようになりま
した。

• Fiery Spot Pro では、複製したグループのスポットカラーでは、工場出荷時に復帰オプションが無効になり
ました。

• Fiery Software Manager から、Adobe Acrobat Pro 2017 および Enfocus PitStop Edit 2019 を再インストールしア
クティベートできます。

Fiery XF

• VUTEk ロールツーロールスーパーワイドフォーマットプリンターを使用すると、特殊設定＞ホワイトイン
ク印刷のプリントモード設定は、常にスポットカラー WHITE_INK に戻っていました。

• Fiery server のシステム言語がポーランド語に設定されている場合、Cut Server アプリケーションではネス
ティングジョブが認識されませんでした。

Fiery Command WorkStation Package v6.5.0.433 で修正される問題
Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 は、Windows 10 バージョン 2004 をサポートしています。

• プリセットとして保存されている Fiery Impose テンプレートを使用してブックレットジョブを印刷する
と、表紙の用紙設定が適用されないことがありました。

• アプリケーションがすでに開いているという誤ったエラーメッセージが表示され、Fiery Impose、Fiery
Compose または Fiery JobMaster を起動できない場合がありました。この問題は修正されました。

• 複数のライセンスをアクティベートしている場合、Fiery システム復元を使用して、Fiery server を復元中に
Licence Activation Code（LAC）を復元できませんでした。この問題は修正されました。

Fiery XF

• システムユーザー名にスペースまたは特殊文字が含まれている場合、Job Editor のジョブプレビューが表示
されませんでした。

• イタリア語システムでは、 Fiery Command WorkStation 6.5 を最新バージョンにアップグレードした後、Job
Editor は応答を停止していました。

Fiery Command WorkStation Package v6.5.0.367 で修正された問題
Fiery Command WorkStation

• 一部の言語では、Fiery Compose または Fiery JobMaster を使用してタブに配置されたテキストはコンピュー
ター上では正しく表示されますが、タブを印刷するとテキストは表示されませんでした。

• フォームフィールドに入力されたデータを含む PDF フォームが Fiery Compose または Fiery JobMaster から
保存されている場合、そのフォームフィールドはプレビューまたは印刷済み出力には表示されませんでし
た。

使用上の注意
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• 用紙サイズを 241x330 mm から 13x19 インチに変更した場合、カスタム用紙サイズ 241x330 mm を使用し
てキャリブレーションセットを再キャリブレートすることはできませんでした。

• キャリブレーションページの印刷後に分光測色計を任意のコンピューターに接続した場合、キャリブレー
ションページを測定できませんでした。

Fiery XF

• 一部の Windows プラットフォームでは、Job Editor でジョブのプレビューを表示できませんでした。

Fiery Command WorkStation Package v6.5.0.292 で修正された問題
Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 をインストールした後、一部の Windows コンピューターで Arial フ
ォントが斜体で表示されていました。

• デフォルト設定機能で定義したデフォルト設定が、送信順印刷キューに適用されていませんでした。

• Fiery JobMaster で、タブまたはブランクシートの挿入中にブックマークを使用して PDF ジョブからページ
を挿入または削除した場合、そのブックマークは別のページに移動されていました。

• 英語以外のオペレーティングシステムを搭載した MacOS コンピューターでは、IT8 測定データが破損して
いることがありました。

Fiery XF

• Color Tools キャリブレーションの作成 > グレーバランス > では、保存された EPL ファイルを開くたびに、
デルタ E 値が変更されていました。

• Fiery server のシステム言語がポーランド語に設定されている場合、Cut Server アプリケーションではネス
ティングジョブが認識されませんでした。

• Fiery XF サーバーを再キャリブレートすると、Server Manager ウィンドウで設定したデフォルトのワーク
フローが適用されませんでした。

Fiery Command WorkStation Package v6.5.0.171 SP1 で修正された問題
• Fiery Impose で用紙の割り当てアクションを行うと、誤った sRGB プロファイルであることを警告するメッ

セージが表示されます。

Fiery Command WorkStation Package v6.5.0.171 で修正された問題
Fiery XF

• EPSON SC-P75x0/SC-P95x0 RGB の基準線を作成できない

• EPSON SC-P75x0 および SC-P95x0 でラベルの印刷を選択できない

• 44 インチの用紙を使用して EPSON 9500 をキャリブレートできない

使用上の注意
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고객 릴리스 정보
Fiery Command WorkStation Package, v6.5

본 문서에는 이번 릴리스에 관한 중요 정보가 포함되어 있습니다. 설치를 계속하기 전에 이 정보를 모든 사용
자에게 제공하십시오.

본 릴리스에 대한 정보

이 릴리스에 포함되어 있는 어플리케이션은 다음과 같습니다.

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Mac용 Fiery Hot Folders 4.1.0.21

• Windows용 Fiery Hot Folders 4.1.0.21

• Fiery Software Manager v4.4.0.18

업그레이드

이 설치 관리자는 기존의 Fiery Command WorkStation Package를 Fiery Command WorkStation 및
Fiery Hot Folders가 포함된 최신 패키지로 업그레이드합니다. 옵션으로, Fiery Software Manager을(를)
사용하여 Fiery Remote Scan을 설치할 수 있습니다.

Fiery Command WorkStation Package는 FS100 이상을 실행하는 Fiery servers, Fiery proServer, Fiery
XF 7.0 이상을 지원합니다. 다음에는 연결되지 않습니다.

• Fiery System 9/9e Rel2 및 System 10 소프트웨어 및 이전 버전을 실행하는 Fiery servers

• Fiery XF 6.x 서버 및 이전 버전

• Fiery Central 서버

이러한 제품에 액세스해야 하는 경우 업그레이드하지 마십시오. Fiery Extended Applications 패키지는 
www.efi.com/cws에서 계속 다운로드할 수 있습니다. 지원되는 컷 시트 프린터의 전체 목록은 http://
fiery.efi.com/CWS/supported-printers를 참조하십시오.

기술 사양에 대한 자세한 내용은 www.efi.com/cws를 참조하십시오.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


새로운 기능

새로운 기능

버전 6.5의 초기 릴리스에서 추가된 새로운 기능에 대한 자세한 내용은 http://fiery.efi.com/CWS/
Whats-New를 참조하십시오.

버전 6.5의 초기 릴리스 이후 추가된 새로운 기능에 대한 자세한 내용은 아래의 정보를 참조하십시오.

Fiery Spot Pro

Fiery Command WorkStation6.5에서는 Fiery Spot Pro을 사용하여 별색을 관리할 수 있으며, 이를 통
해 Fiery Spot-On을 대신할 수 있습니다. 개선 목록 전체를 보려면 https://www.efi.com/spotpro를 참
조하십시오.

Fiery Spot Pro는 다음의 요구 사항을 갖춘 서버에서 사용할 수 있습니다.

• FS200 Pro 이상 소프트웨어

• Fiery Graphic Arts Package, Premium Edition

http://fiery.efi.com/spotpro/supported-printers에서 자세히 알아봅니다.

Fiery server에 Fiery Spot Pro가 활성화되어 있지 않은 경우 Fiery Command WorkStation이 Fiery
Spot-On을 계속 지원합니다.

Fiery Spot Pro 사용 시 고려 사항

• 별색 이름에 "@" 기호를 사용하지 마십시오.

• Spot Pro를 시작하고 나면 검색 기능을 사용하거나 출력 프로필을 전환하기 전에 약 60~120초 정도
기다리십시오.

• 여러 번 반복하여 별색을 최적화하면 원본 별색과 변환된 별색이 더 뚜렷하게 차이날 수 있습니다.

• 변환 된 L*a*b* 값과 장치 CMYK 값의 숫자가 약간 반올림됩니다.

• 동일한 Fiery server에 연결하는 서로 다른 사용자 시스템에 있는 Spot Pro의 두 인스턴스는 두 사용
자가 편집 작업을 수행하면 오류가 발생할 수 있습니다.

EFI ES-3000 지원

새로운 EFI ES-3000 측정 기기는 Fiery Command WorkStation 6.5의 EFI ES-2000 에뮬레이션을 통
해 지원됩니다. EFI ES-3000은 EFI ES-2000에 대한 업그레이드이며 측정 모드 M1 및 M2에서 단일
스캔 측정을 지원합니다. 사용자 인터페이스에서 "EFI ES-2000" 항목을 선택하여 Fiery Command
WorkStation의 Fiery 보정기, Fiery Spot Pro 및 용지 시뮬레이션 기능과 함께 EFI ES-3000 도구를 사
용할 수 있습니다.

참고: ES-2000 에뮬레이션 (사용자 인터페이스의 "EFI ES-2000" 항목)은 EFI ES-2000과 함께 사용할
수도 있습니다.

다른 어플리케이션과 함께 EFI ES-3000을 사용하는 방법에 대한 내용은 해당 어플리케이션과 함께 제
공된 설명서를 참조하십시오.
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Fiery 옵션 패키지 라이선스 알림

서버 업데이트 알림이 Fiery Command WorkStation의 새 알림 섹션에 표시됩니다. 설치된 Fiery 옵션
의 라이선스 만료일이 다가오거나 라이선스가 만료된 경우 알림이 표시됩니다. 알림은 Fiery Command
WorkStation, Fiery Hot Folders, Fiery WebTools에 표시됩니다.

참고: 언제든지 라이선스 만료 정보를 다음에서 확인할 수 있습니다. WebTools > 홈 그리고 Fiery
Command WorkStation > 장치 센터 > 일반 > 일반 정보.

만료 알림은 다음 옵션을 제공합니다.

• 지금 갱신

• 해제

• 자세히 알아보기

Fiery JobExpert 보고서 지원

Fiery Command WorkStation 6.5을 FS400 서버에 연결하면 Fiery JobExpert를 사용하여 작업을 수행
해서 나아진 사항을 미리 볼 수 있습니다.

Fiery JobExpert 보고서는 Fiery JobExpert를 사용하여 작업에 적용되는 작업 속성 설정을 간략하게 제
안합니다.

Adobe Acrobat Pro 2017 및 Enfocus PitStop Edit 2019 지원

Adobe Acrobat Pro 2017 및 Enfocus PitStop Edit 2019 옵션은 Fiery Software Manager에서 다운로
드할 수 있습니다.

Fiery XF Color Editor의 측정 기기 지원

다음의 단일 패치 및 최적화 측정 기기를 지원합니다.

측정 기기 단일 패치 최적화

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

가변 라이트 잉크 끝점 지원

Fiery XF에서는 라이트 잉크 끝점을 설정하여 보정 파일에 라이트 잉크를 저장할 수 있습니다.

잉크 저장 보정 파일을 생성하려면 Color Tools의 잉크 제한 및 보정 탭에서 라이트 잉크 끝점 값을 변경
하여 라이트 잉크의 양을 줄입니다.
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1617 (CGATS IT8.7/5) 패치 레이아웃 지원

Fiery XF는 1617 패치를 통해 Color Tools에서 프로파일링 차트를 지원합니다.

1617 대상은 CMYK 프린터 특성화 대상으로서 표준 IT8.7/4 대상의 고유한 패치값과 P2P51 대상의 4
열과 5열에 제시된 모든 패치값을 결합합니다.

Server Manager에서 사용자 지정 프리셋 Verifier 만들기 지원

Server Manager의 XF-Verifier에서 사용자 지정 프리셋을 만들 수 있습니다.

핫 폴더 백업 파일의 폴더 위치 유지 지원

이제 백업 파일에서 Hot Folders를 복원할 때 백업 파일의 기존 폴더 위치를 유지할 수 있습니다.

EFI IQ 웹 어플리케이션

Command WorkStation의 홈 화면에서 EFI IQ 웹 어플리케이션을 등록할 수 있습니다. EFI IQ 웹 어플
리케이션을 사용하면 강력한 인쇄 분석 기능으로 인쇄 제작의 가시성을 확보할 수 있습니다.

시스템 요구 사항 업데이트

지원되는 버전

Fiery Command WorkStation(이)가 지원하는 컴퓨터 운영 체제:

• macOS 11 (인텔 프로세서용)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10, 64비트

• Windows Server 2019, 64비트

• Windows Server 2016, 64비트

• Windows 8.1, 64비트

• Windows 7, 64비트

• Windows Server 2012 R2, 64비트

• Windows Server 2008 R2, 64비트

지원 중단

• macOS 10.11

• macOS 10.12

• 시스템 10 이하

고객 릴리스 정보
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Fiery Command WorkStation을 버전 6.5로 업데이트하면 이전에 추가한 System 10 서버가 모두 서버
목록에서 제거됩니다. 시스템 10 이하를 실행하는 Fiery server에 로그인하려고 하면, FS100 이상을 실
행하는 Fiery server만을 지원하므로 이 서버를 사용할 수 없습니다.

64비트 어플리케이션

Fiery Command WorkStation6.5(CWS)은 MacOS와 Windows 플랫폼에 대한 고유한 64비트 어플리케
이션입니다.

32비트 운영 체제는 CWS 6.5에서 지원되지 않습니다. Windows 7 32비트 등 32비트 운영 체제(OS)에
서 Fiery Software Manager가 이미 실행되고 있는 경우, CWS 6.5 패키지에 대한 업데이트 알림은 표시
되지 않습니다. 32비트 운영 체제에서 이 버전의 Fiery Software Manager을 실행하려고 시도하면 호환
성 오류가 표시되고 Fiery Software Manager이 실행되지 않습니다. 지원되는 운영 체제를 보려면 
http://fiery.efi.com/cws-specifications를 참조하십시오.

Fiery Impose, Fiery Compose, 또는 Fiery JobMaster와 함께 사용할 Adobe Acrobat DC 구독 지

원

Fiery Command WorkStation Package v6.5.0.292은 Fiery Impose, Fiery Compose 또는 Fiery
JobMaster와 함께 사용하기 위해 클라이언트 컴퓨터에 설치되어 있는 Acrobat DC의 개별 소유/개인 구
독 사용을 지원합니다.

참고: Fiery Impose, Fiery Compose 또는 Fiery JobMaster 내부에서 Acrobat을 사용하려면 클라이언
트 컴퓨터에 Acrobat DC의 인스턴스를 하나만 설치해야 합니다. 또한 다른 버전의 Acrobat이 동일한 클
라이언트 컴퓨터에 설치되어 있지 않은지 확인해야 합니다.

알려진 문제

리더 보기

Fiery Impose,Fiery Compose, Fiery JobMaster 또는 Fiery Preview의 macOS 11 이후 버전에서 리
더 보기가 제거되었습니다.

ImageEnhance Visual Editor

MacOS 11에서 ImageEnhance Visual Editor 창을 최대화하면 모니터가 몇 초 동안 깜박일 수 있습니
다.

PS - PDF 변환

Fiery Impose 또는 Fiery Compose 또는 Fiery JobMaster와 함께 macOS 10.14.5 이상을 사용하는 경
우, Fiery Command WorkStation이 Acrobat Distiller에 액세스할 수 있도록 허용하라는 메시지를 받을
수 있습니다. 이 권한은 PS 파일을 PDF로 변환하는 데 필요합니다. 권한을 부여하지 않으면 변환이 성공
하지 못하며 macOS에서 자동화 보안 기능을 변경해야 합니다.

1 Fiery 어플리케이션을 모두 닫습니다.

2 Acrobat Distiller를 닫습니다.

3 그런 다음, 시스템 환경 설정 > 보안 & 개인 정보 > 개인정보 보호 > 자동화로 이동합니다.

4 왼쪽 하단 모서리에 있는 잠금 아이콘을 클릭하고 사용자 암호를 입력합니다.
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5 앱 목록에서 Fiery Command WorkStation.app을 찾습니다.

6 Acrobat Distiller.app 옵션을 선택합니다.
이로써 Fiery Command WorkStation이 Acrobat Distiller에 액세스할 수 있습니다.

macOS 10.15 (Catalina) 정보

macOS 10.15에서의 Fiery 미리 보기, Fiery Impose, Fiery Compose, Fiery JobMaster

PDF 지원 어플리케이션 키트

Adobe Acrobat 및 Enfocus PitStop으로 구성된 EFI에서 제공하는 PDF 지원 어플리케이션 키트는
macOS 10.15 (Catalina)와 호환되지 않습니다. Acrobat 및/또는 PitStop을 사용하는 경우 macOS
10.15로 업그레이드하지 마십시오. 새로 설치하는 경우 PDF 지원 어플리케이션 설치 프로그램이 실행되
지 않습니다.

현재 PDF 지원 어플리케이션 키트를 사용하면서 macOS 10.15로 업그레이드하면 다음과 같은 문제가
발생할 수 있습니다.

• MacOS 10.15로 업그레이드하기 전에 Acrobat DC가 이미 설치되어 있는 경우 정상적으로 실행됩니
다. 하지만 Acrobat DC 설치 프로그램이 macOS 10.15와 호환되지 않기 때문에 Acrobat DC를 새로
설치할 수는 없습니다. 또한 macOS 10.15에서는 Enfocus PitStop이 지원되지 않습니다.

• macOS 10.15로 업그레이드하기 전에 Acrobat XI가 이미 설치되어 있는 경우 정상적으로 실행되지
않으며 macOS 10.15에서 지원되지 않습니다. macOS 10.15로 업그레이드하기 전에 Acrobat XI를
제거하는 것이 좋습니다. Acrobat XI 제거 프로그램은 macos 10.15에서 실행되지 않아 Acrobat XI
가 여전히 설치되어 있는 채로 macOS 10.15로 업그레이드하는 경우 시스템은 Acrobat XI가 작동하
지 않으며 제거할 수 없는 상태가 됩니다.

호환되는 Acrobat 버전이 설치되어 있지 않으면 다음 문제가 발생합니다.

• Acrobat에서 편집 기능을 Fiery Impose, Fiery Compose, Fiery JobMaster에서 사용할 수 없습니
다.

• Fiery 미리 보기, Fiery Impose, Fiery Compose, 또는 Fiery JobMaster를 사용하여 PostScript 작
업을 열면 오류가 발생할 수 있습니다.

• 워크플로우 사용자 정의 마감 크기 또는 트림 상자 기준을 사용하는 Fiery Impose 템플릿이
PostScript 작업에서 제대로 작동하지 않을 수 있습니다.

• Fiery Hot Folders는 PostScript 파일을 PDF로 변환하는 옵션을 제공하지 않습니다.

기타 문제

이전 macOS 버전에서 macOS 10.15로 업그레이드한 후 Fiery 미리 보기, Fiery Impose, Fiery
Compose, 또는 Fiery JobMaster를 시작하면 다음 메시지 중 하나가 표시 될 수 있습니다.

• "ICUConverter.framework"가 컴퓨터를 손상시킬 수 있습니다. 이를 휴지통으로 이동시키면 됩니다.

• "ICUData. framework"가 컴퓨터를 손상시킬 수 있습니다. 이를 휴지통으로 이동시키면 됩니다.

macOS 10.15는 이러한 파일을 악성 소프트웨어로 잘못 식별합니다. 이 문제를 해결하려면 macOS
10.15와 호환되는 Fiery Command WorkStation Package 버전 6.4.0.396 이상을 다시 설치하십시오.

Fiery 미리 보기, Fiery Impose, Fiery Compose, 또는 Fiery JobMaster에서 아무 컨트롤 아이콘 버튼
위로 마우스를 가져가면 도구 설명이 표시되지 않습니다.
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전체 디스크 액세스

macOS 10.15에서 보안을 관리하는 방법의 변화로 인해 이제 Fiery 어플리케이션이 제대로 작동하기 위
해서는 추가 단계가 필요합니다.
Fiery 어플리케이션이 업데이트를 관리하고 Impose 템플릿 및 핫 폴더와 같은 파일에 액세스할 수 있도
록 macOS에서 전체 디스크 액세스 보안 기능을 변경해야 합니다. Fiery Command WorkStation과 같은
Fiery 어플리케이션에 대한 전체 디스크 액세스를 활성화합니다.

1 Fiery 어플리케이션을 모두 닫습니다.

2 그런 다음, 시스템 환경 설정 > 보안 & 개인 정보 > 개인정보 보호 > 전체 디스크 액세스로 이동합니
다.

3 왼쪽 하단 모서리에 있는 잠금 아이콘을 클릭하고 사용자 암호를 입력합니다.

4 + 버튼을 클릭합니다.

5 어플리케이션 폴더에서 Fiery Software Manager와 Fiery Software Uninstaller를 선택하고 열기를
클릭합니다.

이러한 어플리케이션은 컴퓨터에서 Fiery 어플리케이션을 유지하고 업데이트하기 위한 전체 디스크
액세스가 필요합니다.

6 어플리케이션 폴더에서 Fiery Command WorkStation 어플리케이션을 선택하고 열기를 클릭합니다.

7 Fiery Hot Folders 또는 Fiery Remote Scan을 사용하는 경우 각 어플리케이션를 선택하고 열기를
클릭합니다.

문서, 데스크탑 및 다운로드 폴더가 사용되는 것을 Fiery Hot Folders에서 감지하면 전체 디스크 액
세스를 요청하는 메시지가 표시됩니다. 이 메시지는 액세스 권한이 부여된 후에도 계속 표시됩니다.
이 메시지를 해제하고 작업을 계속할 수 있습니다.

MacOS 10.15의 Safari 브라우저 오류

MacOS 10.15에서 Safari를 사용하는 경우 다음 웹 페이지를 Fiery Command WorkStation에서 열 때
반복적인 브라우저 오류가 발생 합니다. 장치 센터 > 일반 > 도구:

• Fiery 시스템 복원

• Fiery 시스템 이미지

• Fiery 리소스 및 설정

Safari 브라우저에서 Fiery WebTools를 열 때 이러한 오류가 발생할 수도 있습니다.

Chrome 또는 Firefox를 사용하여 이러한 웹페이지에 액세스합니다.

macOS 10.15에서의 Fiery XF

macOS 10.15에서 Fiery XF를 사용하는 경우 Fiery Color Profiler Suite를 버전 5.3.1로 업그레이드해
야 합니다. Fiery Color Profiler Suite 버전 5.3.1에서는 이제 macOS 10.15 호환 Fiery Verify를 Fiery
XF 사용자가 기본 확인 어플리케이션으로 사용할 수 있습니다.

Color Verifier는 macOS 10.15와 호환되지 않지만 이전 macOS 버전에서는 계속 지원됩니다. 하지만
Color Verifier를 별도로 설치해야 합니다. 다운로드 센터에서 macOS 10.14 및 이전 버전용 Color
Verifier를 다운로드하세요.
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Fiery Color Profiler Suite 및 Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0(CPS) 및 이전 버전은 컷 시트 프린터용 Fiery Command WorkStation
패키지 6.5(CWS)와 완벽하게 호환되지는 않습니다. Fiery Color Profiler Suite 5.1로 업데이트하는 것
이 좋습니다.

CWS 6.5를 CPS 5.0과 함께 사용하는 경우, 다음과 같은 문제가 발생할 수 있습니다.

• CPS가 현재 열려있는 동안 CWS에 "컴퓨터에 분광광도계 연결" 메시지가 표시되면 CPS를 닫고 확인
을 클릭하여 계속합니다.

• 보정기에서 새 보정 설정을 만들고 나면, CPS를 시작하기 위한 새 프로필 생성 버튼이 숨겨집니다.
CPS 5.1로 업그레이드한 후 이 문제가 해결되었습니다.

Fiery Impose, Fiery Compose 또는 Fiery JobMaster에서 Acrobat에서 편집 옵션은 두 개의

Acrobat 창을 엽니다.

Windows 컴퓨터에서 Acrobat에서 편집 옵션을 Fiery Impose, Fiery Compose 또는 Fiery JobMaster
내에서 선택하면 Acrobat은 하나 대신 두 개의 창에서 열릴 수도 있습니다. 이것은 알려진 문제입니다.
Adobe Acrobat 창을 닫고 PDF를 사용하여 창에서 작업을 계속할 수 있습니다.

PostScript에서 PDF로 변환을 위한 Adobe Acrobat Distiller에서의 환경 설정 지정

Fiery Impose, Fiery Compose 및 Fiery JobMaster은 클라이언트 컴퓨터에서 PostScript(PS) 파일을
PDF로 변환하기 위해서는 Acrobat Distiller가 필요합니다.

Acrobat Distiller의 강화된 보안 설정으로 인해 변환할 PS 파일의 출처가 신뢰할 만한 곳인지를 확인해
야 합니다. Acrobat Distiller > 파일 > 환경 설정 > 환경 설정 - Acrobat Distiller보안 아래의 Acrobat
Distiller를 통해 열린 모든 파일 신뢰를 선택합니다.

참고: Acrobat Distiller를 통해 열린 모든 파일 신뢰를 선택하지 않으면 PDF로 변환할 모든 PS 파일에 대
해 출처가 신뢰할 수 있는 곳인지 확인하라는 메시지가 표시됩니다. 이는 Microsoft Office 필터를 선택
하고, 출력 파일 형식이 PDF로 지정되고, joboptions 파일이 Distiller 프로필로 선택된 경우에도 Hot
Folders에 적용됩니다.

macOS 컴퓨터에서 구성을 시작할 수 없습니다

Fiery server에서 시스템 FS100을 실행하는 경우 다음 운영 체제 버전에서 구성을 시작할 수 없습니다.

• mac10.14.6 이상 버전의 10.14

• macOS 10.15 (모든 버전)

Fiery Command WorkStation에 연결하려면 이전 버전의 macOS가 있는 macOS 컴퓨터를 사용하거나
Windows 컴퓨터를 사용합니다.

Fiery Impose, Fiery Compose, Fiery JobMaster의 시작 지연

Fiery Impose, Fiery Compose, Fiery JobMaster는 이전 버전보다 시작에 시간이 더 걸릴 수 있습니다.
이러한 어플리케이션 중 하나를 여는 시간을 줄이려면 Fiery Preview를 먼저 시작한 다음 사용할 어플리
케이션을 시작합니다.
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Fiery Command WorkStation Package v6.5.0.599에서 해결된 문제

Fiery Command WorkStation

• ES-3000 분광광도계의 측정 결과는 정확하지 않았습니다.

Fiery Command WorkStation Package 6.5.0.581에서 해결된 문제

Fiery Command WorkStation

• Fiery Hot Folders에서 TIFF 입력 형식을 사용하는 경우 이미지 위치 설정이 몇 가지 언어로 올바르게
적용되지 않았습니다.

• Fiery Command WorkStation Package 6.5은(는) Windows 10 버전 20H2를 지원합니다.

Fiery XF

• 암호 저장 환경설정이 설정되어 있는 Fiery XF 서버를 추가하고 Fiery XF 서버를 다시 시작하면 Fiery
Command WorkStation Package(이)가 성공적으로 시작되지 않습니다.

Fiery Command WorkStation Package 6.5.0.563 문제 해결

Fiery Command WorkStation

• 일본어 시스템에서는 새로 생성된 관리자 계정으로 로그인 할 때 Fiery Spot Pro이(가) 열리지 않습니다.

Fiery XF

• Fiery Command WorkStation 작업 센터에서 작업 상태 열은 작업이 Fiery Verify의 모든 테스트를 통과
하더라도 확인에 실패했음을 보고합니다.

• Fiery Command WorkStation 작업 센터에서 중첩된 작업의 상태가 확인 중인 경우 상위 작업의 작업 요
약 창에서 확인을 클릭해도 Fiery Verify는 시작되지 않았습니다. 하위 작업의 작업 요약 창에서 최적화 또
는 세부 정보를 클릭하면 Fiery Verify가 열립니다.

v6.5.0.539에서Fiery Command WorkStation Package 해결된 문제

Fiery Command WorkStation

• 4 업 템플릿으로 PPML 작업을 임포징하여 처리하면 작업의 일부 페이지가 Fiery ImageViewer에서 표
시되지 않았습니다.

Fiery XF

• Command WorkStation Server Manager > 레이아웃 > 단계 및 반복 > 패턴에서 사용자 지정 너비 설정
에 59.4cm를 초과하는 값을 지정할 수 없었습니다.
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Fiery Command WorkStation Package v6.5.0.512에서 해결된 문제

Fiery Command WorkStation

• 일본어 시스템에서는 Fiery ImageViewer를 사용하여 편집한 작업을 인쇄할 때 Fiery server의 응답이
중지됩니다.

• 이제 Fiery Impose의 와이어프레임 보기에서 작업의 편집 상자 표시가 와이어프레임과 정렬됩니다.

Fiery XF

• 용지 이름 또는 관련 보정 파일(*.EPL)을 Color Tools > 프로필 연결에서 지정된 이름이 다른 용지 프로
필로 변경하면 보정 파일에서(*.EPL)에서 호환 프린터 정보가 제거됩니다.

• Job Editor > 중첩/접착에서 접착 영역 설정을 저장할 수 없습니다.

• XF 7.2는 macOS 컴퓨터에서 X-Rite i1Pro3 및 EFI ES-3000 측정 기기를 지원합니다.

Fiery Command WorkStation Package V 6.5.0.475에서 해결된 문제

Fiery Command WorkStation

• Fiery Spot Pro에서는 이제 별색과 대체 색상의 분리 값을 소수점 이하 한 자리로 지정할 수 있습니다.

• Fiery Spot Pro에서 공장으로 복귀 옵션이 이제 복제된 그룹의 별색에서 비활성화됩니다.

• Fiery Software Manager에서 Adobe Acrobat Pro 2017과 Enfocus PitStop Edit 2019를 재설치하고
활성화할 수 있습니다.

Fiery XF

• VUTEk Roll to roll 초광폭 형식 프린터의 경우, 특수 설정 > 흰색 잉크 인쇄의 인쇄 모드 설정은 항상 별
색 WHITE_INK로 다시 변경되었습니다.

• 폴란드어로 설정된 Fiery server의 시스템 언어로, Cut Server 어플리케이션이 중첩 작업을 인식하지 못
했습니다.

Fiery Command WorkStation Package v6.5.0.433에서 해결된 문제

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5은(는) Windows 10 버전 2004를 지원합니다.

• 프리셋으로 저장된 Fiery Impose 템플릿을 사용하여 소책자 작업을 인쇄하는 경우 표지 용지 설정이 적
용되지 않을 때가 있었습니다.

• 애플리케이션이 이미 열려 있다는 잘못된 오류 메시지가 표시되었기 때문에 Fiery Impose, Fiery
Compose 또는 Fiery JobMaster을(를) 시작할 수 없는 경우가 있었습니다. 이 문제는 해결되었습니다.

• 여러 라이선스가 활성화된 경우 Fiery 시스템 복원을 사용하여 Fiery server을(를) 복원하는 동안에는
LACs(라이선스 활성화 코드)를 복원할 수 없습니다. 이 문제는 해결되었습니다.
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Fiery XF

• 공백 또는 특수 문자를 포함하는 시스템 사용자 이름으로 인해 Job Editor에 작업 미리 보기가 표시되지
않았습니다.

• 이탈리아어 시스템에서는 Fiery Command WorkStation 6.5을(를) 최신 버전으로 업그레이드한 후에
Job Editor가 응답하지 않았습니다.

Fiery Command WorkStation Package v 6.5.0.367에서 해결된 문제

Fiery Command WorkStation

• 일부 언어에서는 Fiery Compose 또는 Fiery JobMaster를 사용하여 색인에 배치한 텍스트가 컴퓨터에
서는 올바르게 보이지만 색인을 인쇄하면 텍스트가 표시되지 않았습니다.

• 양식 필드에 데이터가 입력되어 있는 PDF 양식을 Fiery Compose 또는 Fiery JobMaster에서 저장한 경
우 양식 필드가 미리 보기 또는 인쇄된 출력에 표시되지 않았습니다.

• 241x330 mm에서 13x19 인치로 용지 크기를 변경한 경우 사용자 지정 용지 크기 241x330 mm로 보정
세트를 재보정할 수 없었습니다.

• 보정 페이지를 인쇄한 후에 분광광도계를 컴퓨터에 연결한 경우 보정 페이지를 측정할 수 없었습니다.

Fiery XF

• 일부 Windows 플랫폼에서는 Job Editor에서 작업 미리 보기를 표시할 수 없었습니다.

Fiery Command WorkStation Package v6.5.0.292 문제 해결

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5를 설치한 후, 일부 Windows 컴퓨터에서 Arial 글꼴이 이탤
릭체로 표시되었습니다.

• 기본값 설정 기능을 사용하여 정의한 기본 설정이 순차 인쇄 대기열에 적용되지 않았습니다.

• Fiery JobMaster에서, 색인 또는 빈 시트를 삽입하는 동안 책갈피를 사용하여 PDF 작업에서 페이지를
삽입하거나 삭제하면 책갈피가 다른 페이지로 이동합니다.

• 영어 이외의 언어로 운영 체제를 사용하는 macOS 컴퓨터에서 손상된 IT8 측정 데이터를 생성하는 경우
가 있습니다.

Fiery XF

• Color Tools > 보정 생성 > 회색 밸런스에서델타 E 값은 저장된 EPL 파일을 열 때마다 변경됩니다.

• 폴란드어로 설정된 Fiery server의 시스템 언어로, Cut Server 어플리케이션이 중첩 작업을 인식하지 못
했습니다.

• Fiery XF 서버를 재보정할 때, Server Manager 창에서 설정한 기본 워크플로우가 적용되지 않았습니다.

Fiery Command WorkStation Package v6.5.0.171 SP1 문제 해결

• Fiery Impose에서 용지 할당 동작을 사용한 경우 잘못된 sRGB 프로필에 대한 경고가 표시되었습니다.
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Fiery Command WorkStation Package v6.5.0.171 문제 해결

Fiery XF

• EPSON SC-P75x0/SC-P95x0 RGB의 기준선을 생성할 수 없음

• EPSON SC-P75x0 및 SC-P95x0의 레이블 인쇄를 선택할 수 없음

• 44인치 용지를 사용하여 EPSON 9500를 보정할 수 없음
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客戶版本資訊
Fiery Command WorkStation Package 版本 6.5

本文件包含有關此版本的重要資訊。在繼續安裝之前，請務必將這項資訊提供給所有使用者。

關於本版本
本版本包含以下應用程式：

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• 適用於 Mac 4.1.0.21 的 Fiery Hot Folders

• 適用於 Windows 4.1.0.21 的 Fiery Hot Folders

• Fiery Software Manager v4.4.0.18

升級

此安裝程式會將任何現有的 Fiery Command WorkStation Package 升級至包含 Fiery Command WorkStation
與 Fiery Hot Folders 的最新套件。您可以選擇使用 Fiery Software Manager 來安裝 Fiery Remote Scan。

Fiery Command WorkStation Package 支援 Fiery servers 執行 FS100 和更新版本，以及 Fiery proServer
及 Fiery XF 7.0 和更新版本。它將不會連線至：

• Fiery servers 執行 Fiery System 9/9e Rel2 與 System 10 軟體和先前版本

• Fiery XF 6.x 伺服器和更舊版本

• Fiery Central 伺服器

如果您存取這些產品，請勿升級。Fiery Extended Applications 套件仍可在 www.efi.com/cws 取得。如需完
整的受支援單頁印表機清單，請參閱 http://fiery.efi.com/CWS/supported-printers。

如需有關技術規格的更多資訊，請參閱 www.efi.com/cws。

全新功能

最新消息

如需 6.5 版的初始版本中所新增功能的詳細資訊，請造訪 http://fiery.efi.com/CWS/Whats-New。

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws
http://fiery.efi.com/CWS/Whats-New


如需 6.5 版的初始版本後所新增功能的詳細資訊，請參閱以下資訊。

Fiery Spot Pro

Fiery Command WorkStation 6.5 允許您使用 Fiery Spot Pro 取代 Fiery Spot-On 來管理特別色。如需
有關完整的改善清單，請參閱 https://www.efi.com/spotpro。

所選伺服器需符合以下要求，才可以使用 Fiery Spot Pro：

• FS200 Pro 和更新版本軟體

• Fiery Graphic Arts Package, Premium Edition

如需進一步瞭解，請至 http://fiery.efi.com/spotpro/supported-printers。

如果 Fiery server 未啟用 Fiery Spot Pro，Fiery Command WorkStation 會繼續支援 Fiery Spot-On。

使用 Fiery Spot Pro 的考量事項

• 不在任何特別色名稱中使用 "@" 符號。

• 啟動 Spot Pro 後，請先等待大約 60-120 秒，再使用搜尋功能或切換輸出設定檔。

• 經過幾次反覆測量將特別色最佳化，可能會導致原始特別色與轉換的特別色之間出現更明顯的差異。

• 轉換後的 L*a*b* 值和裝置 CMYK 值的數值會稍微四捨五入。

• 不同使用者系統上的兩個 Spot Pro 執行個體都連線到相同 Fiery server 時，如果兩方使用者都在執
行編輯操作，可能會導致發生錯誤。

EFI ES-3000 支援

新的 EFI ES-3000 測量儀器通過 EFI ES-2000 模擬 Fiery Command WorkStation 6.5 支援。ES-3000 是
ES-2000 的升級，並支援量測模式 M1 和 M2 中的單次掃描量測值。您可以使用 EFI ES-3000 儀器（通過
在使用者介面中選擇「EFI ES-2000」項目），和 Fiery Calibrator、Fiery Spot Pro 和 Fiery Command
WorkStation 內的紙張模擬功能作搭配。

附註：模擬 ES-2000 (使用者介面中的「EFI ES-2000」項目) 也可與 EFI ES-2000 一起使用。

有關搭配使用 EFI ES-3000 與其他應用程式的資訊，請參閱應用程式隨附的文件。

Fiery Option 套件授權通知

現在有關可用伺服器更新的通知會列在 Fiery Command WorkStation 的新「通知」區段下。已安裝 Fiery
選購配件的授權接近其到期日或已過期時，就會顯示通知。分別在 Fiery Command WorkStation、Fiery
Hot Folders 及 Fiery WebTools 中顯示通知。

附註：您可以在以下位置隨時檢視授權到期資訊： WebTools > 首頁與 Fiery Command WorkStation >
裝置中心 > 一般 > 一般資訊。

到期通知提供以下選項：

• 立即續約

• 關閉

• 瞭解更多
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支援 Fiery JobExpert 報告

連線至 FS400 伺服器的 Fiery Command WorkStation 6.5 可讓您使用 Fiery JobExpert 預覽對工作執行
的增強功能。

Fiery JobExpert 報告提供可使用 Fiery JobExpert 套用至工作的建議工作屬性設定概覽。

支援 Adobe Acrobat Pro 2017 與 Enfocus PitStop Edit 2019

Adobe Acrobat Pro 2017 與 Enfocus PitStop Edit 2019 選項可從 Fiery Software Manager 下載。

Fiery XF Color Editor 中支援的量測儀器

支援以下單一色標和最佳化量測儀器：

量測儀器 單一色標 最佳化

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

支援可變淺色墨水結束點

Fiery XF 允許您設定淺色墨水結束點，以在校正檔案上儲存淺色墨水。

若要建立可節省墨水的校正檔案，請在 Color Tools 的墨水限制和校正索引標籤中，變更淺色墨水結束點
值。

支援 1617 (CGATS IT8.7/5) 色標版面配置。

Fiery XF 支援具有 1617 個色標的「色彩工具」中的分析圖表。

1617 目標是 CMYK 印表機特性目標，結合標準 IT8.7/4 目標中的獨特色標值與 P2P51 目標第 4 和 5 欄
中所有的色標值。

支援從 Server Manager 創建 Verifier 自定義預設。

您可以在 Server Manager 的 XF-Verifier 中創建自訂預設。

支援保留監視資料夾備份檔的資料夾位置。

從備份檔還原監視資料夾時，現在可以保留備份檔的原始資料夾位置。
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EFI IQ 網絡應用程式

您可以透過 Command WorkStation 的主螢幕註冊 EFI IQ 網絡應用程式。EFI IQ 網絡應用程式透過強大
的列印分析，讓您的列印生產更加具有可見性。

系統需求更新

支援的版本

Fiery Command WorkStation 可支援以下電腦作業系統：

• macOS 11 (僅限配備 Intel 處理器)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10 (64 位元)

• Windows Server 2019 (64 位元)

• Windows Server 2016 (64 位元)

• Windows 8.1 (64 位元)

• Windows 7 (64 位元)

• Windows Server 2012 R2 (64 位元)

• Windows Server 2008 R2 (64 位元)

已停用支援

• macOS 10.11

• macOS 10.12

• System 10 和更舊版本

當您將 Fiery Command WorkStation 更新至 6.5 版時，會從伺服器清單中移除所有先前新增的 System
10 伺服器。如果您嘗試登入執行 System 10 或更舊版本的 Fiery server，可能會無法使用此伺服器，原
因是只支援執行 FS100 和更新版本的 Fiery server。

64 位元應用程式

Fiery Command WorkStation 6.5 (CWS) 是原生 64 位元應用程式，適用於 macOS 與 Windows 平台。

CWS 6.5 不支援 32 位元作業系統。如果 Fiery Software Manager 已在 32 位元作業系統 (OS) 上執行
(例如 Windows 7 32 位元)，則不會對 CWS 6.5 套件顯示更新通知。如果您嘗試在 32 位元作業系統上執
行此 Fiery Software Manager 版本，您會看到相容性錯誤，而 Fiery Software Manager 也不會執行。
要檢視受支援的作業系統，請參閱 http://fiery.efi.com/cws-specifications。

支援使用 Adobe Acrobat DC 訂閱 Fiery Impose、Fiery Compose 或 Fiery JobMaster

Fiery Command WorkStation Package v6.5.0.292 支援客戶電腦上安裝個人擁有/訂閱的 Acrobat DC，以
便與 Fiery Impose、 Fiery Compose 或 Fiery JobMaster 搭配使用。

客戶版本資訊
Fiery Command WorkStation Package 版本 6.5

122

http://fiery.efi.com/cws-specifications


附註：若要在 Fiery Impose、Fiery Compose 或 Fiery JobMaster 中使用 Acrobat，您必須在客戶電腦上
僅安裝一個 Acrobat DC。此外，請確保其他 Acrobat 版本未安裝在同一台客戶電腦上。

已知問題

Reader 檢視

在 macOS 11 和更新版本上，Fiery Impose、Fiery Compose、Fiery JobMaster 或 Fiery Preview 中的
Reader 檢視已移除 。

ImageEnhance Visual Editor

當您最大化 macOS 11 上的 ImageEnance Visual Editor 視窗時，顯示器可能會閃爍幾秒鐘。

PS 至 PDF 轉換

當您使用 macOS 10.14.5 和更新版本搭配 Fiery Impose、Fiery Compose 或 Fiery JobMaster 時，系統
可能會提示您允許 Fiery Command WorkStation 存取 Acrobat Distiller。這是將 PS 檔案轉換為 PDF
的必要權限。如果不授予權限，將無法成功轉換，而您需要變更 macOS 中的自動化安全性功能。

1 關閉所有 Fiery 應用程式。

2 關閉 Acrobat Distiller。

3 跳至 系統偏好設定 > 安全性與隱私權 > 隱私權 > 自動化。

4 按一下左下角的「鎖定」圖示，然後輸入密碼。

5 在應用程式清單中，找到 Fiery Command WorkStation.app。

6 選取 Acrobat Distiller.app 選項。
這樣即可允許 Fiery Command WorkStation 存取 Acrobat Distiller。

macOS 10.15 (Catalina) 資訊

macOS 10.15 上的 Fiery 預覽、 Fiery Impose、 Fiery Compose 或 Fiery JobMaster

PDF 支援應用程式套件

包含 Adobe Acrobat 和 Enfocus PitStop 的 PDF 支援應用程式套件 (由 EFI 提供) 與 macOS 10.15
(Catalina) 不相容。如果您使用 Acrobat 和/或 PitStop，請勿升級至 macOS 10.15。PDF 支援應用程式
安裝程式不會執行以提供全新安裝。
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使用目前的 PDF 支援應用程式套件，同時升級至 macOS 10.15，可能會導致發生以下問題：

• 如果在升級至 macOS 10.15 之前，您已經安裝 Acrobat DC，其將可正常執行。不過，Acrobat DC 安
裝程式與 macOS 10.15 不相容，因此無法安裝新的 Acrobat DC。此外，macOS 10.15 不支援隨附的
Enfocus PitStop。

• 如果在升級至 macOS 10.15 之前，您已經安裝 Acrobat XI，其將不會執行且 macOS 10.15 亦不支
援。建議您在升級至 macOS 10.15 之前，解除安裝 Acrobat XI。Acrobat XI 解除安裝程式無法在
macOS 10.15 上執行，因此如果您升級到 macOS 10.15 時仍保持安裝 Acrobat XI，系統中的 Acrobat
XI 將處於無法運作，也無法解除安裝的狀態。

如果未安裝相容的 Acrobat 版本，則會發生以下問題：

• Fiery Impose、Fiery Compose 及 Fiery JobMaster 均無法使用在 Acrobat 中編輯功能。

• 使用 Fiery 預覽、Fiery Impose、Fiery Compose 或 Fiery JobMaster 開啟 PostScript 工作，可能
導致發生錯誤。

• 使用工作流程 (使用者定義的加工尺寸或根據剪裁方塊) 的 Fiery Impose 範本可能無法正確處理
PostScript 工作。

• Fiery Hot Folders 不提供將 PostScript 檔案轉換為 PDF 的選項。

其他問題

從舊版 macOS 升級至 macOS 10.15 後，啟動 Fiery 預覽、Fiery Impose、Fiery Compose 或 Fiery
JobMaster 可能會導致顯示以下其中一個訊息：

• 「ICUConverter.framework」將會損害您的電腦。您應該將其丟到「垃圾桶」。

• 「ICUData.framework」將會損害您的電腦。您應該將其丟到「垃圾桶」。

macOS 10.15 誤將這些檔案識別為惡意軟體。若要解決這些問題，請重新安裝與 macOS 10.15 相容的
Fiery Command WorkStation Package6.4.0.396 版或更新版本。

當滑鼠停留在 Fiery 預覽、Fiery Impose、Fiery Compose 或 Fiery JobMaster 中任何控制圖示的按鈕
上方時，均未顯示工作提示。

完全取用磁碟

由於 macOS 10.15 管理安全性的方式改變，現在需要進行額外的步驟，Fiery 應用程式才能正常運作。

您需要對 macOS 中的完全取用磁碟安全性功能進行變更，Fiery 應用程式才能管理更新，以及存取

Impose 範本與監視資料夾等檔案。為 Fiery 應用程式 (例如 Fiery Command WorkStation) 啟用完全取
用磁碟。

1 關閉所有 Fiery 應用程式。

2 前往 系統偏好設定 > 安全性與隱私權 > 隱私權 > 完全取用磁碟。

3 按一下左下角的「鎖定」圖示，然後輸入密碼。

4 按一下 + 按鈕。

5 在「應用程式」資料夾中，選取 Fiery Software Manager 與 Fiery Software Uninstaller，然後按

一下打開。

這些應用程式需要能完全取用磁碟，才能維護和更新電腦上的 Fiery 應用程式。

6 在「應用程式」資料夾中，選取 Fiery Command WorkStation 應用程式，然後按一下打開。
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7 如果您使用 Fiery Hot Folders 或 Fiery Remote Scan，請選取每個應用程式，然後按一下 打開。

當 Fiery Hot Folders 偵測到「文件」、「桌面」及「下載」資料夾處於使用中時，隨即會發出要求
完全取用磁碟的訊息。即使已經授予存取權限，仍會顯示此訊息。您可以關閉該訊息並繼續工作。

MacOS 10.15 上的 Safari 瀏覽器錯誤

如果在 macOS 10.15 上使用 Safari，當您嘗試從 Fiery Command WorkStation 開啟以下網頁時會遇到重

複的瀏覽器錯誤 裝置中心 > 一般 > 工具：

• Fiery 系統還原

• Fiery 系統影像

• Fiery 資源與設定

在 Safari 瀏覽器中開啟 Fiery WebTools 時也會出現這些錯誤。

請使用 Chrome 或 Firefox 來存取這些網頁。

macOS 10.15 上的 Fiery XF

如果您在 Fiery XF macOS 10.15 上使用，則需要升級 Fiery Color Profiler Suite 到版本 5.3.1。使用
Fiery Color Profiler Suite 版本 5.3.1，macOS 10.15 相容的 Fiery Verify 現在可用於 Fiery XF 使
用者作為預設值驗證應用。

Color Verifier 不符合 macOS 10.15，但仍支援較早的 macOS 版本。但是您需要獨立安裝 Color
Verifier。從下載中心下載 macOS 10.14 和較早版本的 Color Verifier。

Fiery Color Profiler Suite 與 Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) 和較舊版本與適用於單頁印表機的 Fiery Command WorkStation
Package 6.5 (CWS) 不完全相容。建議您更新到 Fiery Color Profiler Suite 5.1。

當您將 CPS 5.0 與 CWS 6.5 搭配使用時，可能會遇到以下問題：

• 如果在 CPS 處於開啟的情況下，您在 CWS 中看到「將光譜儀連線到電腦」的訊息，請關閉 CPS，然後

按一下確定以繼續。

• 您在校正器中建立新的校正設定後，就會隱藏可啟動 CPS 的建立新設定檔按鈕。升級到 CPS 5.1 後，
即可解決此問題。

在 Acrobat 中編輯選項 Fiery Impose、Fiery Compose 或 Fiery JobMaster 打開兩個 Acrobat 視
窗

在 Windows 電腦上，當在 acrobat 選項中選擇 Fiery Impose、Fiery Compose 或 Fiery JobMaster 編輯"
時，Acrobat 可能會以兩個視窗打開。這是已知的問題。您可以關閉 Adobe Acrobat 視窗並繼續使用 PDF
在視窗中工作。

在 Adobe Acrobat Distiller 中設置 PostScript PDF 轉換的喜好設定

Fiery Impose、Fiery Compose 和 Fiery JobMaster 要求 Acrobat Distiller 將客戶電腦上的
PostScript （PS）檔轉換為 PDF。

客戶版本資訊
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由於 Acrobat Distiller 中增強的安全設定，您必須確認要轉換的 PS 檔來自於可信賴的來源： Acrobat
Distiller > 檔案 > 喜好設定 > 喜好設定 - Acrobat Distiller，請選擇 安全性 下的 信任通過 Acrobat
Distiller 打開的所有檔案。

附註：如果不選擇信任通過 Acrobat Distiller 打開的所有檔案，系統會提示您確認檔案來自每個 PS 檔的

可信來源以轉換為 PDF。如果選擇了 Microsoft Office 篩選器，Hot Folders 則會將輸出檔案類型指定為

PDF，並選擇 joboptions 檔作為 Distiller 設定檔。

無法從 macOS 電腦啟動 Configure

如果 Fiery server 執行 System FS100，則無法從以下作業系統版本啟動 Configure：

• mac10.14.6 和 10.14 的更新版本

• macOS 10.15 (所有版本)

若要連線到 Fiery Command WorkStation，請使用 macOS 版本較舊的 macOS 電腦，或使用 Windows 電
腦。

延遲啟動 Fiery Impose、Fiery Compose 或 Fiery JobMaster

啟動 Fiery Impose、Fiery Compose 和 Fiery JobMaster 所需的時間可能會比先前的版本更長。若要縮
短開啟上述其中一種應用程式的時間長度，請先啟動 Fiery Preview，然後啟動要使用的應用程式。

Fiery Command WorkStation Package v6.5.0.599 已修正的問題
Fiery Command WorkStation

• ES-3000 光譜儀量測結果不準確的問題。

Fiery Command WorkStation Package v6.5.0.581 中已修復的問題
Fiery Command WorkStation

• 在 Fiery Hot Folders 中使用 TIFF 輸入格式時，圖像定位設定未能正確套用至某些語言。

• Fiery Command WorkStation Package 6.5 支援 20H2 版 Windows 10。

Fiery XF

• 新增 Fiery XF 伺服器時選取儲存密碼喜好設定，然後重新啟動 Fiery XF 伺服器時， Fiery Command
WorkStation Package 無法成功啟動。

客戶版本資訊
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Fiery Command WorkStation Package V6.5.0.563 中已修復的問題
Fiery Command WorkStation

• 在日語系統上，當您使用新建立的管理員帳戶登入時，則無法開啟 Fiery Spot Pro。

Fiery XF

• 在 Fiery Command WorkStation 工作中心中，即使工作通過 Fiery Verify 中的所有測試，工作狀態欄回報
驗證並未成功。

• 在 Fiery Command WorkStation 工作中心中，如果嵌套式工作狀態為要驗證，當您從父工作的工作摘要窗

格按一下驗證時，則無法啟動 Fiery Verify。如果按下子工作工作摘要窗格中的最佳化或詳細資訊，則會開

啟 Fiery Verify。

Fiery Command WorkStation Package v6.5.0.539 已修正的問題
Fiery Command WorkStation

• 在您使用 4-up 範本載入 PPML 工作並處理後，工作的一些頁面不會顯示在 Fiery ImageViewer。

Fiery XF

• 您無法在 Command WorkStation Server Manager > 版面配置 > 執行步驟並重複 > 模式中為自訂寬度設
定指定大於 59.4 公分的數值。

Fiery Command WorkStation Package v6.5.0.512 修復的問題
Fiery Command WorkStation

• 在日語的系統中，當您列印使用 Fiery ImageViewer 編輯工作時， Fiery server 已停止回應。

• 在 Fiery Impose 中的線框檢視中顯示作業的編輯框，則現在與線框對齊。

Fiery XF

• 如果您在 色彩工具 > 連接設定檔 變更了底材名稱或關聯的校準檔案 (*.EPL)，而連接設定檔中使用不同名
稱的底材設定時，相容的印表機資訊會從校準檔案 (*.EPL)移除。

• 無法在  工作編輯器 > 重疊/上膠 儲存 上膠範圍 設定。

• XF 7.2 支援 macOS 電腦中的 X-Rite i1Pro3 和 EFI ES-3000 測量儀器。

Fiery Command WorkStation Package v6.5.0.475 已修正的問題
Fiery Command WorkStation

• 在 Fiery Spot Pro 中，您現在可以將特別色和替代色的分色值指定至小數點後一位。

• 在 Fiery Spot Pro 中，現已對重複群組中特別色停用還原為原廠預設值選項。

• 您可以從 Fiery Software Manager 重新安裝和啟用 Adobe Acrobat Pro 2017 與 Enfocus PitStop Edit
2019。

客戶版本資訊
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Fiery XF

• 使用 VUTEk 捲對捲超大尺寸印表機，特殊設定 > 白色墨水列印 中的列印模式設定一律會變更回特別色
WHITE_INK。

• 當 Fiery server 系統語言設定為波蘭文時，裁切伺服器應用程式無法辨識合併列印工作。

Fiery Command WorkStation Package v6.5.0.433 已修正的問題
Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 支援 Windows 10 2004 版。

• 使用儲存為預設的 Fiery Impose 範本列印手冊工作時，有時不會套用封頁底材設定。

• 您有時會因為錯誤訊息指出應用程式已經開啟，而無法啟動 Fiery Impose、Fiery Compose 或 Fiery
JobMaster。此問題已經修復。

• 若您已經啟用多個授權，使用 Fiery 系統還原來還原 Fiery server 時無法還原授權啟用碼 (LAC)。此問
題已經修復。

Fiery XF

• 系統使用者名稱包含空格或特殊字元，導致 Job Editor 無法顯示工作預覽。

• 在義大利文系統上，將 Fiery Command WorkStation 6.5 升級到最新版本後，Job Editor 停止回應。

Fiery Command WorkStation Packagev6.5.0.367 已修正的問題
Fiery Command WorkStation

• 在某些語言中，使用 Fiery Compose 或 Fiery JobMaster 置於索引標籤上的文字，在電腦上檢視時可正確
顯示，但列印索引標籤時卻未顯示文字。

• 從 Fiery Compose 或 Fiery JobMaster 儲存含有在表單欄位所輸入資料的 PDF 表單時，預覽或列印的輸
出中均未顯示表單欄位。

• 如果將紙張大小從 241x330 公釐變更為 13x19 英寸，則無法以自訂紙張大小 241x330 公釐將校正集重新
校正。

• 如果在列印校正頁之後，將光譜儀連接到任何電腦，則無法量測校正頁。

Fiery XF

• 在某些 Windows 平台上，Job Editor 無法顯示工作預覽。

Fiery Command WorkStation Package v6.5.0.292 已修正的問題
Fiery Command WorkStation

• 安裝 Fiery Command WorkStation Package 6.5 後，在一些 Windows 電腦上，Arial 字體將顯示為斜體。

• 使用「預設值設定」功能定義的設定預設值不適用於「列印佇列」。

• 在 Fiery JobMaster 中，如果您在插入標籤或空白頁的 PDF 作業中插入或刪除頁面，書籤將移至不同的頁
面。

• 有時，使用非英語作業系統的 macOS 電腦會產生損壞的 IT8 測量資料。
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Fiery XF

• 在 Color Tools > 建立校正 > 灰色平衡，每次打開已保存的 EPL 檔案時，delta E 值都會改變

• 當 Fiery server 系統語言設置為波蘭文時，裁切伺服器應用將無法識別合併列印。

• 重新校準 Fiery XF 伺服器時，未應用在 伺服器管理員視窗中設置的預設工作流程。

Fiery Command WorkStation Package v6.5.0.171 SP1 中已修正的問題
• 在 Fiery Impose 中使用指定底材動作時，出現 sRGB 設定檔不正確的警告訊息。

Fiery Command WorkStation Package v6.5.0.171 已修正的問題
Fiery XF

• 無法為 EPSON SC-P75x0/SC-P95x0 RGB 建立基準線

• 無法為 EPSON SC-P75x0 與 SC-P95x0 選取標籤列印

• 無法校正使用 44 英寸底材的 EPSON 9500
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Примечания к выпуску для заказчика
Fiery Command WorkStation Package 6.5

Данный документ содержит важную информацию об этом выпуске. Обязательно предоставьте эту
информацию всем пользователям перед началом установки.

Об этом выпуске

В данный выпуск входят следующие приложения:

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Fiery Hot Folders 4.1.0.21 для Mac

• Fiery Hot Folders 4.1.0.21 для Windows

• Fiery Software Manager v4.4.0.18

Обновление

Эта программа установки обновит все существующие пакеты Fiery Command WorkStation Package до
новейшей версии пакета, содержащего Fiery Command WorkStation и Fiery Hot Folders. При необходимости
можно установить Fiery Remote Scan с помощью Fiery Software Manager.
Fiery Command WorkStation Package поддерживает серверы Fiery servers, работающие под управлением FS100
или более поздней версии, а также Fiery proServer и Fiery XF 7.0 или более поздних версий. Эта версия не
позволяет подключаться к следующим серверам.

• Серверы Fiery servers, работающие под управлением программного обеспечения Fiery System 9/9e Rel2,
System 10 и более ранних версий.

• Серверы Fiery XF 6.x и более ранние версии.

• Серверы Fiery Central.

Если вам необходим доступ к этим продуктам, не обновляйте версию. Пакет Fiery Extended Applications по-
прежнему доступен по адресу www.efi.com/cws. Полный список поддерживаемых листовых принтеров см. по
адресу http://fiery.efi.com/CWS/supported-printers.
Дополнительную информацию о технических характеристиках см. по адресу www.efi.com/cws.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


Новые функции

Новые возможности

Для получения дополнительной информации о новых функциях, добавленных в первоначальный выпуск
версии 6.5, перейдите по адресу http://fiery.efi.com/CWS/Whats-New.
Информацию о новых функциях, добавленных после первоначального выпуска версии 6.5, см. ниже.

Fiery Spot Pro

Fiery Command WorkStation6.5 позволяет управлять плашечными цветами с помощью функции Fiery Spot
Pro, которая заменила Fiery Spot-On. Полный список улучшений см. по адресу https://www.EFI.com/
spotpro.
Функция Fiery Spot Pro доступна для некоторых серверов, соответствующих следующим требованиям:

• FS200 Pro и более поздние версии программного обеспечения

• Fiery Graphic Arts Package, Premium Edition

Подробнее см. по адресу http://fiery.efi.com/spotpro/supported-printers.
Если на сервере Fiery server не включена функция Fiery Spot Pro, Fiery Command WorkStation будет по-
прежнему поддерживать Fiery Spot-On.

Рекомендации по использованию Fiery Spot Pro

• Не используйте символ "@" ни в каком имени плашечного цвета.

• После запуска Spot Pro подождите примерно 60–120 секунд, прежде чем использовать функцию
поиска или переключать выходные профили.

• Оптимизация плашечных цветов после нескольких итераций может привести к более выраженным
различиям между исходным плашечным цветом и преобразованным плашечным цветом.

• Существует небольшое числовое округление преобразованных значений L*a*b* и значений CMYK на
устройстве.

• Использование двух экземпляров Spot Pro в системах различных пользователей, подключенных к
одному серверу Fiery server, может привести к возникновению ошибок, если оба пользователя будут
выполнять операции редактирования.

Поддержка EFI ES-3000

Fiery Command WorkStation 6.5 поддерживает новый измерительный прибор EFI ES-3000 в режиме
эмуляции EFI ES-2000. EFI ES-3000 — это усовершенствованная версия EFI ES-2000, поддерживающая
измерение в один проход в режимах M1 и M2. Прибор EFI ES-3000 можно использовать при работе с
функциями Fiery Calibrator, Fiery Spot Pro и «Имитация бумаги» пакета Fiery Command WorkStation,
выбрав в пользовательском интерфейсе пункт «EFI ES-2000».

Примечание: Эмуляцию ES-2000 (пункт «EFI ES-2000» в пользовательском интерфейсе) также можно
использовать и при работе с прибором EFI ES-2000.
Информацию об использовании EFI ES-3000 с различными приложениями см. в документации к
соответствующим приложениям.
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Уведомления о лицензии на пакет опций Fiery

Уведомления о доступных обновлениях сервера теперь перечислены в новом разделе «Уведомления» в
Fiery Command WorkStation . Уведомления отображаются, когда срок действия лицензий на
установленные опции Fiery заканчивается или уже истек. Уведомления отображаются в Fiery Command
WorkStation, Fiery Hot Folders и Fiery WebTools.

Примечание: Чтобы просмотреть информацию об истечении срока действия лицензии, выберите
WebTools > Главная и Fiery Command WorkStation > Центр устройств > Общие > Общая информация.
Уведомления о сроках действия содержат следующие параметры.

• Продлить сейчас

• Отклонить

• Подробнее

Поддержка отчетов Fiery JobExpert

Fiery Command WorkStation 6.5 при наличии подключения к серверам FS400 позволяет выполнять
предварительный просмотр улучшений, внесенных в задание с помощью Fiery JobExpert.
Отчет Fiery JobExpert содержит обзор предлагаемых параметров заданий, которые применяются к
заданиям с помощью Fiery JobExpert.

Поддержка Adobe Acrobat Pro 2017 и Enfocus PitStop Edit 2019

Adobe Acrobat Pro 2017 и Enfocus PitStop Edit 2019 можно загрузить с помощью Fiery Software Manager.

Поддержка измерительных приборов в Fiery XF Color Editor

Поддерживаются следующие приборы для измерения одиночной зоны и оптимизации.

Измерительный прибор Одиночная зона Оптимизация

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

Поддержка переменной конечной точки светлой краски

Fiery XF позволяет настроить конечную точку светлой краски для экономии светлой краски в файлах
калибровки.
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Чтобы создать файл калибровки для экономии краски, уменьшите количество светлой краски. Для этого
измените значение Конечная точка светлой краски на вкладке Предел краскозаполнения и калибровки в
окне Color Tools.

Поддержка раскладки c 1617 метками (CGATS IT8.7/5)

Fiery XF поддерживает профильную диаграмму в Color Tools с 1617 метками.
Это целевая характеристика принтера CMYK, объединяющая уникальные значения зон стандарта IT8.7/4
со всеми значениями зон в столбцах 4 и 5 целевого значения P2P51.

Поддержка создания пользовательских наборов настроек Verifier в Server Manager

Вы можете создавать пользовательские наборы настроек в XF-Verifier в Server Manager.

Поддерживается сохранение местоположения папки файла резервной копии Hot Folder

При восстановлении папок быстрого доступа из файла резервной копии теперь можно сохранить
исходное местоположение папки, содержащей файл резервной копии.

Веб-приложения EFI IQ

Вы можете зарегистрировать веб-приложения EFI IQ на главном экране Command WorkStation. Веб-
приложения EFI IQ повышают наглядность печатного производства с помощью мощной аналитики
печати.

Обновление системных требований

Поддерживаемые версии

Fiery Command WorkStation поддерживает следующие операционные системы.

• macOS 11 (только с процессорами Intel)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10 (64-разрядная)

• Windows Server 2019 (64-разрядная)

• Windows Server 2016 (64-разрядная)

• Windows 8.1 (64-разрядная)

• Windows 7 (64-разрядная)

• Windows Server 2012 R2 (64-разрядная)

• Windows Server 2008 R2 (64-разрядная)
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Прекращение поддержки

• macOS 10.11

• macOS 10.12

• System 10 и более ранние версии

При обновлении Fiery Command WorkStation до версии 6.5 все ранее добавленные серверы System 10
будут удалены из списка серверов. При попытке выполнить вход на сервер Fiery server, работающий под
управлением System 10 или более ранней версии, будет невозможно использовать этот сервер, поскольку
поддерживается только сервер Fiery server, который работает под управлением FS100 или более поздней
версии.

64-разрядное приложение

Fiery Command WorkStation 6.5 (CWS) является собственным приложением 64-разрядной версии для
платформ macOS и Windows.
CWS 6.5 не поддерживает 32-разрядные операционные системы. Если ПО Fiery Software Manager уже
работает в 32-разрядной операционной системе, например 32-разрядной версии Windows 7, оно не будет
отображать уведомления об обновлениях для пакета CWS 6.5. При попытке установки этой версии Fiery
Software Manager в 32-разрядной операционной системе появится сообщение об ошибке совместимости
и Fiery Software Manager не запустится. Список поддерживаемых операционных систем см. по адресу 
http://fiery.efi.com/cws-specifications.

Поддержка подписки Adobe Acrobat DC для использования с Fiery Impose, Fiery Compose или
Fiery JobMaster

Fiery Command WorkStation Package v6.5.0.292 поддерживает использование копии Acrobat DC,
установленной на клиентском компьютере по индивидуальной или персональной подписке, при работе в
приложениях Fiery Impose, Fiery Compose и Fiery JobMaster.

Примечание: Для использования Acrobat в Fiery Impose, Fiery Compose или Fiery JobMaster необходимо,
чтобы на клиентском компьютере была установлена только одна копия Acrobat DC. Кроме того,
убедитесь, что на этом же клиентском компьютере не установлены другие версии Acrobat.

Известные проблемы

Представление читателя

Представление читателя было удалено в Fiery Impose, Fiery Compose, Fiery JobMaster и Fiery Preview на
macOS 11 и более поздней версии.

ImageEnhance Visual Editor

После полного открытия окна ImageEnhance Visual Editor на macOS 11 монитор может мерцать в течение
нескольких секунд.
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Преобразование PS в PDF

Если используется macOS 10.14.5 или более поздней версии с Fiery Impose, Fiery Compose или Fiery
JobMaster, может быть показан запрос на предоставление доступа Fiery Command WorkStation к Acrobat
Distiller. Это разрешение необходимо для преобразования файлов PS в PDF. Если разрешение не будет
предоставлено, преобразования не будут выполняться и потребуется изменить настройку безопасности
функции автоматизации в macOS.

1 Закройте все приложения Fiery.

2 Закройте Acrobat Distiller.

3 Перейдите в Системные настройки > Безопасность и конфиденциальность > Конфиденциальность >
Автоматизация.

4 Нажмите значок замка в нижнем левом углу и введите пароль.

5 В списке приложений найдите Fiery Command WorkStation.app.

6 Выберите параметр Acrobat Distiller.app.
Это позволит Fiery Command WorkStation получить доступ к Acrobat Distiller.

Информация о macOS 10.15 (Catalina)

Fiery Preview, Fiery Impose, Fiery Compose или Fiery JobMaster на macOS 10.15

Комплект приложений для поддержки PDF

Комплект приложений для поддержки PDF (предоставляемый компанией EFI), который состоит из
Adobe Acrobat и Enfocus PitStop, несовместим с macOS 10.15 (Catalina). При использовании Acrobat или
PitStop не обновляйте компьютер до macOS 10.15. Программа установки приложений для поддержки
PDF не запускается в новых версиях ОС.
Обновление до macOS 10.15 при использовании текущего комплекта приложений для поддержки PDF
может привести к следующим проблемам.

• Если приложение Acrobat DC было установлено перед обновлением до macOS 10.15, оно будет
работать в обычном режиме. Однако программа установки Acrobat DC несовместима с macOS 10.15,
поэтому новая установка Acrobat DC невозможна. Кроме того, поставляемое в комплекте
приложение Enfocus PitStop не поддерживается в macOS 10.15.

• Если приложение Acrobat XI было установлено перед обновлением до macOS 10.15, оно не будет
работать, так как не поддерживается в macOS 10.15. Рекомендуется удалить Acrobat XI перед
обновлением до macOS 10.15. Программа удаления Acrobat XI не будет работать в macOS 10.15,
поэтому при обновлении системы с установленным приложением Acrobat XI до версии macOS 10.15
такая система будет находиться в состоянии, в котором приложение Acrobat XI не будет работать и
его нельзя будет удалить.

Если совместимая версия Acrobat не установлена, возможны следующие проблемы.

• Функция Редактировать в Acrobat недоступна в Fiery Impose, Fiery Composeи Fiery JobMaster.

• Открытие задания PostScript с помощью Fiery Preview, Fiery Impose, Fiery Compose или Fiery JobMaster
может привести к ошибке.
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• Шаблоны Fiery Impose, использующие рабочие процессы Пользовательский формат после
заключительной обработки или На основе области обрезки, могут работать неправильно с заданиями
PostScript.

• Fiery Hot Folders не предоставляет возможность преобразования файлов PostScript в формат PDF.

Другие проблемы

При обновлении до версии macOS 10.15 с более старой версии macOS запуск Fiery Preview, Fiery Impose,
Fiery Compose или Fiery JobMaster может привести к появлению одного из следующих сообщений.

• Использование "ICUConverter.framework" приведет к повреждению компьютера. Его необходимо
переместить в корзину.

• Использование "ICUData.framework" приведет к повреждению компьютера. Его необходимо
переместить в корзину.

Система macOS 10.15 ошибочно идентифицирует эти файлы как вредоносные программы. Чтобы
устранить эту проблему, повторно установите Fiery Command WorkStation Package версии 6.4.0.396 или
более позднюю версию, которая совместима с macOS 10.15.
При наведении указателя мыши на значки элементов управления в Fiery Preview, Fiery Impose, Fiery
Compose или Fiery JobMaster подсказки не отображаются.

Полный доступ к диску

В результате изменений, внесенных в управление безопасностью macOS 10.15, появились
дополнительные шаги, необходимые для правильной работы приложений Fiery.
Чтобы приложения Fiery могли управлять обновлениями и получать доступ к таким файлам, как
шаблоны Impose и Hot Folders, в macOS необходимо внести изменения в функцию безопасности Полный
доступ к диску. Включите Полный доступ к диску для приложений Fiery, таких как Fiery Command
WorkStation.

1 Закройте все приложения Fiery.

2 Перейдите в Системные настройки > Безопасность и конфиденциальность > Конфиденциальность >
Полный доступ к диску.

3 Нажмите значок замка в нижнем левом углу и введите пароль.

4 Нажмите кнопку +.

5 В папке "Программы" выберите Fiery Software Manager и Fiery Software Uninstaller, а затем нажмите
Открыть.
Для обслуживания и обновления приложений Fiery этим приложениям требуется полный доступ к
диску.

6 В папке "Программы" выберите приложение Fiery Command WorkStation и нажмите Открыть.

7 Если используется Fiery Hot Folders или Fiery Remote Scan, выберите каждое приложение и нажмите
Открыть.
Когда Fiery Hot Folders обнаруживает, что используются папки "Документы", "Рабочий стол" или
"Загрузки", будет показано сообщение с запросом на полный доступ к диску. Это сообщение
отображается даже после предоставления доступа. Можно закрыть это сообщение и продолжить
работу.
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Ошибки браузера Safari в macOS 10.15

Если используется Safari в macOS 10.15, при попытке открыть следующие веб-страницы из Fiery
Command WorkStation будут возникать повторяющиеся ошибки браузера Центр устройств > Общие >
Инструменты:

• Восстановление системы Fiery

• Образ Fiery System

• Настройки и ресурсы Fiery

Такие ошибки также могут возникать при открытии Fiery WebTools в браузере Safari.
Для доступа к этим веб-страницам используйте браузеры Chrome или Firefox.

Fiery XF на macOS 10.15

Если вы используете Fiery XF на macOS 10.15, необходимо обновить Fiery Color Profiler Suite до версии
5.3.1. Начиная с Fiery Color Profiler Suite версии 5.3.1 приложение Fiery Verify, совместимое с macOS 10.15,
доступно пользователям Fiery XF в качестве средства проверки по умолчанию.
Приложение Color Verifier несовместимо с macOS 10.15, но по-прежнему работает на более ранних
версиях macOS. Однако для использования Color Verifier необходимо установить его отдельно. Загрузить
Color Verifier для macOS 10.14 и более ранних версий можно из центра загрузок.

Fiery Color Profiler Suite и Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) и более ранние версии не полностью совместимы с пакетом Fiery
Command WorkStation Package 6.5 (CWS) для листовых принтеров. Рекомендуется обновить программу
до версии Fiery Color Profiler Suite 5.1.
При использовании CPS 5.0 с CWS 6.5 могут возникнуть следующие проблемы.

• Если в CWS появилось сообщение «Подключите спектрофотометр к компьютеру», когда открыта
программа CPS, закройте CPS и нажмите ОК, чтобы продолжить.

• После создания новой настройки калибровки в калибраторе кнопка Создать новый профиль для
запуска CPS не отображается. Для решения этой проблемы необходимо выполнить обновление до
версии CPS 5.1.

Действие «Редактировать в Acrobat» в Fiery Impose, Fiery Compose или Fiery JobMaster
открывает два окна Acrobat

На компьютерах с Windows при выборе в Fiery Impose, Fiery Compose или Fiery JobMaster действия
Редактировать в Acrobat иногда открывается два окна Acrobat вместо одного. Это известная проблема.
Вы можете закрыть окно Adobe Acrobat и продолжить работу в окне с файлом PDF.

Настройка предпочтений в Adobe Acrobat Distiller для преобразования PostScript в PDF

В Fiery Impose, Fiery Compose и Fiery JobMaster для преобразования файлов PostScript (PS) в PDF на
клиентском компьютере требуется Acrobat Distiller.
Поскольку в Acrobat Distiller используются расширенные настройки безопасности, необходимо
подтвердить, что преобразуемый файл PS получен из надежного источника: Acrobat Distiller > Файл >
Предпочтения > Предпочтения — Acrobat Distiller, в разделе Защита выберите Все открытые в Acrobat
Distiller файлы надежные.
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Примечание: Если настройка Все открытые в Acrobat Distiller файлы надежные отключена, то для
каждого файла PS, преобразуемого в PDF, будет запрашиваться подтверждение надежности его
источника. Это также относится и к Hot Folders, если активен фильтр Microsoft Office, в списке Тип
выходного файла выбран формат PDF, а в качестве профиля Distiller используется файл joboptions.

Не удается запустить приложение Configure на компьютере с macOS

Если сервер Fiery server работает под управлением FS100, невозможно запустить приложение Configure в
следующих версиях операционной системы:

• mac10.14.6 и более поздние версии 10.14

• macOS 10.15 (все версии)

Для подключения к Fiery Command WorkStation используйте компьютер с более ранней версией macOS
или компьютер, работающий под управлением Windows.

Задержка при запуске Fiery Impose, Fiery Compose или Fiery JobMaster

Для запуска Fiery Impose, Fiery Compose и Fiery JobMaster может потребоваться больше времени, чем при
использовании предыдущих версий. Чтобы сократить время открытия этих приложений, сначала
запустите Fiery Preview, а затем приложение, которое необходимо использовать.

Проблемы, исправленные в Fiery Command WorkStation Package v6.5.0.599

Fiery Command WorkStation

• Результаты измерений с помощью спектрофотометра ES-3000 оказались не точными.

Проблемы, исправленные в Fiery Command WorkStation Package v6.5.0.581

Fiery Command WorkStation

• При использовании входного формата TIFF в Fiery Hot Folders параметры позиционирования
изображения некорректно применялись для нескольких языков.

• Fiery Command WorkStation Package 6.5 поддерживает Windows 10 версии 20H2.

Fiery XF

• Если вы добавляете сервер Fiery XF с включенным предпочтением Сохранить пароль и перезапустите
сервер Fiery XF, то не удается запустить Fiery Command WorkStation Package.
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Проблемы, исправленные в Fiery Command WorkStation Package v6.5.0.563

Fiery Command WorkStation

• На компьютерах с японским языком при входе в систему с использованием недавно созданной учетной
записи администратора не удавалось открыть Fiery Spot Pro.

Fiery XF

• В Центре заданий Fiery Command WorkStation в столбце Состояние задания было указано, что проверка
завершилась неудачно даже при успешном выполнении всех тестов задания в Fiery Verify.

• В Центре заданий в Fiery Command WorkStation, если состояние вложенного задания было На проверку,
приложение Fiery Verify не запускалось при нажатии Проверить на панели Сводная информация о задании
родительского задания. Приложение Fiery Verify запускается, если нажать Оптимизировать или Сведения
на панели Сводная информация о задании дочернего задания.

Проблемы, исправленные в Fiery Command WorkStation Package v6.5.0.539

Fiery Command WorkStation

• После обработки задания PPML со спуском полос и шаблоном «4 на страницу» некоторые страницы
задания не отображаются в Fiery ImageViewer.

Fiery XF

• Невозможно указать значение больше 59,4 см для параметра «Настраиваемая ширина» в Command
WorkStation Server Manager > Компоновка > Шаг и повтор > Рисунок.

Проблемы, исправленные в Fiery Command WorkStation Package v6.5.0.512

Fiery Command WorkStation

• В системе на японском языке Fiery server переставал отвечать при печати задания, которое было
отредактировано с помощью Fiery ImageViewer.

• Отображаемые поля ввода задания в режиме каркаса в Fiery Impose теперь выровнены с каркасами.

Fiery XF

• При изменении имени носителя или привязке файла калибровки (*.EPL) к профилю носителя с другим
именем в Color Tools > Подключение профилей, информация о совместимых принтерах удалялась из
файла калибровки (*.EPL).

• Вы не смогли сохранить настройки области клея в редакторе работы - Overlap/Glue.

• XF 7.2 поддерживает приборы измерения X-Rite i1Pro3 и EFI ES-3000 на компьютерах под управлением
macOS.
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Ошибки, исправленные в Fiery Command WorkStation Package v 6.5.0.475

Fiery Command WorkStation

• В Fiery Spot Pro теперь можно задавать значения цветоделения для плашечных цветов и замещающих
цветов одним десятичным разрядом.

• В Fiery Spot Pro параметр Восстановить заводские настройки теперь отключен для плашечных цветов в
дублированной группе.

• Вы можете переустановить и активировать Adobe Acrobat Pro 2017 и Enfocus PitStop Edit 2019 из Fiery
Software Manager.

Fiery XF

• При использовании сверхширокоформатных рулонных принтеров VUTEk параметр режима печати в
разделе Специальные настройки > Печать белой краской всегда возвращался к значению "Плашечный
цвет: WHITE_INK".

• При использовании польского в качестве системного языка Fiery server приложение Cut Server не
распознавало вложенные задания.

Проблемы, исправленные в Fiery Command WorkStation Package v6.5.0.433

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 поддерживает Windows 10 версии 2004.

• При печати брошюры с использованием шаблона Fiery Impose, сохраненного в качестве шаблона задания,
иногда параметр материала для печати обложки не применялся.

• Иногда вам не удавалось запустить Fiery Impose, Fiery Compose или Fiery JobMaster, потому что получали
ложное сообщение об ошибке, в котором указывалось, что приложение уже открыто. Эта ошибка
исправлена.

• При активации нескольких лицензий невозможно восстановить коды активации лицензии (LAC) во
время восстановления Fiery server с помощью Fiery System Restore. Эта ошибка исправлена.

Fiery XF

• Имя пользователя системы, содержащее пробел или специальные символы, приводило к тому, что в
приложении Job Editor не отображался предварительный просмотр задания.

• В системе с итальянским языком после обновления Fiery Command WorkStation 6.5 до последней версии
приложение Job Editor перестает отвечать.

Проблемы, исправленные в Fiery Command WorkStation Package v6.5.0.367

Fiery Command WorkStation

• Текст на некоторых языках при размещении на разделителях с помощью Fiery Compose или Fiery
JobMaster отображался правильно на компьютере, но отсуствовал при печати разделителей.

• Если PDF-формы с введенными данными были сохранены в Fiery Compose или Fiery JobMaster, поля форм
не отображались в окне Предварительный просмотр и при печати.
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• Невозможно повторно откалибровать набор калибровки с пользовательским форматом бумаги 241 x 330
мм, если формат бумаги был изменен с 241 x 330 мм на 13 x 19 дюймов.

• Невозможно измерить страницу калибровки, если спектрофотометр был подключен к компьютеру после
печати страницы калибровки.

Fiery XF

• На некоторых платформах Windows не отображается предварительный просмотр заданий в Job Editor.

Проблемы, исправленные в Fiery Command WorkStation Package v6.5.0.292

Fiery Command WorkStation

• На некоторых компьютерах под управлением Windows шрифт Arial после установки Fiery Command
WorkStation Package 6.5 отображался курсивом.

• Настройки, установленные при помощи функции «Задать значения по умолчанию», не распространялись
на очередь последовательной печати.

• В Fiery JobMaster изменение числа страниц в задании типа PDF при вставке разделителя или пустого
листа приводило к тому, что закладки (если они присутствовали в задании) перемещались на соседние
страницы.

• На компьютерах под управлением macOS использование языка системы, отличного от английского,
иногда приводило к тому, что данные измерений IT8 генерировались с ошибками.

Fiery XF

• В окне Color Tools > Создать калибровку > Баланс серогозначения дельта E изменялись каждый раз при
открытии сохраненного файла EPL

• При использовании польского в качестве системного языка Fiery server приложение Cut Server не
распознавало вложенные задания.

• При повторной калибровке сервера Fiery XF не применялся рабочий процесс по умолчанию, выбранный в
окне Server Manager.

Проблемы, исправленные в Fiery Command WorkStation Package v6.5.0.171 SP1

• При выполнении действия Назначить материал для печати в Fiery Impose отображается сообщение,
предупреждающее об использовании неправильного профиля sRGB.

Проблемы, исправленные в Fiery Command WorkStation Package v6.5.0.171

Fiery XF

• Не удается создать базовую линию для EPSON SC-P75x0/SC-P95x0 RGB

• Не удается выбрать печать этикеток для EPSON SC-P75x0 и SC-P95x0

• Не удается выполнить калибровку EPSON 9500 с использованием материала для печати шириной 44
дюйма

Примечания к выпуску для заказчика
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Niniejszy dokument zawiera ważne informacje dotyczące tej wersji. Informacje te należy koniecznie przekazać
wszystkim użytkownikom przed kontynuowaniem instalacji.

Informacje dotyczące tej wersji

W tej wersji dostępne są następujące aplikacje:

• Fiery Command WorkStation Package w wersji 6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Fiery Hot Folders 4.1.0.21 dla komputerów Mac

• Fiery Hot Folders 4.1.0.21 dla systemu Windows

• Fiery Software Manager w wersji 4.4.0.18

Uaktualnianie

Za pomocą tego instalatora można uaktualnić dowolny istniejący pakiet Fiery Command WorkStation Package do
najnowszej wersji zawierającej aplikacje Fiery Command WorkStation oraz Fiery Hot Folders. Można także
zainstalować program Fiery Remote Scan przy użyciu narzędzia Fiery Software Manager.
Fiery Command WorkStation Package obsługuje Fiery servers z zainstalowanym oprogramowaniem FS100 lub
nowszym, a także serwery Fiery proServer i Fiery XF 7.0 lub nowsze. Brak możliwości łączenia z serwerami:

• Fiery servers z zainstalowanym oprogramowaniem Fiery System 9/9e Rel2 oraz System 10 i starszymi wersjami

• Serwery Fiery XF 6.x i wcześniejsze

• Serwery Fiery Central

Jeżeli musisz korzystać z tych produktów, nie dokonuj uaktualnienia. Pakiet Fiery Extended Applications jest nadal
dostępny na stronie www.efi.com/cws. Pełną listę obsługiwanych arkuszowych maszyn cyfrowych można znaleźć na
stronie http://fiery.efi.com/CWS/supported-printers.
Więcej informacji na temat specyfikacji technicznych można znaleźć na stronie www.efi.com/cws.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


Nowe funkcje

Co nowego?

Aby uzyskać informacje na temat nowych funkcji dodanych w początkowym wydaniu wersji 6.5, odwiedź
witrynę http://fiery.efi.com/CWS/Whats-New.
Aby uzyskać informacje na temat nowych funkcji dodanych po początkowym wydaniu wersji 6.5, zapoznaj się z
poniższymi informacjami.

Fiery Spot Pro

Oprogramowanie Fiery Command WorkStation 6.5 umożliwia zarządzanie kolorami dodatkowymi za pomocą
aplikacji Fiery Spot Pro, która zastępuje aplikację Fiery spot-on. Aby zobaczyć pełną listę ulepszeń, odwiedź
stronę https://www.EFI.com/spotpro.
Aplikacja Fiery Spot Pro jest dostępna dla wybranych kontrolerów spełniających następujące wymagania:

• Oprogramowanie FS200 Pro lub nowsze

• Fiery Graphic Arts Package, Premium Edition

Więcej informacji jest dostępnych pod adresem http://fiery.efi.com/spotpro/supported-printers.
Jeżeli kontroler Fiery server nie ma włączonej aplikacji Fiery Spot Pro, oprogramowanie Fiery Command
WorkStation będzie nadal obsługiwać aplikację Fiery Spot-On.

Zagadnienia dotyczące korzystania z aplikacji Fiery Spot Pro

• Nie należy umieszczać symbolu „@” w nazwach kolor dodatkowych.

• Po uruchomieniu aplikacji Spot Pro należy odczekać około 60–120 sekund przed skorzystaniem z funkcji
wyszukiwania lub przełączeniem profili wydruku.

• Optymalizacja kolorów dodatkowych po wykonaniu kilku iteracji może spowodować powstanie wyraźnych
różnic między pierwotnym kolorem dodatkowym a skonwertowanym kolorem dodatkowym.

• Skonwertowane wartości numeryczne L*a*b* i wartości CMYK urządzenia są lekko zaokrąglane.

• Dwa wystąpienia aplikacji Spot Pro używane w różnych systemach łączących się z tym samym kontrolerem
druku Fiery server mogą powodować błędy, jeśli obaj użytkownicy wykonują operacje edycji.

Obsługa urządzenia EFI ES-3000

Nowy przyrząd pomiarowy EFI ES-3000 jest obsługiwany w drodze emulacji EFI ES-2000 w programie Fiery
Command WorkStation 6.5. EFI ES-3000 to uaktualniona wersja spektrofotometru EFI ES-2000, która obsługuje
pomiar przy jednym skanowaniu w trybach skanowania M1 i M2. Możesz użyć przyrządu EFI ES-3000
(wybierając pozycję „EFI ES-2000” w interfejsie użytkownika) z narzędziem Fiery Calibrator, Fiery Spot Pro i
funkcjami Symulacji papieru w programie Fiery Command WorkStation.

Uwaga: Emulacji urządzenia ES-2000 (pozycja „EFI ES-2000” w interfejsie użytkownika) można używać także
razem ze spektrofotometrem EFI ES-2000.
Aby uzyskać informacje dotyczące użytkowania urządzenia EFI ES-3000 z różnymi aplikacjami, należy zapoznać
się z dokumentacją dostarczoną z danym oprogramowaniem.
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Powiadomienia dotyczące licencji pakietu opcji Fiery

Powiadomienia o dostępnych aktualizacjach serwera są teraz wyświetlane w nowej sekcji Powiadomienia w
aplikacji Fiery Command WorkStation. Powiadomienia są wyświetlane, gdy licencje zainstalowanych opcji Fiery
wkrótce wygasną lub już wygasły. Powiadomienia są wyświetlane w oprogramowaniu Fiery Command
WorkStation, Fiery Hot Folders i Fiery WebTools.

Uwaga: Informacje o wygaśnięciu licencji można wyświetlić w dowolnym momencie po wybraniu kolejno opcji
WebTools > Strona główna oraz Fiery Command WorkStation > Centrum urządzeń > Ogólne > Informacje
ogólne.
W powiadomieniach o wygaśnięciu dostępne są następujące opcje:

• Odnów teraz

• Zamknij

• Dowiedz się więcej

Obsługa raportu aplikacji Fiery JobExpert

Nawiązanie połączenia między Fiery Command WorkStation 6.5 a serwerami FS400 umożliwia wyświetlanie
podglądu ulepszeń wprowadzonych do zadania za pomocą aplikacji Fiery JobExpert.
Raport aplikacji Fiery JobExpert zawiera podsumowanie proponowanych ustawień właściwości zadania
zastosowywanych do zadań za pomocą aplikacji Fiery JobExpert.

Obsługa oprogramowania Adobe Acrobat Pro 2017 i Enfocus PitStop Edit 2019

Opcjonalne oprogramowanie Adobe Acrobat Pro 2017 i Enfocus PitStop Edit 2019 można pobrać w aplikacji
Fiery Software Manager.

Obsługa przyrządów pomiarowych w aplikacji Fiery XF Color Editor

Obsługiwane są następujące pojedyncze przyrządy do pomiarów i optymalizacji pojedynczych pól kontrolnych:

Przyrząd pomiarowy Pojedyncze pole kontrolne Optymalizacja

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3 *

Obsługa zmiennej punktu końcowego jasnego tuszu

Fiery XF umożliwia skonfigurowanie punktu końcowego jasnego tuszu w celu oszczędzania jasnego tuszu w
plikach kalibracji.
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Aby utworzyć plik kalibracji oszczędzający jasny tusz, zmniejsz ilość jasnego tuszu, zmieniając wartość punktu
końcowego jasnego tuszu w zakładce Limit tuszu i kalibracja w aplikacji Color Tools.

Obsługa układu pól kontrolnych 1617 (CGATS IT8.7/5)

Fiery XF obsługuje tabelę profilowania w module Color Tools z 1617 polami kontrolnymi.
Jest to docelowa charakterystyka maszyny drukarskiej CMYK, która łączy unikalne wartości pól kontrolnych w
standardowym elemencie docelowym IT8.7/4 z wszystkimi wartościami pól kontrolnych w kolumnach 4 i 5
wartości docelowej P2P51.

Obsługa tworzenia własnych ustawień wstępnych w programie Verifier z poziomu narzędzia Server
Manager

Własne ustawienia wstępne można tworzyć w programie XF-Verifier z poziomu narzędzia Server Manager.

Obsługa zachowania lokalizacji folderów w pliku kopii zapasowej Hot Folder

W przypadku przywracania Hot Folders z pliku kopii zapasowej można teraz zachować oryginalne lokalizacje
folderów w pliku kopii zapasowej.

Aplikacje internetowe EFI IQ

Aplikacje internetowe EFI IQ można zarejestrować na ekranie Strona główna aplikacji Command WorkStation .
Aplikacje internetowe EFI IQ zapewniają wgląd w produkcję drukarską dzięki zaawansowanej analizie procesu
drukowania.

Aktualizacje wymagań systemowych

Obsługiwane wersje

Aplikacja Fiery Command WorkStation obsługuje następujące systemy operacyjne:

• macOS 11 (tylko z procesorami firmy Intel)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10, wersja 64-bitowa

• Windows Server 2019, wersja 64-bitowa

• Windows Server 2016, wersja 64-bitowa

• Windows 8.1, wersja 64-bitowa

• Windows 7, wersja 64-bitowa

• Windows Server 2012 R2, wersja 64-bitowa

• Windows Server 2008 R2, wersja 64-bitowa
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Wsparcie wycofane

• MacOS 10.11

• MacOS 10.12

• System 10 i wcześniejsze

Po aktualizacji Fiery Command WorkStation do wersji 6.5 wszystkie wcześniej dodane serwery System 10
zostaną usunięte z listy serwerów. Jeśli spróbujesz zalogować się na serwer Fiery server z Systemem 10 lub
wcześniejszym, nie będziesz w stanie z niego korzystać, ponieważ obsługiwane są tylko serwery Fiery server z
oprogramowaniem FS100 lub nowszym.

Aplikacja 64-bitowa

Fiery Command WorkStation 6.5 (CWS) to natywna aplikacja 64-bitowa na urządzenia z systemami Mac OS i
Windows.
32-bitowe systemy operacyjne nie są obsługiwane w wersji CWS 6.5. Jeśli Fiery Software Manager działa już w
32-bitowym systemie operacyjnym, takim jak 32-bitowy Windows 7, nie będą wyświetlane powiadomienia o
aktualizacji dla pakietu CWS 6.5. W przypadku próby zainstalowania tej wersji Fiery Software Manager w 32-
bitowym systemie operacyjnym zostanie wyświetlony błąd zgodności, a program Fiery Software Manager nie
zostanie uruchomiony. Informacje na temat obsługiwanych systemów operacyjnych można znaleźć pod adresem 
http://fiery.efi.com/cws-specifications.

Obsługa subskrypcji Adobe Acrobat DC na potrzeby korzystania z programu Fiery Impose, Fiery
Compose lub Fiery JobMaster

Aplikacja Fiery Command WorkStation Package w wersji 6.5.0.292 obsługuje korzystanie z indywidualnych/
osobistych subskrypcji oprogramowania Acrobat DC zainstalowanych na komputerze klienckim w celu użycia
go w programie Fiery Impose, Fiery Compose lub Fiery JobMaster.

Uwaga: Aby korzystać z programu Acrobat z poziomu aplikacji Fiery Impose, Fiery Compose lub Fiery
JobMaster, należy zainstalować tylko jedną instancję oprogramowania Acrobat DC na komputerze klienckim.
Ponadto należy upewnić się, że inne wersje oprogramowania Acrobat nie są zainstalowane na tym samym
komputerze klienckim.

Znane problemy

Widok czytnika

W aplikacjach Fiery Impose, Fiery Compose, Fiery JobMaster oraz Fiery Preview działających w systemie macOS
11 lub nowszym usunięto Widok czytnika.

ImageEnhance Visual Editor

Po zmaksymalizowaniu okna edytora ImageEnhance Visual Editor w systemie macOS 11 monitor może migać
przez kilka sekund.
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Konwersja plików PS do PDF

W przypadku korzystania z systemu macOS 10.14.5 lub nowszego z oprogramowaniem Fiery Impose, Fiery
Compose lub Fiery JobMaster, może zostać wyświetlony monit o zezwolenie aplikacji Fiery Command
WorkStation na dostęp do programu Acrobat Distiller. To zezwolenie jest niezbędne do konwersji plików PS do
formatu PDF. Jeśli nie udzieli się tego zezwolenia, konwersje nie powiodą się i będzie konieczna zmiana funkcji
zabezpieczającej Automatyzacja w systemie macOS.

1 Zamknij wszystkie aplikacje Fiery.

2 Zamknij program Acrobat Distiller.

3 Przejdź do Preferencje systemowe > Bezpieczeństwo i prywatność > Prywatność > Automatyzacja.

4 Kliknij ikonę kłódki w lewym dolnym rogu i wprowadź swoje hasło.

5 Na liście Aplikacje znajdź Fiery Command WorkStation.app.

6 Wybierz opcję Acrobat Distiller.app.
Dzięki temu oprogramowanie Fiery Command WorkStation będzie miało dostęp do programu Acrobat
Distiller.

Informacje o systemie macOS 10.15 (Catalina)

Podgląd Fiery, Fiery Impose, Fiery Compose lub Fiery JobMaster w systemie macOS 10.15

Zestaw aplikacji do obsługi formatu PDF

Zestaw aplikacji do obsługi formatu PDF (dostarczany przez firmę EFI), który składa się z programów Adobe
Acrobat i Enfocus PitStop, nie jest zgodny z systemem macOS 10.15 (Catalina). W przypadku korzystania z
oprogramowania Acrobat i/lub PitStop nie należy przeprowadzać aktualizacji systemu macOS do wersji 10.15.
W przypadku nowych instalacji nie jest uruchamiany instalator aplikacji do obsługi formatu PDF.
Aktualizacja systemu macOS do wersji 10.15 podczas korzystania z aktualnego zestawu aplikacji do obsługi
formatu PDF może spowodować następujące problemy:

• Jeżeli oprogramowanie Acrobat DC jest już zainstalowane przed uaktualnieniem systemu macOS do wersji
10.15, będzie ono działać normalnie. Jednak instalator programu Acrobat DC nie jest zgodny z systemem
macOS 10.15, dlatego nowe instalacje programu Acrobat DC nie są możliwe. Ponadto dołączony program
Enfocus PitStop nie jest obsługiwany przez system macOS 10.15.

• Jeżeli oprogramowanie Acrobat XI zostało już zainstalowane przed uaktualnieniem systemu macOS do
wersji 10.15, nie będzie ono działać i nie jest obsługiwane przez system macOS 10.15. Przed uaktualnieniem
systemu macOS do wersji 10.15 zaleca się odinstalowanie oprogramowania Acrobat XI. Program Acrobat XI
Uninstaller nie będzie działać w systemie macOS 10.15, więc w przypadku uaktualnienia systemu macOS do
wersji 10.15 z zainstalowanym programem Acrobat XI system znajdzie się w stanie, w którym program
Acrobat XI nie działa i nie można go odinstalować.

Jeżeli nie zainstalowano zgodnej wersji programu Acrobat, pojawiają się następujące problemy:

• Funkcja Edytuj w programie Acrobat jest niedostępna w programach Fiery Impose, Fiery Compose i Fiery
JobMaster.

• Otwarcie zadania PostScript za pomocą programu Podgląd Fiery, Fiery Impose, Fiery Compose lub Fiery
JobMaster może spowodować wystąpienie błędu.
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• Szablony programu Fiery Impose opierające się na kolejności zadań Rozmiar wykańczania definiowany przez
użytkownika lub Zależnie od pola przycinania mogą nie działać prawidłowo w przypadku zadań PostScript.

• Fiery Hot Folders nie umożliwia konwersji plików PostScript na format PDF.

Inne problemy

Uruchomienie programu Podgląd Fiery, Fiery Impose, Fiery Compose lub Fiery JobMaster po uaktualnieniu
systemu macOS do wersji 10.15 może spowodować wyświetlenie jednego z następujących komunikatów:

• „ICUConverter.framework” spowoduje uszkodzenie komputera. Należy przenieść go do kosza.

• „ICUData.framework” spowoduje uszkodzenie komputera. Należy przenieść go do kosza.

System macOS 10.15 błędnie identyfikuje te pliki jako złośliwe oprogramowanie. Aby rozwiązać te problemy,
należy ponownie zainstalować oprogramowanie Fiery Command WorkStation Package w wersji 6.4.0.396 lub
nowszej, która jest zgodna z systemem macOS 10.15.
Po umieszczeniu wskaźnika myszy nad przyciskami dowolnych ikon sterowania w programie Podgląd Fiery,
Fiery Impose, Fiery Composelub Fiery JobMaster etykietki narzędzi nie są wyświetlane.

Pełny dostęp do dysku

Ze względu na zmiany w sposobie zarządzania zabezpieczeniami w systemie macOS 10.15 istnieją teraz
dodatkowe kroki wymagane do poprawnego działania aplikacji Fiery.
Konieczne jest dokonanie zmian w funkcji zabezpieczenia Pełny dostępu do dysku w systemie macOS, aby
aplikacje Fiery zarządzały aktualizacjami i uzyskiwały dostęp do plików, takich jak szablony Impose i foldery
podręczne. Włącz pełny dostęp do dysku dla aplikacji Fiery, w tym Fiery Command WorkStation.

1 Zamknij wszystkie aplikacje Fiery.

2 Przejdź do Preferencje systemowe > Bezpieczeństwo i prywatność > Prywatność > Pełny dostęp do dysku.

3 Kliknij ikonę kłódki w lewym dolnym rogu i wprowadź swoje hasło.

4 Kliknij przycisk +.

5 W folderze Aplikacje wybierz Fiery Software Manager i Fiery Software Uninstaller, a następnie kliknij
Otwórz.
Aplikacje te wymagają pełnego dostępu do dysku w celu utrzymania i zaktualizowania aplikacji Fiery na
komputerze.

6 W folderze Aplikacje wybierz aplikację Fiery Command WorkStation i kliknij Otwórz.

7 Jeżeli korzystasz z Fiery Hot Folders lub Fiery Remote Scan, wybierz każdą aplikację i kliknij Otwórz.
Jeśli Fiery Hot Folders wykryje, że używane są foldery Dokumenty, Pulpit i Pobrane, zostanie wyświetlony
komunikat z prośbą o pełny dostęp do dysku. Ten komunikat jest nadal wyświetlany nawet po przydzieleniu
dostępu. Można zignorować ten komunikat i kontynuować pracę.
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Błędy przeglądarki Safari w systemie macOS 10.15

Jeżeli korzystasz z przeglądarki Safari w systemie macOS 10.15, podczas próby otwarcia następujących stron
sieci Web z poziomu aplikacji Fiery Command WorkStation pojawią się powtarzalne błędy. Centrum urządzeń >
Ogólne > Narzędzia:

• Przywracanie systemu Fiery

• Obraz systemu Fiery

• Zasoby i ustawienia Fiery

Te błędy mogą również wystąpić po otwarciu narzędzi Fiery WebTools w przeglądarce Safari.
Aby uzyskać dostęp do tych stron, należy skorzystać z przeglądarki Chrome lub Firefox.

Fiery XF w systemie macOS 10.15

W przypadku korzystania z programu Fiery XF na systemie macOS 10.15 należy przeprowadzić uaktualnienie
pakietu Fiery Color Profiler Suite do wersji 5.3.1. Dzięki wersji 5.3.1 pakietu Fiery Color Profiler Suite, aplikacja
Fiery Verify zgodna z systemem macOS 10.15 jest teraz dostępna dla użytkowników Fiery XF jako domyślna
aplikacja weryfikacyjna.
Aplikacja Color Verifier nie jest zgodna z systemem macOS 10.15, jednak jest nadal obsługiwana przez starsze
wersje systemu macOS. Należy jednak zainstalować osobno program Color Verifier. Pobierz aplikację Color
Verifier dla systemu macOS w wersji 10.14 i wcześniejszych z centrum pobierania.

Fiery Color Profiler Suite i Fiery Command WorkStation 6.5

Pakiet Fiery Color Profiler Suite 5.0 (CPS) i starsze wersje nie są w pełni zgodne z oprogramowaniem Fiery
Command WorkStation Package 6.5 (CWS) dla arkuszowych maszyn cyfrowych. Zaleca się aktualizację do
pakietu Fiery Color Profiler Suite 5.1.
W przypadku korzystania z programu CPS 5.0 z programem CWS 6.5 mogą wystąpić następujące problemy:

• Jeśli w programie CWS jest wyświetlany komunikat „Podłącz spektrofotometr do komputera”, gdy pakiet
CPS jest otwarty, należy zamknąć pakiet CPS i kliknąć przycisk OK, aby kontynuować.

• Po utworzeniu nowego ustawienia kalibracji w narzędziu Kalibrator przycisk Utwórz nowy profil pozwalający
uruchomić pakiet CPS jest ukryty. Ten problem został rozwiązany po uaktualnieniu do wersji CPS 5.1.

Opcja Edytuj w programie Acrobat z Fiery Impose, Fiery Compose lub Fiery JobMaster otwiera dwa
okna programu Acrobat

W przypadku komputerów z systemem Windows, gdy opcja Edytuj w programie Acrobat jest wybrana w
programie Fiery Impose, Fiery Compose lub Fiery JobMaster, program Acrobat może zostać otwarty w dwóch
oknach zamiast jednego. Jest to znany problem. Okno programu Adobe Acrobat można zamknąć i kontynuować
pracę w oknie z plikiem PDF.

Konfigurowanie preferencji w programie Adobe Acrobat Distiller w celu konwersji formatu
PostScript do PDF

Aplikacje Fiery Impose, Fiery Compose i Fiery JobMaster wymagają programu Acrobat Distiller do
konwertowania plików PostScript (PS) na pliki PDF na komputerze klienckim.
Ze względu na rozszerzone ustawienia zabezpieczeń w programie Acrobat Distiller należy potwierdzić, że plik
PS do konwersji pochodzi z zaufanego źródła. W sekcji: Acrobat Distiller > Plik > Preferencje > Preferencje —
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Acrobat Distillerwybierz opcję Zaufaj wszystkim plikom otwartym za pośrednictwem programu Acrobat Distiller
w obszarze Zabezpieczenia.

Uwaga: Jeśli nie wybrano opcji Ufaj wszystkim plikom otwieranym za pośrednictwem programu Acrobat
Distiller, monit o potwierdzenie, że plik pochodzi z zaufanego źródła będzie wyświetlany dla każdego pliku PS,
który ma zostać skonwertowany do formatu PDF. Dotyczy to również aplikacji Hot Folders, gdy wybrany jest
filtr Microsoft Office, Typ pliku wydruku określono jako PDF, a plik joboptions wybrano jako profil Distiller.

Nie można uruchomić programu Configure na komputerze z systemem macOS

Jeśli Fiery server działa z systemem FS100, programu Configure nie można uruchomić z następującymi wersjami
systemu operacyjnego:

• macOS 10.14.6 i późniejsze wersje systemu 10.14

• macOS 10.15 (wszystkie wersje)

Aby się połączyć z Fiery Command WorkStation, należy skorzystać z komputera z wcześniejszą wersją systemu
macOS lub z systemem Windows.

Opóźnienie podczas uruchamiania Fiery Impose, Fiery Compose lubFiery JobMaster

Uruchamianie oprogramowania Fiery Impose, Fiery Compose i Fiery JobMaster może trwać dłużej niż w
poprzednich wersjach. Aby skrócić czas otwierania jednej z tych aplikacji, najpierw uruchom Fiery Preview, a
następnie aplikację, której chcesz używać.

Problemy rozwiązane w aplikacji Fiery Command WorkStation Package w wersji
6.5.0.599

Fiery Command WorkStation

• Wyniki pomiarów spektrofotometrem ES-3000 nie były dokładne.

Problemy rozwiązane w wersji 6.5.0.581 aplikacji Fiery Command WorkStation
Package

Fiery Command WorkStation

• W przypadku korzystania z formatu wejściowego TIFF w aplikacji Fiery Hot Folders ustawienia pozycjonowania
obrazu nie były prawidłowo stosowane dla kilku języków.

• Pakiet Fiery Command WorkStation Package 6.5 obsługuje system Windows 10 w wersji 20H2.

Fiery XF

• Po dodaniu kontrolera Fiery XF z włączoną preferencją Zapisz hasło i ponownym uruchomieniu kontrolera Fiery
XF pakiet Fiery Command WorkStation Package nie uruchamia się pomyślnie.
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Problemy rozwiązane w wersji 6.5.0.563 aplikacji Fiery Command WorkStation
Package

Fiery Command WorkStation

• Po zalogowaniu się za pomocą nowo utworzonego konta administratora w systemie w języku japońskim nie
można otworzyć aplikacji Fiery Spot Pro.

Fiery XF

• W Centrum zadań Fiery Command WorkStation kolumna Stan zadania raportuje, że weryfikacja nie powiodła
się, nawet jeśli zadanie przeszło wszystkie testy w aplikacji Fiery Verify.

• Jeśli w Centrum zadań Fiery Command WorkStation zadaniu zagnieżdżonemu został przypisany stan Do
sprawdzenia, oznacza to, że aplikacja Fiery Verify nie została uruchomiona po kliknięciu przycisku Sprawdź w
okienku Podsumowanie zadania zadania nadrzędnego. Aplikacja Fiery Verify otwiera się po kliknięciu przycisku
Optymalizuj lub Szczegóły w okienku Podsumowanie zadania zadania podrzędnego.

Problemy rozwiązane w wersji 6.5.0.539 aplikacji Fiery Command WorkStation
Package

Fiery Command WorkStation

• Po impozycji zadania PPML z szablonem 4-up i przetworzeniu go, niektóre strony w zadaniu nie były
wyświetlane w Fiery ImageViewer .

Fiery XF

• Nie można było określić wartości większej niż 59,4 cm dla ustawienia Szerokość niestandardowa w Command
WorkStation Server Manager > Układ > Twórz wiele kopii > Wzór.

Problemy rozwiązane w wersji 6.5.0.512 aplikacji Fiery Command WorkStation
Package

Fiery Command WorkStation

• W systemach w języku japońskim podczas drukowania zadań edytowanych przy użyciu aplikacji Fiery
ImageViewer kontroler Fiery server przestawał odpowiadać.

• Wyświetlane pola edycji zadania w podglądzie szkieletowym w programie Fiery Impose są teraz wyrównane z
krawędziami.

Fiery XF

• Jeśli zmieniono nazwę nośnika lub skojarzono plik kalibracji (*.EPL) z profilem nośnika o innej nazwie w
profilach Color Tools > Profile Connect, informacje o kompatybilnej drukarce zostawały usunięte z pliku
kalibracji (*.EPL).

• Nie można było zapisać ustawienia Obszar klejony w opcji Job Editor > Zachodzenie/klejenie.

• XF 7.2 obsługuje przyrządy pomiarowe X-Rite i1Pro3 i EFI ES-3000 na komputerach z systemem macOS.
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Problemy rozwiązane w wersji 6.5.0.475 aplikacji Fiery Command WorkStation
Package

Fiery Command WorkStation

• Teraz w aplikacji Fiery Spot Pro można określić wartości oddzielania dla kolorów dodatkowych i kolorów
zastępczych z dokładnością do jednego miejsca po przecinku.

• W aplikacji Fiery Spot Pro opcja Przywróć ustawienia fabryczne jest teraz wyłączona w przypadku kolorów
dodatkowych w zduplikowanej grupie.

• Teraz można ponownie zainstalować i aktywować aplikacje Adobe Acrobat Pro 2017 i Enfocus PitStop Edit 2019
z poziomu programu Fiery Software Manager.

Fiery XF

• W przypadku superwielkoformatowych maszyn drukarskich VUTEk z roli na rolę ustawienie opcji trybu
drukowania w menu Ustawienia specjalne > Drukowanie tuszem białym zawsze zmieniało się z powrotem na
kolor dodatkowy WHITE_INK.

• Po ustawieniu języka polskiego jako języka systemowego kontrolera Fiery server, aplikacja Cut Server nie
rozpoznawała zadań kolekcji.

Problemy rozwiązane w programie Fiery Command WorkStation Package w wersji
6.5.0.433

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5obsługuje system Windows 10 w wersji 2004.

• Po wydrukowaniu zadania broszury za pomocą szablonu Fiery Impose zapisanego jako ustawienie wstępne
ustawienie Nośnik okładki czasami nie zostaje zastosowane.

• Czasami uruchomienie aplikacji Fiery Impose, Fiery Compose lub Fiery JobMaster było niemożliwe z powodu
nieprawidłowego komunikatu o błędzie informującego, że aplikacja jest już otwarta. Ten problem został
rozwiązany.

• Jeśli aktywowano wiele licencji, nie można było przywrócić kodów aktywacyjnych licencji (LAC) podczas
przywracania serwera Fiery server za pomocą programu Fiery System Restore. Ten problem został rozwiązany.

Fiery XF

• Nazwa użytkownika w systemie zawierająca spację lub znaki specjalne spowodowała, że narzędzie Job Editor nie
wyświetla podglądów zadań.

• W systemie w języku włoskim po uaktualnieniu aplikacji Fiery Command WorkStation 6.5 do najnowszej wersji
narzędzie Job Editor przestało odpowiadać.
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Problemy rozwiązane w wersji 6.5.0.367 aplikacji Fiery Command WorkStation
Package

Fiery Command WorkStation

• W niektórych językach tekst umieszczony na nośnikach z zakładkami za pomocą Fiery Compose lub Fiery
JobMaster wyświetlał się prawidłowo podczas pracy na komputerze, jednak nie był widoczny po zadrukowaniu
nośników z zakładkami.

• Gdy zapisano formularze PDF z danymi wprowadzonymi w polach formularza przy użyciu Fiery Compose lub
Fiery JobMaster, pola formularza nie były wyświetlane w oknie Podgląd ani na wydruku.

• Nie można było dokonać ponownej kalibracji zestawu kalibracyjnego, dla którego wybrano niestandardowy
rozmiar papieru 241 x 330 mm, jeśli zmieniono rozmiar papieru z 241 x 330 mm na 13x19 cali.

• Gdy podłączono spektrofotometr do dowolnego komputera po wydrukowaniu strony kalibracji, nie można było
dokonać pomiaru z użyciem strony kalibracji.

Fiery XF

• Na niektórych platformach Windows aplikacja Job Editor nie wyświetlała podglądu zadań.

Problemy rozwiązane w programie Fiery Command WorkStation Package w wersji
6.5.0.292

Fiery Command WorkStation

• Czcionka Arial była wyświetlana na niektórych komputerach z systemem Windows kursywą po zainstalowaniu
pakietu Fiery Command WorkStation Package 6.5.

• Ustawień domyślnych zdefiniowanych przy użyciu funkcji Ustaw domyślne nie zastosowano do kolejki Wydruk
sekwencyjny.

• W programie Fiery JobMaster, gdy wstawiono lub usunięto strony z zadania PDF z zakładkami podczas
wstawiania zakładek lub pustych arkuszy, zakładki przesuwają się na inne strony.

• Zdarza się, że komputery z systemem macOS w wersji nieanglojęzycznej generują uszkodzone dane pomiarów
IT8.

Fiery XF

• W sekcji dostępnej po wybraniu kolejno opcji Color Tools > Utwórz kalibrację > Balans szarości, wartości Delta E
zmieniają się po każdym otwarciu zapisanego pliku EPL.

• Po ustawieniu języka polskiego w roli języka systemowego kontrolera Fiery server, aplikacja Cut Server nie
rozpoznawała zadań zagnieżdżania.

• Podczas ponownej kalibracji kontrolera Fiery XF domyślna kolejność zadań ustawiona w oknie Server Manager
nie była stosowana.
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Problem naprawiony w programie Fiery Command WorkStation Package w wersji
6.5.0.171 SP1

• Gdy użyto akcji Przypisz nośniki w aplikacji Fiery Impose, wyświetlany był komunikat ostrzegający o
nieprawidłowym profilu sRGB.

Problemy rozwiązane w programie Fiery Command WorkStation Package w wersji
6.5.0.171

Fiery XF

• Nie można utworzyć wartości bazowych RGB dla urządzenia EPSON SC-P75x0/SC-P95x0

• Nie można wybrać drukowania etykiet dla urządzeń EPSON SC-P75x0 i SC-P95x0

• Nie można skalibrować nośników 44-calowych na urządzeniu EPSON 9500

Informacje o wersji dla klientów
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Müşteri sürüm notları
Fiery Command WorkStation Package, v6.5

Bu belge, sürüm hakkında önemli bilgiler içermektedir. Yükleme işlemine devam etmeden önce tüm kullanıcılara bu
bilgileri sağladığınızdan emin olun.

Bu sürüm hakkında

Aşağıdaki uygulamalar bu sürüme dahil edilmiştir:

• Fiery Command WorkStation Package V6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Mac 4.1.0.21 için Fiery Hot Folders

• Windows 4.1.0.21 için Fiery Hot Folders

• Fiery Software Manager v4.4.0.18

Yükseltme

Bu yükleyici tüm mevcut Fiery Command WorkStation Package ögelerini Fiery Command WorkStation ve Fiery Hot
Folders içeren son pakete yükseltecektir. İsteğe bağlı olarak, Fiery Software Manager ögesini kullanarak Fiery Remote
Scan'i yükleyebilirsiniz.
Fiery Command WorkStation Package, FS100 veya sonrası ve Fiery proServer ve Fiery XF 7.0 veya sonrası çalıştıran
Fiery servers ögesini destekler. Aşağıdakilere bağlanmaz:

• Fiery System 9/9e Rel2 ve System 10 yazılımı ve önceki sürümleri çalıştıran Fiery servers

• Fiery XF 6.x sunucuları ve daha önceki sürümleri

• Fiery Central sunucuları

Bu ürünlere erişmeniz gerekiyorsa, yükseltmeyin. Fiery Extended Applications Paket hala www.efi.com/cws
adresinde mevcuttur. Desteklenen tüm kesilmiş yaprak baskı makinelerinin bir listesi için bkz. http://
fiery.efi.com/CWS/supported-printers.
Teknik özellikler hakkında daha fazla bilgi için www.efi.com/cws adresini ziyaret edin.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


Yeni özellikler

Yenilikler

6.5 ögesinin ilk sürümüne eklenmiş olan yeni özellikler hakkında bilgi için http://fiery.efi.com/CWS/Whats-New
adresini ziyaret edin.
6.5 ögesinin ilk sürümünden sonra eklenen yeni özellikler hakkında bilgi için aşağıdaki bilgilere bakın.

Fiery Spot Pro

Fiery Command WorkStation 6.5 nokta renklerini, Fiery Spot-On'un yerini alan Fiery Spot Pro ile yönetmenize
olanak sağlar. İyileştirmelerin tam listesi için bkz. https://www.efi.com/spotpro.
Fiery Spot Pro aşağıdaki gereksinimleri karşılayan seçili sunucularda kullanılabilir:

• FS200 Pro ve daha üstü yazılım

• Fiery Graphic Arts Package, Premium Edition

http://fiery.efi.com/spotpro/supported-printers adresinde daha fazla bilgi edinin.
Fiery server ögenizde Fiery Spot Pro etkinleştirilmiş değilse Fiery Command WorkStation Fiery Spot-On'u
desteklemeye devam edecektir.

Fiery Spot Pro kullanma hakkında önemli bilgiler

• Herhangi nokta rengi adında "@" sembolünü kullanmayın.

• Spot Pro'yu başlattıkdan sonra arama işlevini kullanmadan veya çıktı profillerini değiştirmeden önce yaklaşık
60-120 saniye bekleyin.

• Nokta renklerinin optimizasyonu, birkaç yenilemeden sonra orijinal nokta renk ve dönüştürülmüş nokta
rengi arasında daha belirgin farklılıklara neden olabilir.

• Dönüştürülmüş L*a*b* değerleri ve cihaz CMYK değerlerinde hafif bir sayısal yuvarlama vardır.

• Farklı kullanıcı sistemleriyle aynı Fiery server ögesine iki Spot Pro bağlantısı gerçekleştirildiğinde, iki
kullanıcı da düzenleme işlemi gerçekleştirirse bu durum hatalara neden olabilir.

EFI ES-3000 desteği

Yeni EFI ES-3000 ölçüm enstrümanı, Fiery Command WorkStation 6.5 ögesinde EFI ES-2000 öykünmesi
üzerinden desteklenir. EFI ES-3000, EFI ES-2000 için bir yükseltmedir ve M1 ve M2 ölçüm modlarında tek
tarama ölçümlerini destekler. Fiery Command WorkStation'ına ait Fiery Calibrator, Fiery Spot Pro ve Kağıt
Simülasyonu özellikleri ile EFI ES-3000 enstrümanını (kullanıcı arabiriminde “EFI ES-2000” girişini seçerek)
kullanabilirsiniz.

Not: ES-2000 öykünmesi (kullanıcı arabiriminde "EFI ES-2000" girişi), bir EFI ES-2000 ile birlikte de
kullanılabilir.
EFI ES-3000'i diğer uygulamalarla birlikte kullanma hakkında bilgi için ilgili uygulamalarla birlikte sağlanan
belgelere bakın.
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Fiery seçenek paketi lisans bildirimleri

Kullanılabilir sunucu güncellemeleri hakkında bildirimler artık Fiery Command WorkStation ögesinde yeni
Bildirimler bölümünde listeleniyor. Yüklü Fiery seçeneklerinin lisansları son kullanma tarihine yaklaştığında
veya süresi dolmuş olduğunda bildirimler görüntülenir. Bildirimler Fiery Command WorkStation , Fiery Hot
Folders ve Fiery WebTools ögelerinde görüntülenir.

Not: Lisans zaman aşımı bilgilerini istediğiniz zaman şurada görüntüleyebilirsiniz: WebTools > Ana sayfa ve Fiery
Command WorkStation > Cihaz merkezi > Genel > Genel bilgiler.
Zaman aşımı bildirimleri aşağıdaki seçenekleri sağlar:

• Şimdi yenile

• Reddet

• Daha fazla bilgi edinin

Fiery JobExpert raporu için destek

FS400 sunucularına bağlı Fiery Command WorkStation 6.5, Fiery JobExpert kullanarak iş yapılan geliştirmelerini
önizlemenize olanak sağlar.
Fiery JobExpert raporu, Fiery JobExpert kullanarak işleriniz için uygulanan önerilen iş özellikleri ayarlarına genel
bakış sağlar.

Adobe Acrobat Pro 2017 ve Enfocus PitStop Edit 2019 desteği

Adobe Acrobat Pro 2017 ve Enfocus PitStop Edit 2019 seçeneği, Fiery Software Manager adresinden indirilebilir.

Fiery XF Color Editor ölçüm enstrümanları için destek

Şu tek ek ve optimizasyon ölçüm enstrümanları desteklenir:

Ölçüm enstrümanı Tek ek Optimizasyon

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

Değişken açık mürekkep uç nokta desteği

Fiery XF kalibrasyon dosyalarında açık mürekkebi kaydetmek için açık mürekkep uç noktası ayarlamanıza
olanak sağlar.
Mürekkep tasarruflu kalibrasyon dosyası oluştururken Color Tools Mürekkep sınırı ve kalibrasyon sekmesindeki
Açık mürekkep uç noktası değerini değiştirerek açık mürekkep miktarını azaltın.
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1617 (CGATS IT8.7/5) ek düzeni desteği

Fiery XF 1617 ekleri ile Color Tools'ta bir profil oluşturma grafiğini destekler.
1617 hedefi, standart IT8.7 / 4 hedefindeki benzersiz ek değerleri P2P51 hedefinin 4. ve 5. sütunlarındaki tüm ek
değerlerle birleştiren bir CMYK yazıcı karakterizasyon hedefidir.

Server Manager'dan Verifier özel ön ayarları oluşturma desteği

Server Manager'dan XF-Verifier'da özel ön ayarlar oluşturabilirsiniz.

Çalışma klasörü yedekleme dosyasının klasör konumunu koruma desteği

Bir yedekleme dosyasından Çalışma klasörünü geri yüklediğinizde, artık yedekleme dosyasının orijinal klasör
konumlarını koruyabilirsiniz.

EFI IQ web uygulamaları

Command WorkStation Ana ekranından EFI IQ web uygulamalarına kayıt olabilirsiniz. EFI IQ web
uygulamaları, güçlü yazdırma analitikleri ile yazdırma üretiminize daha fazla görünürlük sağlar.

Sistem gereksinimleri güncellemeleri

Desteklenen sürümler

Fiery Command WorkStation ögesi, bilgisayarınız için şu işletim sistemlerini destekler:

• macOS 11 (yalnızca Intel işlemcilerde)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10, 64-bit

• Windows sunucu 2019, 64-bit

• Windows sunucu 2016, 64-bit

• Windows 8.1, 64-bit

• Windows 7, 64-bit

• Windows sunucu 2012 R2, 64-bit

• Windows sunucu 2008 R2, 64-bit

Kesilen destek

• macOS 10.11

• macOS 10.12

• System 10 ve öncesi
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Fiery Command WorkStation ögesini sürüm 6.5'e güncellediğinizde daha önce eklenen tüm System 10
sunucuları sunucu listesinden kaldırılır. System 10 veya daha önceki sürümleri çalıştıran bir Fiery server
ögesinde oturum açmaya çalışırsanız Fiery server ögesi FS100 ve sonraki desteklenen sürümleri çalıştırdığından
bu sunucuyu kullanmanız engellenir.

64 bit uygulama

Fiery Command WorkStation 6.5 (CWS), hem macOS hem de Windows platformları için yerel bir 64 bit
uygulamadır.
32 bit işletim sistemlerinde CWS 6.5 desteklenmez. Fiery Software Manager, halihazırda Windows 7 32 bit gibi
32 bit bir işletim sisteminde çalışıyorsa, CPS 6.5 paketi için güncelleme bildirimlerini görüntülemez. Bu Fiery
Software Manager sürümünü bir 32 bit işletim sistemine yüklemeye çalışırsanız bir uyumluluk hatası görürsünüz
ve Fiery Software Manager çalışmaz. Desteklenen işletim sistemlerini görüntülemek için bkz. http://
fiery.efi.com/cws-specifications.

Fiery Impose, Fiery Compose veya Fiery JobMaster ile kullanılmak üzere Adobe Acrobat DC
aboneliği desteği

Fiery Command WorkStation Package v6.5.0.292, Fiery Impose, Fiery Compose veya Fiery JobMaster ile birlikte
kullanım için bir istemci bilgisayarda yüklü Acrobat DC bireysel/kişisel aboneliklerin kullanımını destekler.

Not: Fiery Impose, Fiery Compose veya Fiery JobMaster içinde Acrobat'ı kullanmak için istemci bilgisayara
Acrobat DC'nin yalnızca bir örneğini yüklemeniz gerekir. Ayrıca diğer Acrobat sürümlerinin aynı istemci
bilgisayarda yüklü olmadığından emin olun.

Bilinen sorunlar

Okuyucu görünümü

Fiery Impose, Fiery Compose, Fiery JobMaster ögelerinde veya Fiery Preview içinde, Okuyucu görünümü macOS
11 ve üzerinde kaldırıldı.

ImageEnhance Visual Editor

macOS 11'de ImageEnhance Visual Editor penceresini büyüttüğünüzde monitör birkaç saniye boyunca
titreyebilir.

PSʼden PDFʼye dönüştürme

macOS 10.14.5 veya sonraki sürümlerle birlikte Fiery Impose, Fiery Compose veya Fiery JobMaster
kullanıyorsanız Fiery Command WorkStation ögesine Acrobat Distiller erişimi izni vermeniz istenebilir. Bu izin,
PS dosyalarının PDF'ye dönüştürülmesi için gereklidir. İzin vermezseniz dönüştürmeler başarılı olmaz ve
macOS'taki Otomasyon güvenlik özelliğini değiştirmeniz gerekir.

1 Tüm Fiery uygulamalarını kapatın.

2 Acrobat Distiller'ı kapatın.

3 Şu bölüme gidin: Sistem Tercihleri > Güvenlik ve gizlilik > Gizlilik > Otomasyon.

4 Sol alt köşedeki Kilitle simgesine tıklayın ve şifrenizi girin.
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5 Uygulamalar listesinde Fiery Command WorkStation.app'ı bulun.

6 Acrobat Distiller.app seçeneğini seçin.
Bu Fiery Command WorkStation ögesine Acrobat Distiller erişimi sağlar.

macOS 10,15 (Catalina) bilgileri

macOS 10.15'te Fiery Preview, Fiery Impose, Fiery Compose veya Fiery JobMaster

PDF destek uygulamaları kiti

Adobe Acrobat ve Enfocus PitStop'tan oluşan PDF destek uygulamaları kiti (EFI tarafından sağlanır), macOS
10.15 (Catalina) ile uyumlu değildir. Acrobat ve/veya PitStop kullanıyorsanız macOS 10.15'e yükseltmeyin. Yeni
yüklemeler için PDF destek uygulamaları yükleyicisi çalışmaz.
Güncel PDF destek uygulamaları kitini kullanırken macOS 10.15 sürümüne yükseltme işlemi aşağıdaki sorunlara
neden olabilir:

• macOS 10.15 sürümüne yükseltmeden önce Acrobat DC zaten yüklüyse normal olarak çalışacaktır. Ancak
Acrobat DC yükleyicisi macOS 10.15 ile uyumlu değildir, bu nedenle yeni Acrobat DC yüklemeleri mümkün
değildir. Ayrıca dahili Enfocus PitStop, macOS 10.15'de desteklenmez.

• macOS 10.15 sürümüne yükseltmeden önce Acrobat XI zaten yüklüyse çalışmayacaktır ve macOS 10.15'te
desteklenmez. macOS 10.15 sürümüne yükseltmeden önce Acrobat XI 'yı kaldırmanızı öneririz. Acrobat XI
program kaldırıcı macOS 10.15 üzerinde çalışmaz, bu nedenle Acrobat XI yüklü iken macOS 10.15'e
yükseltirseniz sisteminizde Acrobat XI çalışmayacak ve kaldırılamayacaktır.

Uyumlu bir Acrobat sürümü yüklenmezse aşağıdaki sorunlar olacaktır:

• Acrobat'ta Düzenle işlevi, Fiery Impose, Fiery Compose ve Fiery JobMaster içinde kullanılamaz.

• Fiery Preview, Fiery Impose, Fiery Compose veya Fiery JobMaster ile bir PostScript işini açma bir hataya
neden olabilir.

• Kullanıcı tanımlı sonlandırma boyutu veya Kesim kutusuna göre iş akışları kullanan Fiery Impose şablonları,
PostScript işlerde düzgün çalışmayabilir.

• Fiery Hot Folders, PostScript dosyaları PDF'ye dönüştürme seçeneği sunmaz.

Diğer sorunlar

Daha eski bir macOS sürümünden macOS 10.15'e yükselttikten sonra Fiery Preview'ı başlatırken Fiery Impose,
Fiery Compose veya Fiery JobMaster aşağıdaki mesajlardan birinin görüntülenmesine neden olabilir:

• "ICUConverter.framework" bilgisayarınıza zarar verecek. Onu Çöp Kutusuna taşımalısın.

• "ICUData.framework" bilgisayarınıza zarar verecek. Onu Çöp Kutusuna taşımalısın.

macOS 10.15, hatalı şekilde bu dosyaları kötü amaçlı yazılım olarak algılar. Bu sorunları çözmek için macOS
10.15 ile uyumlu Fiery Command WorkStation Package sürüm 6.4.0.396 veya sonrasını yeniden yükleyin.
Fiery Preview, Fiery Impose, Fiery Compose ve Fiery JobMaster ögesindeki denetim simgelerinin düğmeleri
üzerinde imlecinizi gezdirdiğinizde araç ipuçları görüntülenmez.
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Tam disk erişimi

macOS 10.15'in güvenliği yönetme şeklindeki değişiklikler nedeniyle Fiery uygulamalarının düzgün çalışabilmesi
için gerekli ek adımlar mevcuttur.
Fiery uygulamaların güncellemeleri yönetmesi ve Impose şablonları ve çalışma klasörleri gibi dosyalara erişmesi
için macOS'deki Tam disk erişimi güvenlik özelliği üzerinde değişiklik yapmanız gerekir. Fiery Command
WorkStation gibi Fiery uygulamaları için Tam disk erişimi'ni etkinleştirin.

1 Tüm Fiery uygulamalarını kapatın.

2   Sistem Tercihleri > Güvenlik ve gizlilik > Gizlilik > Tam disk erişimi.

3 Sol alt köşedeki Kilitle simgesine tıklayın ve şifrenizi girin.

4 + düğmesine tıklayın.

5 Uygulamalar klasöründe Fiery Software Manager ve Fiery Software Uninstaller seçimini yapın ve Aç'a
tıklayın.
Bu uygulamalar, bilgisayarınızdaki Fiery uygulamalarını korumak ve güncellemek için tam disk erişimi
gerektirir.

6 Uygulamalar klasöründe Fiery Command WorkStation ögesini seçin ve Aç'a tıklayın.

7 Fiery Hot Folders veya Fiery Remote Scan kullanıyorsanız her uygulamayı seçin ve Aç'a tıklayın.
Fiery Hot Folders, Belgeler, Masaüstü ve İndirilenler klasörlerinin kullanıldığını algılarsa tam disk erişimi
isteyen bir mesaj verir. Bu mesaj erişim izni verildikten sonra bile görüntülenir. Bu mesajı kapatabilir ve
çalışmaya devam edebilirsiniz.

macOS 10.15'te Safari tarayıcı hataları

macOS 10.15'te Safari kullanıyorsanız, Fiery Command WorkStation ögesinden aşağıdaki web sayfalarını açmaya
çalışırken tekrarlanan tarayıcı hatalarıyla karşılaşacaksınız Cihaz merkezi'ne tıklayın > Genel > Araçlar:

• Fiery Sistem Geri Yüklemesi

• Fiery System Görüntüsü

• Fiery kaynakları ve ayarları

Bu hatalar, ayrıca Safari tarayıcısında Fiery WebTools'u açtığınızda da meydana gelebilir.
Bu web sayfalarına erişmek için Chrome veya Firefox kullanın.

macOS 10.15 üzerinde Fiery XF

macOS 10.15 sürümünde Fiery XF kullanıyorsanız Fiery Color Profiler Suite ögesini 5.3.1 sürümüne
yükseltmeniz gerekir. Fiery Color Profiler Suite sürüm 5.3.1 sonrasında macOS 10.15 uyumlu Fiery Verify, artık
varsayılan doğrulama uygulaması olarak Fiery XF kullanıcıları tarafından kullanılabilir.
Color Verifier macOS 10.15 ile uyumlu değildir ancak eski macOS sürümlerinde hala desteklenir. Color Verifier'ı
ayrıca yüklemeniz gerekir. macOS 10.14 ve önceki sürümler için Color Verifier'ı İndirme merkezi'nden indirin.

Fiery Color Profiler Suite ve Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) ve ve önceki sürümler, kesilmiş yaprak baskı makineleri için Fiery Command
WorkStation Package 6.5 (CWS) ile tam olarak uyumlu değildir. Fiery Color Profiler Suite 5.1'e güncellemenizi
öneririz.
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CPS 5.0'ı CWS 6.5 ile kullanırken aşağıdaki sorunlarla karşılaşabilirsiniz:

• CPS açıkken CWS'de "Spektrofotometreyi bilgisayarınıza bağlayın" mesajını görürseniz, CPS'yi kapatın ve
devam etmek için Tamam'a tıklayın.

• Kalibratör'de yeni bir kalibrasyon ayarı oluşturduktan sonra CPS'yi başlatmak için kullanılan Yeni profil
oluştur düğmesi gizlenir. CPS 5.1'e yükselttikten sonra bu sorun giderilmiştir.

Fiery Impose, Fiery Compose veya Fiery JobMaster ögelerinde Acrobat'ta düzenle seçeneğinin
seçilmesi iki Acrobat penceresi açar

Windows bilgisayarlarda Fiery Impose, Fiery Compose veya Fiery JobMaster ögelerinde Acrobat'ta düzenle
seçildiğinde Acrobat bir yerine iki pencerede açılabilir. Bu, bilinen bir sorundur. Adobe Acrobat penceresini
kapatıp PDF ile pencerede çalışmaya devam edebilirsiniz.

PostScript'ten PDF'ye dönüştürme için Adobe Acrobat Distillerʼdeki Tercihleri ayarlama

Fiery Impose, Fiery Compose ve Fiery JobMaster, istemci bilgisayarda PostScript (PS) dosyalarını PDF'ye
dönüştürmek için Adobe Distiller gerektirir.
Acrobat Distiller'daki iyileştirilmiş güvenlik ayarları nedeniyle dönüştürülecek PS dosyasının güvenilir bir
kaynaktan geldiğini onaylamanız gerekir: Acrobat Distiller > Dosya > Tercihler > Tercihler - Acrobat Distiller,
Güvenlik altında Acrobat Distiller tarafından açılan tüm dosyalara güven seçeneğini seçin.

Not: Acrobat Distiller tarafından açılan tüm dosyalara güven seçeneği seçili değilse PDF'ye dönüştürülecek her
PS dosyası için güvenilir bir kaynaktan geldiğini onaylamanız istenir. Bu durum Microsoft Office filtresi
seçildiğinde, Çıktı dosyası türü olarak PDFseçildiğinde ve Distiller profili olarak joboptions dosyası seçildiğinde
Hot Folders için de geçerlidir.

macOS bilgisayardan Configure başlatılamıyor

Fiery server ögeniz FS100 sistemi çalıştırıyorsa bu işletim sistemi sürümlerinden Configure'ü başlatamazsınız:

• mac10.14.6 ve sonraki 10.14 sürümleri

• macOS 10.15 (tüm sürümler)

Fiery Command WorkStation ögesine bağlanmak için macOS'un önceki bir sürümüne sahip bir macOS
bilgisayarı veya bir Windows bilgisayarı kullanın.

Fiery Impose, Fiery Compose veya Fiery JobMaster ögelerini başlatmada gecikme

Fiery Impose, Fiery Compose ve Fiery JobMaster ögelerini başlatmak önceki sürümlere göre daha uzun sürebilir.
Bu uygulamalardan birini açmak için gereken süreyi azaltmak için önce Fiery Preview'ı sonra da kullanmak
istediğiniz uygulamayı başlatın.

Fiery Command WorkStation Package v6.5.0.599'da düzeltilen sorunlar

Fiery Command WorkStation

• ES-3000 spektrofotometre ile ölçüm sonuçları doğru değildi.
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Fiery Command WorkStation Package v6.5.0.581 ile giderilen sorunlar

Fiery Command WorkStation

• Siz Fiery Hot Folders içinde TIFF girdi biçimini kullanırken, görüntü konumlandırma ayarları birkaç dil için
doğru şekilde uygulanmadı.

• Fiery Command WorkStation Package 6.5 Windows 10, sürüm 20H2'yi destekler.

Fiery XF

• Şifre kaydet tercihi açık olan bir Fiery XF sunucu eklediğinizde ve Fiery XF sunucusunu yeniden başlattığınızda
Fiery Command WorkStation Package ögesi başarıyla başlatılmaz.

Fiery Command WorkStation Package v6.5.0.563'te düzeltilen sorunlar

Fiery Command WorkStation

• Japonca dil sisteminde yeni oluşturulan yönetici hesabıyla oturum açtığınızda Fiery Spot Pro açılamıyordu.

Fiery XF

• Fiery Command WorkStation İş merkezi'nde iş, Fiery Verify'da tüm testleri geçse bile İş durumu sütunu
doğrulama işleminin başarılı olmadığını bildiriyordu.

• Fiery Command WorkStation İş merkezi'nde bir iç içe yerleştirme işinin durumu Doğrulanacak ise üst işin İş
özeti bölmesinden Doğrula'ya tıkladığınızda Fiery Verify başlamıyordu. Bir alt işin Optimize et veya İş özeti
bölmesinden Ayrıntılar'a tıkladığınızda Fiery Verify açılır.

Fiery Command WorkStation Package v6.5.0.539'daki sorunlar düzeltildi

Fiery Command WorkStation

• 4-yukarı şablon ile bir PPML işi yükledikten ve işledikten sonra işin bazı sayfaları Fiery ImageViewer'de
görüntülenmedi.

Fiery XF

• Command WorkStation Server Manager > Düzen > Adımla ve Tekrarla > Desen'de Özel genişlik ayarı için 59,4
cm'den fazla bir değer belirtemezsiniz.

Fiery Command WorkStation Package v6.5.0.512'de sorunlar düzeltilmiştir

Fiery Command WorkStation

• Japonca dilindeki bir sistemde, Fiery ImageViewer kullanılarak düzenlenen bir işi yazdırdığınızda Fiery server
yanıt vermeyi durdurur.

• Fiery Impose'de tel çerçeve görünümündeki bir işin düzenleme kutularının ekranı artık tel çerçevelerle
hizalanıyor.
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Fiery XF

• Ortam adını değiştirdiyseniz veya bir kalibrasyon dosyasıyla (*. EPL) Color Tools > Connect Profiles'ta bir ortam
profiline farklı bir adla ilişkilendirdiyseniz, uyumlu yazıcı bilgileri kalibrasyon dosyasından (*. EPL) kaldırılır.

• İş düzenleyicisi > Çakışma/tutkal'da Tutkal alanı ayarını kaydedemediniz.

• XF 7.2, macOS bilgisayarlarda X-Rite i1Pro3 ve EFI ES-3000 ölçüm cihazlarını destekler.

Fiery Command WorkStation Package v6.5.0.475'te düzeltilen sorunlar

Fiery Command WorkStation

• Fiery Spot Pro ögesinde artık Nokta renkleri ve Değiştirme renkleri için ayrım değerlerini bir ondalık basamağa
kadar belirleyebilirsiniz.

• Fiery Spot Pro ögesinde Fabrika ayarlarına geri dön seçeneği artık çoğaltılmış bir gruptaki nokta renkleri için
devre dışı bırakılmıştır.

• Adobe Acrobat Pro 2017 ve Enfocus PitStop Edit 2019'u Fiery Software Manager ögesinden yeniden yükleyebilir
ve etkinleştirebilirsiniz.

Fiery XF

• VUTEk rulodan ruloya süper geniş formatlı yazıcılarda Özel ayarlar > Beyaz mürekkepli baskı'da bulunan
yazdırma modu ayarı daima Nokta rengi WHITE_INK olarak geri değişiyordu.

• Fiery server sistem dili Lehçe'ye ayarlı ise Cut Server uygulaması iç içe yerleştirme işlerini tanımıyordu.

Fiery Command WorkStation Package v6.5.0.433'de düzeltilen sorunlar

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5, Windows 10 sürüm 2004'ü destekler.

• Ön ayar olarak kaydedilen bir Fiery Impose şablonu kullanarak kitapçık işi yazdırırken bazen kapak malzeme
ayarı uygulanmıyordu.

• Yanlış bir hata mesajı uygulamanın zaten açık olduğunu belirttiği için bazen Fiery Impose, Fiery Compose veya
Fiery JobMaster başlatılamıyordu. Bu sorun giderildi.

• Birden fazla lisans etkinleştirildiğinde Fiery sistem geri yüklemesi kullanarak Fiery server ögesini geri yüklerken
Lisans etkinleştirme kodlarını (LAC'ları) geri yükleyemiyordunuz. Bu sorun giderildi.

Fiery XF

• Boşluk veya özel karakterler içeren bir sistem kullanıcı adı Job Editor'ün iş önizlemelerini görüntülememesine
neden oluyordu.

• İtalyanca dil sisteminde Fiery Command WorkStation 6.5 ögesini en son sürüme yükselttikten sonra Job Editor
yanıt vermeyi durduruyordu.
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Fiery Command WorkStation Package v6.5.0.367'de düzeltilen sorunlar

Fiery Command WorkStation

• Bazı dillerde bilgisayarda görüntülendiğinde Fiery Compose veya Fiery JobMaster kullanarak sekmelere
yerleştirilen metin düzgün şekilde görünüyor ancak sekmeler yazdırılırken metin görünmüyordu.

• Form alanlarına girilen verileri içeren PDF formları Fiery Compose veya Fiery JobMaster ögesinden
kaydedildiğinde form alanları Önizleme veya yazdırılan çıktıda görünmüyordu.

• Kağıt boyutunu 241x330 mm'den 13x19 inçe değiştirdiyseniz 241x330 mm özel kağıt boyutunda kalibrasyon
setini yeniden kalibre edemiyordunuz.

• Kalibrasyon sayfasını yazdırdıktan sonra spektrofotometreyi herhangi bir bilgisayara bağladıysanız kalibrasyon
sayfasını ölçemiyordunuz.

Fiery XF

• Bazı Windows platformlarda Job Editor işlerin önizlemesini gösteremiyordu.

Fiery Command WorkStation Package v6.5.0.292'de düzeltilen sorunlar

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5'i yükledikten sonra Arial yazı tipi bazı Windows bilgisayarlarda italik
olarak görüntüleniyordu.

• Varsayılanları Ayarla özelliği ile tanımladığınız varsayılan ayarlar Ardışık Yazdırma kuyruğuna uygulanmıyordu.

• Fiery JobMaster ögesinde sekme veya boş yaprak eklerken yer imleri içeren PDF işine sayfa ekler veya silerseniz
yer imleri farklı sayfalara kayıyordu.

• Bazen İngilizce harici işletim sistemine sahip macOS bilgisayarlar bozuk IT8 ölçüm verileri oluşturuyordu.

Fiery XF

• Bilgisayarın Color Tools > Kalibrasyon oluştur > Gri dengesi, kaydedilmiş bir EPL dosyasını her açtığınızda delta E
değerleri değişiyordu

• Fiery server sistem dili Lehçe'ye ayarlı ise Cut Server uygulaması iç içe yerleştirme işlerini tanımıyordu.

• Fiery XF sunucuyu yeniden kalibre ettiğinizde Server Manager penceresinde belirlediğiniz varsayılan iş akışı
uygulanmıyordu.

Fiery Command WorkStation Package v6.5.0.171 SP1'de giderilen sorunlar

• Fiery Impose ögesinde Ortam ata eylemini kullandığınızda hatalı bir sRGB profili hakkında uyarı mesajı
veriliyordu.
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Fiery Command WorkStation Package v6.5.0.171'de düzeltilen sorunlar

Fiery XF

• EPSON SC-P75x0/SC-P95x0 RGB için Taban çizgisi oluşturulamadı

• EPSON SC-P75x0 ve SC-P95x0 için etiket baskısı seçimi yapılamadı

• 44 inçlik malzemeyle EPSON 9500 kalibre edilemedi
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Poznámky k verzi pro zákazníky
Fiery Command WorkStation Package, v6.5

Tento dokument obsahuje důležité informace o této verzi produktu. Než budete pokračovat v instalaci, nezapomeňte
tyto informace poskytnout všem uživatelům.

Informace o této verzi

Tato verze obsahuje následující aplikace:

• Fiery Command WorkStation Package v6.5.0.599

• Fiery Command WorkStation 6.5.0.57

• Fiery Hot Folders pro Mac 4.1.0.21

• Fiery Hot Folders pro Windows 4.1.0.21

• Fiery Software Manager v4.4.0.18

Upgradování

Tento instalační program provede upgrade vašeho stávajícího balíčku Fiery Command WorkStation Package na
nejnovější verzi, která obsahuje aplikaci Fiery Command WorkStation a Fiery Hot Folders. Aplikaci Fiery Remote
Scan můžete také volitelně nainstalovat pomocí Fiery Software Manager.
Fiery Command WorkStation Package podporuje Fiery servers se systémem FS100 a novějším, Fiery proServer a
Fiery XF 7.0 a novějším. Nepřipojí se k:

• Fiery servers se systémem Fiery System 9/9e Rel2 a softwarem System 10 a předchozími verzemi

• Servery Fiery XF 6.x a starší

• Serverům Fiery Central

Pokud potřebujete přístup k těmto produktům, neprovádějte upgrade. Fiery Extended Applications Package je stále k
dispozici na adrese www.efi.com/cws. Úplný seznam podporovaných tiskáren na volné listy viz http://
fiery.efi.com/CWS/supported-printers.
Další informace o technických specifikacích naleznete na adrese www.efi.com/cws.

HTTP://WWW.EFI.COM/CWS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
HTTP://FIERY.EFI.COM/CWS/SUPPORTED-PRINTERS
http://www.efi.com/cws


Nové funkce

Co je nového?

Informace o nových funkcích, které byly přidány v počátečním vydání verze 6.5, najdete na http://
fiery.efi.com/CWS/whats-new.
Informace o nových funkcích, které byly přidány po počátečním vydání verze 6.5, najdete níže.

Fiery Spot Pro

Fiery Command WorkStation 6.5 umožňuje spravovat přímé barvy pomocí nástroje Fiery Spot Pro, který
nahrazuje Fiery Spot-On. Úplný seznam vylepšení naleznete na stránkách https://www.EFI.com/spotpro.
Fiery Spot Pro je k dispozici pro vybrané servery a má následující požadavky:

• Software FS200 Pro a novější

• Fiery Graphic Arts Package, Premium Edition

Další informace získáte na stránkách http://fiery.efi.com/spotpro/supported-printers.
Pokud Fiery server nemá zapnutou funkci Fiery Spot Pro, Fiery Command WorkStation bude nadále podporovat
Fiery Spot-On.

Důležité informace týkající se použití Fiery Spot Pro

• Nepoužívejte symbol „@“ v žádném názvu přímé barvy.

• Po spuštění Spot Pro vyčkejte přibližně 60-120 sekund, než použijete funkci hledání nebo přepnete výstupní
profily.

• Optimalizace přímých barev po několika iteracích může mít za následek výraznější rozdíly mezi původní
přímou barvou a převedenou přímou barvou.

• Převedené hodnoty L*a*b* a hodnoty zařízení CMYK se nepatrně zaokrouhlují.

• Pokud se dvě instance nástroje Spot Pro spuštěné v různých systémech připojí ke stejnému serveru Fiery
server a oba uživatelé provádějí operace úprav, může dojít k chybám.

Podpora EFI ES-3000

Nový měřicí přístroj EFI ES-3000 je podporován prostřednictvím emulace EFI ES-2000 v aplikaci Fiery
Command WorkStation 6.5. EFI ES-3000 představuje upgrade EFI ES-2000 a podporuje měření jednoho
skenování v režimech měření M1 a M2. Přístroj EFI ES-3000 můžete použít (výběrem položky "EFI ES-2000" v
uživatelské rozhraní) pomocí nástroje Fiery Calibrator, Fiery Spot Pro a funkce Simulace papíru aplikace Fiery
Command WorkStation.

Poznámka: Emulaci ES-2000 (položka "EFI ES-2000" v uživatelské rozhraní) lze použít také v kombinaci s EFI
ES-2000.
Informace o použití přístroje EFI ES-3000 s jinými aplikacemi naleznete v dokumentaci k příslušným aplikacím.
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Oznámení o licenci na balíček Fiery Option Package

Oznámení o dostupných aktualizacích serveru jsou nyní uvedena v části nová oznámení v aplikaci Fiery
Command WorkStation . K zobrazení oznámení dojde, když se licence nainstalovaných možností Fiery blíží k
datu vypršení platnosti nebo jejich platnost již vypršela. Oznámení se zobrazí v aplikaci Fiery Command
WorkStation, Fiery Hot Folders a Fiery WebTools.

Poznámka: Informace o vypršení platnosti licence můžete kdykoli zobrazit v aplikaci WebTools > Domů a Fiery
Command WorkStation > Středisko zařízení > Obecné > Obecné informace.
Oznámení o vypršení platnosti nabízí následující možnosti:

• Obnovit nyní

• Zrušit

• Další informace

Podpora pro sestavu Fiery JobExpert

Aplikace Fiery Command WorkStation 6.5 umožňuje po připojení k serverům FS400 zobrazení náhledu
vylepšení provedených v úloze pomocí nástroje Fiery JobExpert.
Sestava Fiery JobExpert obsahuje přehled navrhovaných nastavení vlastností úlohy, které se používají pro vaše
úlohy v aplikaci Fiery JobExpert.

Podpora pro produkty Adobe Acrobat Pro 2017 a Enfocus PitStop Edit 2019

Možnost Adobe Acrobat pro 2017 a Enfocus PitStop Edit 2019 je k dispozici ke stažení z aplikace Fiery Software
Manager.

Podpora měřicích přístrojů v nástroji Fiery XF Color Editor

Jsou podporovány tyto měřicí přístroje pro jednotlivá políčka a optimalizaci:

Měřicí přístroj Jednotlivé políčko Optimalizace

EFI ES-3000 * *

Konica Minolta MYIRO-1 * *

X-Rite i1iO3 * *

X-Rite i1iO3+ * *

X-Rite i1Pro3 *

X-Rite i1Pro3+ *

Podpora pro variabilní koncový bod světlého inkoustu

Fiery XFumožňuje nastavit koncový bod světlého inkoustu pro úsporu světlého inkoustu u souborů kalibrace.
Chcete-li vytvořit kalibrační soubor, který šetří inkoust, snižte množství světlého inkoustu změnou hodnoty
koncového bodu světlého inkoustu na kartě Limit inkoustu a kalibrace části Color Tools.
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Podpora pro rozložení políček 1617 (CGATS IT 8.7/5)

Fiery XF podporuje profilování grafu v aplikaci Color Tools s 1617 políčky.
1617 představuje cíl charakterizace CMYK tiskárny kombinující jedinečné hodnoty políček ve standardním cíli
IT 8.7/4 se všemi hodnotami políček ve sloupcích 4 a 5 cíle P2P51.

Podpora vytváření vlastních předvoleb Verifier v aplikaci Server Manager

V nástroji XF-Verifier můžete vytvářet vlastní předvolby z aplikace Server Manager.

Podpora zachování umístění složky souboru zálohy Hot Folder

Když obnovujete Hot Folders ze souboru zálohy, můžete nyní zachovat původní umístění složek souboru zálohy.

Webové aplikace EFI IQ

Webové aplikace EFI IQ můžete zaregistrovat na domovské obrazovce aplikace Command WorkStation .
Webové aplikace EFI IQ poskytují větší přehlednost vaší tisková produkce pomocí výkonné analýzy tisku.

Aktualizace systémových požadavků

Podporované verze

Aplikace Fiery Command WorkStation podporuje tyto operační systémy ve vašem počítači:

• macOS 11 (pouze s procesory Intel)

• macOS 10.15

• macOS 10.14

• macOS 10.13

• Windows 10 (64bitový systém)

• Windows Server 2019, (64bitový systém)

• Windows Server 2016, (64bitový systém)

• Windows 8.1, (64bitový systém)

• Windows 7, (64bitový systém)

• Windows Server 2012 R2, (64bitový systém)

• Windows Server 2008 R2, (64bitový systém)

Podpora byla ukončena

• macOS 10.11

• macOS 10.12

• System 10 a starší
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Při aktualizaci Fiery Command WorkStation na verzi 6.5 budou všechny dříve přidané servery verze System 10
odebrány ze seznamu serverů. Pokusíte-li se přihlásit k serveru Fiery server s verzí System 10 nebo starší,
nebudete moci použít tento server, protože je podporován pouze Fiery server se systémem FS100 a novějším.

64bitová aplikace

Fiery Command WorkStation 6.5 (CWS) je nativní 64bitová aplikace pro platformy Mac OS a Windows.
32bitové operační systémy nejsou aplikací CWS 6.5 podporovány. Pokud je již aplikace Fiery Software Manager
spuštěna v 32bitovém operačním systému (OS), jako je například 32bitová verze Windows 7, nezobrazí
oznámení o aktualizaci pro sadu CWS 6.5. Pokud se tuto verzi aplikace Fiery Software Manager pokusíte spustit
v 32bitovém operačním systému, zobrazí se chyba kompatibility a Fiery Software Manager se nespustí. Chcete-li
zobrazit podporované operační systémy, navštivte web http://fiery.efi.com/cws-specifications.

Podpora předplatného aplikace Adobe Acrobat DC k použití s nástroji Fiery Impose, Fiery Compose
nebo Fiery JobMaster

Verze Fiery Command WorkStation Package v6.5.0.292 podporuje používání individuálních/osobních odběrů
aplikace Acrobat DC nainstalovaných na klientském počítači k použití s nástroji Fiery Impose, Fiery Compose
nebo Fiery JobMaster.

Poznámka: Chcete-li používat aplikaci Acrobat v nástrojích Fiery Impose, Fiery Compose nebo Fiery JobMaster,
musíte na klientském počítači nainstalovat pouze jednu instanci aplikace Acrobat DC. Dále zajistěte, aby na
jednom klientském počítači nebyly nainstalovány jiné verze aplikace Acrobat.

Známé potíže

Zobrazení pro čtení

V aplikaci Fiery Impose, Fiery Compose, Fiery JobMaster nebo Fiery Preview bylo na macOS 11 a novějších
verzích odebráno zobrazení pro čtení.

ImageEnhance Visual Editor

Při maximalizaci okna ImageEnhance Visual Editor v systému macOS 11 může monitor několik sekund blikat.

Převod z formátu PS do PDF

Pokud s Fiery Impose, Fiery Composenebo Fiery JobMaster používáte systém macOS 10.14.5 a novější, může vás
systém požádat o povolení pro aplikaci Fiery Command WorkStation k získání přístupu k nástroji Acrobat
Distiller. Toto oprávnění je nezbytné pro převod souborů PS do formátu PDF. Neudělíte-li oprávnění, převody
nebudou úspěšné a bude nutné změnit funkci zabezpečení automatizace v systému macOS.

1 Zavřete všechny aplikace Fiery.

2 Zavřete aplikaci Acrobat Distiller.

3 Přejděte do části Předvolby systému > Zabezpečení a ochrana soukromí > Ochrana soukromí >
Automatizace.

4 V levém dolním rohu klikněte na ikonu zámku a zadejte své heslo.
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5 V seznamu aplikací vyhledejte položku Fiery Command Workstation.app.

6 Vyberte možnost Acrobat Distiller.app.
Tím umožníte aplikaci Fiery Command WorkStation získat přístup k nástroji Acrobat Distiller.

Informace týkající se systému macOS 10.15 (Catalina)

Fiery Preview, Fiery Impose, Fiery Compose nebo Fiery JobMaster v systému MacOS 10.15

Sada aplikací pro podporu PDF

Sada aplikací pro podporu PDF (poskytovaná společností EFI), která obsahuje aplikace Adobe Acrobat a Enfocus
PitStop, není kompatibilní se systémem macOS 10.15 (Catalina). Pokud používáte aplikaci Acrobat nebo
PitStop, neprovádějte upgrade na systém macOS 10.15. Pro nové instalace aplikací pro podporu PDF se
instalační program nespustí.
Po upgradu na systém macOS 10.15 se při používání aktuální sady podpůrných aplikací PDF mohou objevit
následující problémy:

• Pokud máte před upgradem na systém macOS 10.15 již nainstalovanou aplikaci Acrobat DC, spustí se
normálně. Instalační program aplikace Acrobat DC však není kompatibilní se systémem macOS 10.15, takže
novou instalaci aplikace Acrobat DC nelze provést. Enfocus PitStop, které je součástí sady, navíc není v
systému macOS 10.15 podporován.

• Pokud máte aplikaci Acrobat XI již nainstalovanou před upgradem na systém macOS 10.15, nespustí se a
není podporována pro systém macOS 10.15. Před upgradem na systém macOS 10.15 doporučujeme aplikaci
Acrobat XI odinstalovat. Odinstalační program pro aplikaci Acrobat XI se v systému macOS 10.15 nespustí,
takže pokud provedete upgrade na systém macOS 10.15, když je aplikace Acrobat XI stále nainstalovaná,
dostane se váš systém do situace, kdy aplikace Acrobat XI nefunguje a nelze ji odinstalovat.

Pokud není nainstalována kompatibilní verze aplikace Acrobat, platí následující omezení:

• Funkce Upravit v aplikaci Acrobat není k dispozici v aplikacích Fiery Impose, Fiery Compose a Fiery
JobMaster.

• Při otevření úlohy PostScript pomocí aplikace Fiery Preview, Fiery Impose, Fiery Compose Fiery JobMaster
může dojít k chybě.

• Šablony Fiery Impose, které používají pracovní postupy Uživatelem definovaná velikost dokončování nebo
Podle rámečku trimování, nemusí fungovat správně s úlohou PostScript.

• Fiery Hot Folders nenabízí možnost převodu souborů PostScript do formátu PDF.

Další problémy

Po upgradu na systém MacOS 10.15 ze starší verze systému MacOS může spuštění aplikace Fiery Preview, Fiery
Impose, Fiery Compose nebo Fiery JobMaster způsobit zobrazení jedné z následujících zpráv:

• „ICUConverter.framework“ poškodí váš počítač. Měli byste ho přesunout do koše.

• „ICUData.framework“ poškodí váš počítač. Měli byste ho přesunout do koše.

Systém macOS 10.15 tyto soubory chybně vyhodnotí jako malware. Chcete-li tyto potíže vyřešit, znovu
přeinstalujte sadu Fiery Command WorkStation Package ve verzi 6.4.0.396 nebo novější, která je kompatibilní se
systémem MacOS 10.15.
Když umístíte kurzor myši na tlačítka pro kteroukoli ikonu ovládacích prvků v aplikaci Fiery Preview, Fiery
Impose, Fiery Compose, nebo Fiery JobMaster, nezobrazí se jejich popis.
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Úplný přístup k disku

V důsledku změn způsobu, jakým systém macOS 10.15 spravuje zabezpečení, je nyní nutné provést další kroky
ke zprovoznění aplikací Fiery.
Chcete-li, aby aplikace Fiery spravovaly aktualizace a přístup k souborům, například k šablonám Impose nebo
sledovaným složkám, musíte v systému macOS provést změny funkce zabezpečení Úplný přístup k disku .
Povolte Úplný přístup k disku pro aplikace Fiery, jako je například Fiery Command WorkStation.

1 Zavřete všechny aplikace Fiery.

2 Přejděte do části Předvolby systému > Zabezpečení a ochrana soukromí > Ochrana soukromí > Úplný přístup
k disku.

3 V levém dolním rohu klikněte na ikonu zámku a zadejte své heslo.

4 Klikněte na tlačítko +.

5 Přejděte do složky Aplikace, vyberte Fiery Software Manager a Fiery Software Uninstaller a klikněte na
Otevřít.
Tyto aplikace vyžadují úplný přístup k disku, aby bylo možné v počítači spravovat a aktualizovat aplikace
Fiery.

6 Ve složce Aplikace vyberte Fiery Command WorkStation a klikněte na Otevřít.

7 Používáte-li Fiery Hot Folders nebo Fiery Remote Scan, vyberte každou aplikaci a klikněte na tlačítko Otevřít.
Když Fiery Hot Folders zjistí, že se používají složky Dokumenty, Plocha a Stažené soubory, vygeneruje zprávu
požadující úplný přístup k disku. Tato zpráva se stále zobrazuje i po udělení přístupu. Tuto zprávu můžete
zrušit a pokračovat v práci.

Chyby v prohlížeči Safari v systému macOS 10.15

Pokud používáte prohlížeč Safari v systému macOS 10.15, při pokusu o otevření následujících stránek z aplikace
Fiery Command WorkStation bude docházet k opakovaným chybám prohlížeče. Středisko zařízení > Obecné >
Nástroje:

• Obnovení systému Fiery

• Bitová kopie systému Fiery

• Prostředky a nastavení Fiery

K těmto chybám může docházet také při otevírání aplikace Fiery WebTools v prohlížeči Safari.
Pro přístup k těmto stránkám použijte prohlížeč Chrome nebo Firefox.

Fiery XF v systému macOS 10.15

Používáte-li aplikaci Fiery XF v systému MacOS 10.15, musíte provést upgrade aplikace Fiery Color Profiler
Suite na verzi 5.3.1. U verze aplikace Fiery Color Profiler Suite 5.3.1 je nyní uživatelům aplikace Fiery XF jako
výchozí aplikace ověření k dispozici nástroj Fiery Verify kompatibilní s verzí macOS 10.15.
Nástroj Color Verifier není kompatibilní se systémem macOS 10.15, ale je stále podporován u starších verzí
systému macOS. Nástroj Color Verifier je však třeba nainstalovat samostatně. Stáhněte si nástroj Color Verifier
pro systém macOS 10.14 a starší verze z centra stahování.
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Fiery Color Profiler Suite a Fiery Command WorkStation 6.5

Fiery Color Profiler Suite 5.0 (CPS) a starší verze nejsou plně kompatibilní s aplikací Fiery Command
WorkStation Package 6.5 (CWS) pro digitální tiskové stroje na volné listy. Doporučujeme aktualizovat na nástroj
Fiery Color Profiler Suite 5.1.
Při používání CPS 5.0 s aplikací CWS 6.5 můžete zaznamenat následující problémy:

• Pokud v nástroji CWS uvidíte zprávu „Připojte spektrofotometr k počítači“ zatímco je nástroj CPS otevřen,
zavřete CPS a pokračujte kliknutím na tlačítko OK.

• Jakmile vytvoříte nové nastavení kalibrace v modulu Kalibrátor, skryje se tlačítko Vytvořit nový profil ke
spuštění CPS. Tento problém je vyřešen po upgradu na CPS 5.1.

Možnost Upravit v Acrobatu v nástroji Fiery Impose, Fiery Compose nebo Fiery JobMaster otevře
dvě okna aplikace Acrobat

Když je v počítačích se systémem Windows zvolena možnost Upravit v Acrobatu v nástroji Fiery Impose, Fiery
Compose nebo Fiery JobMaster, může se aplikace Acrobat otevřít ve dvou oknech namísto jednoho. Jedná se o
známý problém. Okno aplikace Adobe Acrobat můžete zavřít a pokračovat v práci v okně s PDF.

Nastavení předvoleb v aplikaci Adobe Acrobat Distiller pro převod z PostScriptu do PDF

Nástroje Fiery Impose, Fiery Compose a Fiery JobMaster vyžadují, aby aplikace Acrobat Distiller převedla
soubory PostScript (PS) do formátu PDF v klientském počítači.
Z důvodu rozšířeného nastavení zabezpečení v aplikaci Acrobat Distiller je nutné potvrdit, že soubor PS, který
má být převeden, pochází z důvěryhodného zdroje v: Acrobat Distiller > Soubor > Předvolby > Předvolby –
Acrobat Distillervyberte možnost Důvěřovat všem souborům otevřeným prostřednictvím aplikace Acrobat
Distiller pod položkou Zabezpečení.

Poznámka: Není-li vybrána možnost Důvěřovat všem souborům otevřeným prostřednictvím aplikace Acrobat
Distiller, budete vyzváni, abyste potvrdili, že soubor pochází z důvěryhodného zdroje u všech souborů PS, které
mají být převedeny do formátu PDF. To platí také pro složky Hot Folders když je vybrán filtr Microsoft Office,
Výstupní typ souboru je určen jako PDF a jako Profil aplikace Distiller je vybrán soubor joboptions.

Nástroj Configure nelze spustit z počítače se systémem macOS

Pokud váš Fiery server používá systém FS100, nástroj Configure nemůžete spustit z těchto verzí operačního
systému:

• mac10.14.6 a novější verze 10.14

• macOS 10.15 (všechny verze)

Chcete-li se připojit k Fiery Command WorkStation, použijte počítač se systémem MacOS se starší verzí
systému MacOS nebo použijte počítač se systémem Windows.

Prodleva při spouštění Fiery Impose, Fiery Compose nebo Fiery JobMaster

Spouštění nástrojů Fiery Impose, Fiery Compose a Fiery JobMaster může trvat déle než v předchozích verzích.
Chcete-li zkrátit dobu otevření jedné z těchto aplikací, spusťte nejprve Fiery Preview a teprve poté aplikaci,
kterou chcete použít.

Poznámky k verzi pro zákazníky

Fiery Command WorkStation Package, v6.5

174



Potíže opravené ve verzi Fiery Command WorkStation Package v6.5.0.599

Fiery Command WorkStation

• Výsledky měření pomocí spektrofotometru ES-3000 nebyly přesné.

Problémy opravené v Fiery Command WorkStation Package v6.5.0.581

Fiery Command WorkStation

• Používáte-li v aplikaci Fiery Hot Folders vstupní formát TIFF, u některých jazyků se nastavení umístění obrázku
uplatňovalo nesprávně.

• Fiery Command WorkStation Package 6.5 podporuje Windows 10, verze 20H2.

Fiery XF

• Pokud přidáte server Fiery XF se zapnutou předvolbou Uložit heslo a restartujete server Fiery XF, Fiery
Command WorkStation Package se nespustí úspěšně.

Problémy opravené v aplikaci Fiery Command WorkStation Package ve verzi
6.5.0.563

Fiery Command WorkStation

• V systému v japonštině se při přihlašování k nově vzniklému účtu správce neotevře nástroj Fiery Spot Pro.

Fiery XF

• V aplikaci Fiery Command WorkStation Job Center sloupec Stav úlohy obsahuje informaci, že ověření nebylo
úspěšné, i když úloha prošla všemi zkouškami v nástroji Fiery Verify.

• Pokud byl v aplikaci Fiery Command WorkStation Job Center stav vnořené úlohy K ověření, Fiery Verify se
nespustí po kliknutí na položku Ověřit v podokně Souhrn úlohy nadřazené úlohy. Okno Fiery Verify se otevře,
pokud kliknete na možnost Optimalizovat nebo Podrobnosti z podokna Souhrn úlohy v podřízené úloze.

Problémy opravené ve verzi Fiery Command WorkStation Package v6.5.0.539

Fiery Command WorkStation

• Po vyřazení úlohy PPML s šablonou 4-up a jejím zpracování se některé stránky úlohy v Fiery ImageViewer
nezobrazily.

Fiery XF

• Pro nastavení vlastní šířky v nástroji Command WorkStation Server Manager > Rozložení > Krok a opakovat >
Pattern nebylo možné zadat hodnotu větší než 59,4 cm.

Poznámky k verzi pro zákazníky

Fiery Command WorkStation Package, v6.5

175



Problémy opravené ve verzi Fiery Command WorkStation Package v6.5.0.512

Fiery Command WorkStation

• V systému v japonštině přestal při tisku úlohy, která byla upravena pomocí aplikace Fiery ImageViewer, Fiery
server reagovat.

• Zobrazení textových rámečků úlohy v drátovém zobrazení v aplikaci Fiery Impose je nyní zarovnáno s drátovým
zobrazením.

Fiery XF

• Pokud jste změnili název média nebo přidruženého souboru kalibrace (*. EPL) na profil médií s jiným názvem v
části Color Tools > Connect Profiles, informace o kompatibilní tiskárně byly odebrány ze souboru kalibrace
(*.EPL).

• Nastavení Oblast lepení nelze pod položkou Job Editor > Překrytí/Lepení uložit.

• XF 7.2 podporuje měřicí přístroje X-Rite i1Pro3 a EFI ES-3000 na počítačích se systémem macOS.

Problémy opravené v aplikaci Fiery Command WorkStation Package v6.5.0.475

Fiery Command WorkStation

• V aplikaci Fiery Spot Pro můžete nyní určit separační hodnoty pro přímé barvy a náhradní barvy s přesností na
jedno desetinné místo.

• V aplikaci Fiery Spot Pro je nyní možnost Vrátit do nastavení výrobce zakázána pro přímé barvy v duplikované
skupině.

• Produkty Adobe Acrobat Pro 2017 a Enfocus PitStop Edit 2019 můžete přeinstalovat a aktivovat z programu
Fiery Software Manager.

Fiery XF

• U rolových tiskáren VUTEk superširokého formátu se nastavení režimu tisku Speciální nastavení > Tisk bílým
inkoustem vždy změnilo zpět na hodnotu Přímá barva WHITE_INK.

• Pokud byl jazyk systému serveru Fiery server nastavený na polštinu, aplikace Cut Server nerozpoznala vnořené
úlohy.

Problémy opravené ve verzi Fiery Command WorkStation Package v6.5.0.433

Fiery Command WorkStation

• Fiery Command WorkStation Package 6.5 podporuje Windows 10 verze 2004.

• When you printed a booklet job using a Fiery Impose template that is saved as a preset, sometimes the cover
media setting was not applied.

• V některých případech nešlo spustit Fiery Impose, Fiery Compose nebo Fiery JobMaster, protože nesprávná
chybová zpráva hlásila, že aplikace již byla otevřena. Tato chyba je opravena.

• Pokud jste měli aktivováno více licencí, při obnovení Fiery server pomocí nástroje Obnovení systému Fiery jste
nemohli obnovit aktivační kódy licence License Activation Code (LAC). Tato chyba je opravena.
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Fiery XF

• Jméno uživatele systému obsahující mezeru nebo speciální znaky způsobilo, že nedošlo k zobrazení náhledů úloh
v nástroji Job Editor.

• V systému v italském jazyce přestal Job Editor reagovat po upgradu Fiery Command WorkStation 6.5 na
nejnovější verzi.

Problémy opravené v aplikaci Fiery Command WorkStation Package v6.5.0.367

Fiery Command WorkStation

• V některých jazycích se text umístěný na kartách s ouškem prostřednictvím Fiery Compose nebo Fiery
JobMaster zobrazoval správně při prohlížení v počítači, ale při tisku karet s ouškem se text nezobrazoval.

• Pokud byly formuláře PDF s daty zadanými v polích formuláře uloženy z aplikace Fiery Compose nebo Fiery
JobMaster, pole formuláře se nezobrazovala v části Náhled ani v vytištěném výstupu.

• Pokud jste změnili velikost papíru z 241x330 mm na 13x19 palců, nemohli jste provést rekalibraci sady kalibrace
s vlastní velikostí papíru 241x330 mm.

• Nebylo možné měřit kalibrační stránku, pokud jste po vytištění kalibrační stránky připojili spektrofotometr k
libovolnému počítači.

Fiery XF

• Na některých platformách systému Windows nebylo možné v nástroji Job Editor zobrazit náhled úloh.

Problémy opravené v aplikaci Fiery Command WorkStation Package v6.5.0.292

Fiery Command WorkStation

• Písmo Arial bylo v některých počítačích se systémem Windows po instalaci aplikace Fiery Command
WorkStation Package 6.5 zobrazeno jako kurzíva.

• Výchozí nastavení, které jste definovali pomocí funkce Nastavit výchozí, nebylo použito pro sekvenční tiskovou
frontu.

• Pokud jste v aplikaci Fiery JobMaster při vkládání karet nebo prázdných archů vložili nebo smazali stránky z
úlohy PDF se záložkami, záložky se přesunuly na jiné stránky.

• V některých případech došlo v počítačích macOS s operačním systémem v jiném než anglickém jazyce k
vygenerování poškozených dat měření IT8.

Fiery XF

• Pokud v nastavení Color Tools > Vytvořit kalibraci > Vyvážení šedédošlo ke změně hodnot delta E pokaždé, když
jste otevřeli uložený soubor EPL

• V případě systémového jazyka serveru Fiery server nastaveného na polštinu aplikace Cut Server nerozpoznala
vnořené úlohy.

• Při rekalibraci serveru Fiery XF nebyl použit výchozí pracovní postup, který jste nastavili v okně Server Manager.
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Problémy opravené v aplikaci Fiery Command WorkStation Package v6.5.0.171 SP1

• Když jste v aplikaci Fiery Imposepoužili akci Přiřadit média, zobrazila se varovná zpráva o nesprávném profilu
sRGB.

Problémy opravené v aplikaci Fiery Command WorkStation Package v 6.5.0.171

Fiery XF

• Nelze vytvořit základní čáru pro EPSON SC-P75x0/SC-P95x0 RGB

• Nelze vybrat tisk štítků pro EPSON SC-P75x0 a SC-P95x0

• Nelze provést kalibraci tiskárny EPSON 9500 s médiem o velikosti 44-palců
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